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IInnttrroodduuzziioonnee

Importante

Nel limite massimo consentito dalle leggi applicabili, in nessun caso il produttore sarà ritenuto
responsabile per danni derivanti da eventuali guasti del prodotto, per perdita di documenti o dati o per
l'utilizzo di questo prodotto e dei manuali operativi con esso forniti.

Assicurarsi di effettuare sempre una copia o il backup di documenti o dati importanti. I documenti e i
dati potrebbero essere cancellati a causa di errori di funzionamento o malfunzionamento della
macchina. Inoltre, è responsabilità dell'utente adottare misure di protezione contro virus, worm e altri
software dannosi per il computer.

In nessun caso il produttore sarà ritenuto responsabile per i documenti creati dall'utente utilizzando il
prodotto e per qualsiasi risultato che l'utente ottiene dai dati.

Non rimuovere e non inserire nessun disco durante il funzionamento di questa applicazione.

Attenzioni relative a questa guida

• Alcune illustrazioni o spiegazioni in questa guida potrebbero differire dall’applicazione per
miglioramenti o modifiche nell’applicazione.

• I contenuti di questo documento sono soggetti a modifiche senza preavviso.

• Nessuna parte di questo documento può essere duplicata, replicata, riprodotta in qualsiasi forma,
modificata o citata senza il previo consenso da parte del produttore.

• Nei manuali di istruzioni, le procedure utilizzano Windows 10, come esempio. La procedura
potrebbe differire leggermente nelle altre versioni di Windows.

Guide per questa applicazione

Di seguito sono riportate le guide disponibili per la presente applicazione.

Manuali di istruzioni

Questi manuali di istruzione sono compresi:

• RICOH TotalFlow Prep: Guida all'installazione (Stampata/PDF)
Questa guida illustra le procedure di installazione e di avvio, nonché le impostazioni necessarie per
poter utilizzare l'applicazione.

• RICOH TotalFlow Prep: Guida per l'utente (Questa guida, HTML/PDF)
Questa guida spiega le funzioni e le operazioni di base di questa applicazione.

Per favorire una migliore comprensione delle operazioni di base dell'applicazione, questa guida
include anche lezioni pratiche con file di esempio.



Guida

La guida contestuale è disponibile su diverse schermate per fornire informazioni su attività e
impostazioni specifiche. Nella presente guida questo tipo di aiuto viene definito "guida contestuale su
schermo".

Inoltre, il menu [Guida] consente l'accesso alla versione HTML della Guida per l'utente direttamente
dall'interfaccia utente.

Per visualizzare la documentazione in formato HTML, deve essere installato un browser Web. Il
browser consigliato è la versione più recente di Mozilla Firefox. Per visualizzare la documentazione in
formato PDF è necessario che sia installato un lettore PDF come Adobe Reader.

Come leggere la documentazione

Prima di utilizzare l'applicazione

Questo manuale contiene istruzioni dettagliate e note sul funzionamento e l'utilizzo di questa
applicazione. Per garantire il corretto utilizzo, leggere attentamente l'intero manuale prima di usare
l'applicazione. Tenere questo manuale a portata di mano per riferimento rapido.

Come utilizzare i manuali e la Guida in linea

Utilizzare i manuali di istruzioni e la guida contestuale in base alle esigenze.

Per imparare a installare e avviare questa applicazione
Consultare la Guida all'installazione.

Per ulteriori informazioni sulle funzioni e sulle operazioni di base di questa applicazione
Consultare la Guida dell'utente.

Per ulteriori informazioni sulla configurazione delle impostazioni su schermo
Vedere l’aiuto diretto su schermo.

Visualizzazione del Manuale di istruzioni (Guida all'installazione e Guida dell'utente)

Per visualizzare i manuali di istruzioni, procedere come segue.

Visualizzazione della Guida all'installazione e della Guida dell'utente in formato PDF

Questa procedura utilizza Windows 10 come esempio. La procedura potrebbe differire
leggermente nelle altre versioni di Windows.

• Fare clic su Start→ Tutte le app→ RICOH TotalFlow Prep, quindi fare clic su [Guida
all'installazione] o [Guida dell'utente].
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Visualizzazione della Guida dell'utente in formato HTML

• La versione HTML della Guida dell’utente è disponibile direttamente dall’interfaccia utente.
Avviare l'applicazione, quindi fare clic su Guida→ Guida TotalFlow Prep.
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Visualizzazione della Guida campo

Fare clic sul pulsante accanto a una voce sull'interfaccia utente per visualizzare la guida contestuale
per la data voce. Fare clic su [Maggiori informazioni nella Guida] nella casella di guida per
visualizzare la pagina correlata nella Guida per l'utente in HTML.

Simboli

Di seguito sono riportati i simboli utilizzati in questo manuale per identificare rapidamente i contenuti.

Questo simbolo indica i punti a cui prestare attenzione quando si utilizza
l'applicazione. Assicurarsi di leggere queste spiegazioni.

Questo simbolo indica informazioni supplementari che potrebbero essere utili,
ma non essenziali, per il completamento dell'attività.

Questo simbolo indica dove è possibile reperire altre informazioni importanti.

[] Questo simbolo indica i nomi di schermate, menu, impostazioni e pulsanti.

Marchi

RICOH TotalFlow Production Manager™ è un marchio di Ricoh Company, Ltd. negli Stati Uniti, in altri
paesi o in entrambi.
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Alcune parti del presente prodotto software sono protette da copyright © 1984-2022 di Adobe
Systems Incorporated e dei relativi licenziatari. Tutti i diritti riservati.

Adobe, il logo Adobe, Acrobat, il logo Adobe PDF, Distiller, Photoshop, PostScript e Reader sono
marchi registrati o marchi di fabbrica di Adobe negli Stati Uniti e/o in altri Paesi.

Google Chrome è un marchio di fabbrica di Google LLC.

Mozilla e Firefox sono marchi di fabbrica di Mozilla Foundation negli Stati Uniti e in altri Paesi.

Microsoft, Windows, Windows Server, Excel, PowerPoint e Microsoft Edge sono marchi registrati o
marchi di Microsoft Corporation negli Stati Uniti e/o in altri Paesi.

Il logo EFI, Electronics For Imaging, Fiery e il logo Fiery sono marchi registrati di Electronics for
Imaging, Inc. negli Stati Uniti e/o in alcuni altri paesi. EFI è un marchio registrato di Electronics for
Imaging, Inc. negli Stati Uniti e/o in altri Paesi.

Java e tutti i marchi e i logo Java sono marchi di Oracle e/o società affiliate.

IBM, il logo IBM e IBM.com sono marchi o marchi registrati di International Business Machines Corp.,
registrati in diverse giurisdizioni a livello mondiale. Altri nomi di prodotti e servizi possono essere marchi
di IBM o altre società.

OpenJDK (il “Nome”) è un marchio di Oracle America, Inc. (“Oracle”)(il “Titolare del marchio”). Java
e OpenJDK sono marchi di fabbrica o marchi registrati di Oracle e/o le società ad essa collegate.
Copyright Oracle America, Inc.

Questo prodotto contiene tecnologia di proprietà e con copyright di ULTIMATE. I marchi commerciali, i
brevetti e i copyright associati sono proprietà di ULTIMATE. Copyright © Ultimate TechnoGraphics Inc.
1992-2022. Tutti i diritti riservati.

I nomi propri dei sistemi operativi Windows sono indicati di seguito:

• I nomi di prodotto di Windows 10 sono indicati di seguito:

Microsoft Windows 10 Pro

Microsoft Windows 10 Enterprise

• I nomi di prodotto di Windows 11 sono indicati di seguito:

Microsoft Windows 11 Pro

Microsoft Windows 11 Enterprise

• Il nome prodotto di Windows Server 2016 Standard è il seguente:

Microsoft Windows Server 2016 Standard

• I nomi di prodotto di Windows Server 2019 sono i seguenti:

Microsoft Windows Server 2019 Standard

Microsoft Windows Server 2019 Essentials

• Il nome prodotto di Windows Server 2022 è:

Microsoft Windows Server 2022 Standard

Altri nomi prodotto qui utilizzati sono solo a scopo identificativo e possono essere marchi delle rispettive
aziende. Decliniamo tutti i diritti su tali marchi.

Le schermate dei prodotti Microsoft sono riprodotte con l'autorizzazione di Microsoft Corporation.
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PPaannoorraammiiccaa ddii TToottaallFFllooww PPrreepp
TotalFlow Prep consente di modificare documenti cartacei scansiti e file elettronici e di creare ed
emettere quindi i dati per la stampa. I dettagli relativi alle principali funzioni della presente
applicazione sono elencati di seguito.
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PPaannoorraammiiccaa ddeellllaa vveerrssiioonnee bbrroowwsseerr ddii TToottaallFFllooww PPrreepp
È possibile utilizzare la versione browser di TotalFlow Prep per modificare lavori provenienti da RICOH
TotalFlow Production Manager™ o da RICOH TotalFlow Print Server. Al termine della modifica del
lavoro, è possibile salvarlo e inviarlo nuovamente a TotalFlow Production Manager o TotalFlow Print
Server.

• Per ulteriori informazioni, vedere Modifica di lavori nella versione browser di TotalFlow Prep,
pagina 225.

• Alcune funzioni di TotalFlow Prep non sono disponibili nella versione browser.

• TotalFlow Production Manager deve essere installato sullo stesso computer di TotalFlow Prep.

1 Panoramica
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IInntteerrffaacccciiaa uutteennttee TToottaallFFllooww PPrreepp
TotalFlow Prep offre un'interfaccia utente completa e intuitiva per la composizione, la modifica e la
preparazione dei lavori per l'output.

L'interfaccia utente è formata dalle seguenti aree:

1. Barra dei menu con gestione file, configurazione, modifica lavoro, impostazioni predefinite e
opzioni di stampa.

2. Barra degli strumenti per un rapido accesso alle funzioni usate di frequente.

3. Elenco pagine per una facile navigazione attraverso le pagine del lavoro e per la gestione del
contenuto del lavoro e del layout.

4. Spazio di lavoro con diverse opzioni di layout per la visualizzazione e la modifica delle pagine e
dei fogli nel lavoro.

5. Area impostazioni per la configurazione di impostazioni lavoro quali imposizione, finitura,
copertine, fogli divisori, fogli designati, intestazioni e piè di pagina, numerazione pagine,
timbratura pagine e schede su margini al vivo. È anche possibile rimuovere il rumore dai documenti
scansiti, raddrizzare le pagine disallineate e allineare il contenuto delle pagine.

Se si desidera, è possibile visualizzare l’interfaccia utente di TotalFlow Prep ad alto contrasto. L'alto
contrasto consente di visualizzare più facilmente le icone e il testo. Per attivare l'alto contrasto, andare
in Impostazioni→ Preferenze→ Visualizza e selezionare la casella [Utilizza un tema ad alto
contrasto].

Interfaccia utente TotalFlow Prep
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Barra dei menu

La barra dei menu offre accesso a gestione file, configurazione, modifica lavoro e opzioni di stampa.

•

Fare clic sulle voci della barra dei menu per aprire l'elenco delle opzioni disponibili per ogni menu.

•

Usare il menu delle impostazioni predefinite per applicare un'impostazione predefinita al lavoro o
per registrare le impostazioni del lavoro corrente come predefinite.

•

Usare il menu di selezione della stampante per selezionare una stampante per il lavoro.

Quando si cambia stampante, le capacità del dispositivo e l'elenco della carta disponibile vengono
aggiornati automaticamente.

• [Aggiorna informazioni stampante]

Fare clic su , il pulsante [Aggiorna informazioni stampante], per aggiornare le capacità del
dispositivo e l'elenco della carta disponibile per la stampante attiva.

•

Fare clic sul pulsante [Stampa] per inviare il lavoro alla stampante.

Barra degli strumenti

La barra degli strumenti offre un accesso rapido alle funzioni usate di frequente per la modifica delle
pagine e l'impostazione delle proprietà del lavoro.

Queste funzioni sono disponibili nella barra degli strumenti:

• Pulsanti [Annulla] e [Ripeti]

Annullare e ripristinare le modifiche al lavoro.

• [Strumento seleziona]

Selezionare e interagire con le pagine nel lavoro.

• [Strumento maschera], [Strumento testo] e [Strumento immagine]

1 Panoramica
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Inserire maschere, testo e immagini in una pagina.

• [Strumento sposta area]

Spostare un'area selezionata in una posizione differente nella pagina.

• [Strumento taglio]

Ritagliare una pagina.

• [Strumento ridimensiona pagina]

Ridimensionare una pagina.

• [Strumento ruota pagina]

Ruotare una pagina.

• [Sovrapposizioni]

Applicare e gestire le sovrapposizioni registrate.

• Menu di selezione carta

Selezionare la carta per il lavoro.

• Menu di selezione vassoio

Selezionare il vassoio in cui è caricata la carta per il lavoro. L'elenco dei vassoi dipende dalla
stampante selezionata per il lavoro.

• [Lato di stampa]

Specificare su quali lati del foglio stampare e la direzione in cui vengono aperti i fogli.

• [Orientamento]

Specificare se le pagine hanno un layout verticale o orizzontale.

• [Pinzatura]

Specificare un'opzione di pinzatura per il lavoro.

• [Colore/Bianco e nero]

Specificare se il lavoro viene stampato in bianco e nero o a colori. Le opzioni disponibili per questa
impostazione dipendono dalla stampante selezionata per il lavoro.

• [Copie:]

Specificare il numero di copie.

Interfaccia utente TotalFlow Prep
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Lista pagine

È possibile usare l'elenco pagine per spostarsi attraverso le pagine del lavoro. L’elenco delle pagine
consente di selezionare, spostare, copiare, inserire ed eliminare le pagine. Sono visualizzate anche le
informazioni sulle pagine, tra cui impostazioni carta, capitoli, schede, inserti, copertine, fogli designati,
impostazioni di eccezione e tipo PDF.

Per migliorare le prestazioni durante la modifica di lavori di grandi dimensioni, è possibile nascondere
il contenuto del lavoro corrente e utilizzare miniature segnaposto. Selezionare [Nascondi contenuto
foglio] nel menu [Visualizza] per abilitare questa funzione.

Per modificare la visualizzazione dell'elenco pagine, fare clic su uno dei pulsanti di visualizzazione
disponibili:

• [Vista miniature]

Consente di visualizzare le pagine del lavoro come miniature in una griglia, con ridimensionamento
in base al formato carta.

Le miniature vengono visualizzate se l'orientamento è orizzontale o verticale.

L'icona capitolo contrassegna la prima pagina di ogni capitolo.

• [Vista elenco]

Consente di visualizzare le pagine del lavoro come miniature una sotto l'altra, ridimensionate in
base al formato carta e raggruppate in capitoli.

Le miniature vengono visualizzate se l'orientamento è orizzontale o verticale. Accanto a ogni
miniatura è possibile visualizzare il numero di pagina, se la pagina è una copertina, una scheda,
un inserto o una pagina designata, l'impostazione del lato stampa, il formato carta e l'impostazione
del colore. L'icona eccezione viene visualizzata per le pagine configurate come eccezioni.

1 Panoramica
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Se l'imposizione è impostata su [Libretto] o [Combina], l'elenco pagine visualizza le miniature pagina
originali e il formato carta.

Per apportare modifiche alle pagine:

• Per riordinare le pagine, selezionare la pagina o le pagine da spostare e trascinarle nella nuova
posizione.

È anche possibile trascinare le pagine dalla lista pagine nell'area dello spazio di lavoro sulla destra
se lo spazio di lavoro viene visualizzato in [Vista foglio] e se il lavoro ha l'imposizione [Normale]
ed è impostato per la stampa sul lato anteriore del foglio.

• Per inserire una pagina vuota prima di una pagina nel lavoro, passare il mouse sulla pagina e fare

clic su , il pulsante [Inserisci pagina].

• Per eliminare una pagina, passare il mouse sulla pagina e fare clic su , il pulsante [Elimina
pagina].

• Per inserire una scheda prima di una pagina, passare il mouse sulla pagina e fare clic su , il
pulsante [Inserisci scheda].

• Per creare un capitolo prima di una pagina, passare il mouse sulla pagina e fare clic su , il
pulsante [Crea capitolo].

È anche possibile usare il menu attivato con il tasto destro per apportare modifiche alle pagine.
Selezionare la pagina o le pagine, fare clic con il tasto destro del mouse e selezionare una delle
opzioni disponibili nel menu.

Per cambiare le dimensioni dell'area di elenco pagine, fare clic sulla linea di separazione e trascinarla

a sinistra o a destra. È anche possibile ridurre o espandere l'area facendo clic su [Riduci] o
[Espandi].

Spazio di lavoro

Lo spazio di lavoro offre diverse opzioni di layout per la visualizzazione e la modifica delle pagine e
dei fogli nel lavoro. Le impostazioni vengono visualizzate in tempo reale in modo da poter visualizzare
l'anteprima dell'output finale.

Per modificare le opzioni di layout per lo spazio di lavoro, fare clic su uno dei pulsanti di
visualizzazione disponibili nell'angolo a destra. Sono disponibili queste visualizzazioni:

• [Vista foglio]

Consente di visualizzare i fogli del lavoro come miniature in una griglia, con ridimensionamento in
base al formato carta. Se il lavoro è impostato per la stampa su un solo lato, viene visualizzata solo
la facciata anteriore del foglio. Se il lavoro è impostato per la stampa su entrambi i lati, viene
visualizzata anche la facciata posteriore del foglio.

Interfaccia utente TotalFlow Prep
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Per migliorare le prestazioni durante la modifica di lavori di grandi dimensioni, è possibile
nascondere il contenuto del lavoro corrente e utilizzare miniature segnaposto. Selezionare
[Nascondi contenuto foglio] nel menu [Visualizza] per abilitare questa funzione.

La miniatura mostra se l'orientamento è orizzontale o verticale. Sotto ogni miniatura, è possibile
vedere i numeri di pagina. Nella parte superiore della miniatura, è possibile vedere il numero di
foglio e la carta specificata per il foglio. Per ulteriori informazioni su impostazioni carta,
impostazioni di eccezione applicate al foglio e pagine posizionate sul foglio, passare il mouse sul
testo.

L'icona capitolo contrassegna la prima pagina di ogni capitolo. L'icona eccezione viene
visualizzata per i fogli configurati come eccezione.

Usare la barra di scorrimento o le frecce della tastiera per spostarsi attraverso righe di miniature.

Per regolare la dimensione delle miniature, usare uno dei seguenti controlli:

– [Zoom in]

Usare questo pulsante per aumentare la dimensione delle miniature.

– [Zoom out]

Usare questo pulsante per diminuire la dimensione delle miniature.

–

Usare questa impostazione per regolare la dimensione delle miniature in base a una
percentuale specifica. Per adattare la miniatura del foglio alla larghezza dell'area dello spazio
di lavoro, Selezionare [Adatta larghezza].

– Usare e per passare dal ridimensionamento della miniatura foglio in base alla
larghezza dell'area dello spazio di lavoro a una percentuale di ridimensionamento del 12%.

1 Panoramica
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Per apportare modifiche ai fogli:

– Per riordinare i fogli, selezionare il foglio o i fogli da spostare e trascinarli nella nuova
posizione.

È possibile riordinare i fogli solo se il lavoro ha imposizione [Normale] ed è impostato per la
stampa sul lato anteriore del foglio.

– Per inserire un foglio bianco prima di un foglio nel lavoro, passare il mouse sul foglio e fare clic

su , il pulsante [Inserisci foglio].

– Per inserire una scheda prima di un foglio, passare il mouse sul foglio e fare clic su , il
pulsante [Inserisci scheda].

– Per eliminare un foglio, passare il mouse sul foglio e fare clic su , il pulsante [Elimina
foglio].

– Per eliminare una scheda, passare il mouse sulla scheda e fare clic su , il pulsante [Elimina
scheda].

– Per creare un capitolo prima di un foglio, passare il mouse sul foglio e fare clic su , il
pulsante [Crea capitolo].

È anche possibile usare il menu attivato con il tasto destro per apportare modifiche ai fogli.
Selezionare il foglio o i fogli, fare clic con il tasto destro del mouse e selezionare una delle opzioni
disponibili nel menu.

• [Vista reader]

Consente di visualizzare il lavoro come libro al centro dello spazio di lavoro.

[Vista reader] consente di sfogliare le pagine del lavoro e visualizzare l'anteprima dell'output.

Per spostarsi nel lavoro:

Interfaccia utente TotalFlow Prep
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– Fare clic sul bordo esterno delle pagine.

– Utilizzare , il pulsante [Pagina precedente], e , il pulsante [Pagina successiva].

– Passare il mouse sul numero di pagina corrente e digitare il numero di pagina che si desidera
visualizzare.

– Selezionare una pagina nell'elenco delle pagine.

– Fare clic su , l'icona [Segnalibri], e selezionare [Inizio], un nome capitolo o [Fine] per
passare alla prima pagina, a un capitolo specifico o all'ultima pagina.

Il prodotto finale effettivo potrebbe differire dai risultati visualizzati nell'anteprima a seconda della
stampante, delle impostazioni carta e delle impostazioni di finitura.

È anche possibile apportare modifiche ai fogli utilizzando il menu a comparsa attivato dal tasto
destro del mouse. Fare clic con il tasto destro del mouse su un foglio e selezionare una delle
opzioni disponibili nel menu.

Quando si utilizzano funzioni che modificano le pagine originali, come ad esempio l'inserimento di
testo, immagini e maschere, lo spazio di lavoro visualizza una pagina per volta.

Questa visualizzazione di modifica si apre anche quando si fa clic con il pulsante destro del mouse su
una pagina e si seleziona [Modifica pagina] dal menu o quando si fa doppio clic su una pagina
nell'elenco delle pagine o in [Vista foglio].

Quando la vista di modifica è attiva, è possibile cambiare la pagina visualizzata nello spazio di lavoro
facendo semplicemente clic sulle pagine nell'elenco pagine.

È possibile tornare a [Vista foglio] facendo clic su , il pulsante [Torna a Tutte le pagine],
posizionato nell'angolo in alto a sinistra dello spazio di lavoro.

Per regolare la dimensione della pagina visualizzata, usare uno dei seguenti controlli:
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• [Zoom in]

Usare questo pulsante per aumentare la dimensione della pagina visualizzata.

• [Zoom out]

Usare questo pulsante per diminuire la dimensione della pagina visualizzata.

•

Usare questa impostazione per regolare la dimensione della pagina visualizzata in base a una
percentuale specifica. Per adattare la pagina alla larghezza dell'area dello spazio di lavoro,
selezionare [Adatta larghezza].

• Usare e per passare dal ridimensionamento della pagina in base alla larghezza
dell'area dello spazio di lavoro a una percentuale di ridimensionamento del 12%.

Per visualizzare righelli, griglie e guide nella visualizzazione di modifica, selezionare le opzioni
[Righelli], [Griglia] e [Guide] nel menu [Visualizza].

Per la modifica avanzata della pagina sono anche disponibili le visualizzazioni [Tavolo luminoso] e
[Tavolo luminoso speculare]. Per ulteriori informazioni, vedere Uso delle funzioni di modifica
avanzate, pagina 149.

Area impostazioni

È possibile utilizzare le opzioni nell'area impostazioni per la configurazione delle impostazioni lavoro,
come imposizione, finitura, copertine, fogli divisori, fogli designati, intestazioni e piè di pagina,
numerazione pagine, timbratura pagine e schede su margini al vivo. È anche possibile rimuovere il
rumore dai documenti scansiti, raddrizzare le pagine disallineate e allineare il contenuto delle pagine.

Interfaccia utente TotalFlow Prep
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Fare clic sulle schede per passare tra i pannelli. Fare clic sulla scheda per nascondere il contenuto del
pannello attivo.

Per ulteriori informazioni sulle impostazioni disponibili, consultare Modifica dei lavori, pagina 95.

Menu attivato col tasto destro del mouse

Il menu attivato con il tasto destro viene visualizzato quando si fa clic con il tasto destro del mouse sulle
pagine e i fogli nell'elenco delle pagine o nell'area dello spazio di lavoro e quando si modifica il
documento originale e si interagisce con testo, immagini e maschere.

Le opzioni disponibili nel menu variano in base alla voce su cui si fa clic con il tasto destro del mouse e
alle impostazioni lavoro correnti. Se si fa clic con il tasto destro del mouse su un foglio, ad esempio, è
possibile usare le opzioni nel menu attivato con il tasto destro per tagliare, copiare ed eliminare il
foglio, per configurare eccezioni, schede e capitoli, per inserire pagine e per selezionare altri fogli nel
lavoro in base alle loro proprietà.
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È possibile applicare le opzioni del menu attivato con il tasto destro a più pagine, fogli o oggetti.
Selezionare le pagine, i fogli o gli oggetti, fare clic con il tasto destro del mouse sulla selezione, quindi
selezionare una delle opzioni disponibili nel menu.

Per ulteriori informazioni sulle opzioni di modifica lavoro disponibili, consultare Modifica dei lavori,
pagina 95.

CCoossaa ssii ppuuòò ffaarree ccoonn qquueessttaa aapppplliiccaazziioonnee

Combinare documenti cartacei e file
elettronici in un unico lavoro di stampa.

Vedere Costruzione di un nuovo lavoro, pagina
86.

Correggere l'inclinazione di un documento
scansito.

Vedere Allineamento delle pagine inclinate,
pagina 124.

Selezionare un'area di un documento e
riposizionarla.

Vedere Spostamento di un'area selezionata,
pagina 131.

Eseguire modifiche a pagine multiple in un
solo passaggio.

Vedere Modifica di file originali, pagina 116.

Cosa si può fare con questa applicazione
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Utilizzare altri programmi con questa
applicazione per modificare documenti.

Vedere Uso di programmi esterni per modificare
lavori, pagina 114.

Stampare documenti aggiungendo i numeri
di pagina.

Quando vengono stampati più file in un unico
lavoro, è possibile aggiungere i numeri di pagina
in sequenza continua.

Vedere Aggiunta di numeri di pagina, pagina
198.

Copiare e adattare lo stesso documento più
volte su un foglio singolo.

Vedere Impostazione imposizione raggruppata,
pagina 161.

Creare libretti.

Vedere Impostazione imposizione Libretto,
pagina 158.

Impostare e inserire copertine, fogli divisori
e fogli designati.

Vedere Aggiunta di copertine, pagina 207,
Inserimento di fogli divisori, pagina 215 o
Inserimento dei fogli designati nelle interruzioni di
capitolo, pagina 217.

Impostare e inserire divisori a rubrica.

Consultare Inserimento di schede, pagina 178,
Conversione di una pagina in una scheda,
pagina 179, e Modifica schede, pagina 180.

Stampare documenti con impostazioni di
rilegatura, piegatura o rilegatura a libro.

Vedere Specificazione delle impostazioni di
finitura, pagina 171.
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Visualizzare l'anteprima di stampa di un
documento sullo schermo prima di
stamparlo.

Vedere Anteprima lavori, pagina 229.

Salvare e riutilizzare i dati di un lavoro.

È possibile salvare i lavori per utilizzarli in
seguito.

Vedere Salvataggio di lavori, pagina 234.

Registrazione dei tipi, formati e colori di
carta utilizzati frequentemente.

Vedere Aggiunta di carta personalizzata, pagina
77.

Registrazione di una hot folder (cartella
monitorata).

Una hot folder consente di eseguire imposizione
e finitura e quindi di stampare un documento
senza dover avviare l'applicazione principale.

Vedere Utilizzo di hot folder con impostazioni
predefinite, pagina 250.

PPuunnttii ee pprroocceedduurree pprriinncciippaallii
È possibile seguire il flusso di lavoro illustrato di seguito per creare, modificare ed eseguire l'output dei
lavori.

Per prima cosa, verificare che una stampante sia registrata. Per ulteriori informazioni, vedere
Registrazione delle stampanti, pagina 63.

Punti e procedure principali
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• Per ulteriori informazioni sull'impostazione dei lavori, consultare Preparazione dei lavori, pagina
85.

• Per ulteriori informazioni sulla modifica dei lavori, consultare Modifica dei lavori, pagina 95.

1 Panoramica
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22.. Tutorial

•Tutorial 1: Utilizzo delle funzioni generali
•Tutorial 2: Creazione di un libretto

I tutorial offrono istruzioni passo-passo per aiutare a capire meglio le funzioni e le operazioni di questa
applicazione.

Sono disponibili due tutorial:

• Tutorial 1: Utilizzo delle funzioni generali, pagina 29
Questo tutorial consente di provare le funzioni principali dell'applicazione usando file campione.

• Tutorial 2: Creazione di un libretto, pagina 39
Questo tutorial consente di creare un libretto usando il file PDF della Guida all'installazione fornita con
l'applicazione.

TTuuttoorriiaall 11:: UUttiilliizzzzoo ddeellllee ffuunnzziioonnii ggeenneerraallii
Questo tutorial consente di provare le funzioni principali dell'applicazione usando file campione PDF,
TIFF e JPEG.

Funzioni utilizzate in questo tutorial:

• Creare un nuovo lavoro

• Modifica del layout pagina

– Inserire nuove pagine

– Sposta pagina

– Elimina pagina

• Modifica originale

– Ruota

– Smacchiamento

– Raddrizzamento

– Sposta area
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Preparazione

Prima di iniziare il tutorial, attenersi ai seguenti passaggi.

1. Avviare l'applicazione.

Per ulteriori informazioni su come avviare l'applicazione, consultare la Guida alla configurazione.

2. Preparare i file di prova.

File campione utilizzati in questo tutorial:

• 1_2_A.pdf

• 3_5_4.tif

• 6.jpg

Posizione dei file di prova: Percorso d'installazione di questa applicazione\samples\

Se quando è stata installata l'applicazione è stato scelto il percorso di installazione predefinito, i
file di prova si trovano nella seguente cartella:

C:\Program Files\RICOH\TotalFlow Prep\

Se è stato effettuato un aggiornamento da una versione precedente di TotalFlow Prep, la nuova
versione viene installata nella stessa cartella della versione precedente.

Procedura

Seguire i passaggi illustrati per acquisire familiarità con le funzioni principali di questa applicazione,

Lasciare tutte le impostazioni non identificate in questa procedura ai valori predefiniti.

Passaggio 1: creazione di un lavoro dai file di prova

In questo passaggio, viene creato un lavoro dai file campione (1_2_A.pdf, 3_5_4.tif).

1. Fare clic su [Crea nuovo lavoro] nella schermata [Azioni rapide].

2 Tutorial



2

31

Se un lavoro è già aperto in TotalFlow Prep, andare su File→ Crea nuovo lavoro per creare
un nuovo lavoro.

2. Nella finestra di dialogo [Apri], andare nella cartella samples, tenere premuto il tasto Ctrl e
selezionare 1_2_A.pdf e 3_5_4.tif, quindi fare clic su [Apri].

Per ulteriori informazioni sulla creazione di lavori, consultare Preparazione dei lavori, pagina 85.

Passaggio 2: inserimento di un altro documento

In questo passaggio viene inserito un altro file di prova (6.jpg) nel lavoro creato.

1. Nell'elenco delle pagine, fare clic con il pulsante destro del mouse sull'ultima pagina e
selezionare [Inserisci nuove pagine] dal menu.

1

2

Tutorial 1: Utilizzo delle funzioni generali



2

32

2. Nella finestra di dialogo [Inserisci pagine], fare clic su [Aggiungi file].

3. Nella finestra di dialogo [Apri], passare alla cartella samples, selezionare il file 6.jpg e fare
clic su [Apri].

1

2

2 Tutorial



2

33

4. Nella finestra di dialogo [Inserisci pagine], fare clic su [OK].

Per ulteriori informazioni sull'inserimento di nuove pagine in un lavoro, consultare Inserimento di pagine
da file esistenti o scansiti, pagina 108.

Passaggio 3: eliminare una pagina non necessaria

In questo passaggio, verrà rimossa la pagina con la lettera "A".

1. Nell'elenco delle pagine, andare alla pagina "A".

2. Passare il mouse sulla pagina e fare clic sul , il pulsante [Elimina pagina].

3

4
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Per ulteriori informazioni sull'eliminazione di pagine o fogli, consultare Eliminazione di pagine e fogli,
pagina 104.

Passaggio 4: riordinare le pagine

In questo passaggio, è possibile riposizionare le pagine in modo che siano nell'ordine corretto.

1. Fare clic sulla pagina "4" e tenere premuto il pulsante del mouse, quindi trascinare la pagina
dopo la pagina "3" e rilasciare il pulsante del mouse.

2. Verificare che l'ordine delle pagine sia ora corretto, da "1" a "6".

1

2

1
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Per ulteriori informazioni sullo spostamento delle pagine, consultare Spostamento di pagine, pagina
105.

Passaggio 5: ruotare una pagina

L'orientamento di pagina "5" differisce dall'orientamento delle altre pagine. In questo passaggio,
ruotare la pagina in modo che il suo orientamento corrisponda a quello delle altre pagine.

1. Selezionare pagina "5".

2. Sulla barra degli strumenti, fare clic sul , il pulsante [Strumento ruota pagina] e
selezionare [Ruota pagina di 180°].

2

2
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3. Fare clic sul , il pulsante [Torna a Tutte le pagine], nell'angolo in alto a sinistra dello spazio
di lavoro.

Per ulteriori informazioni su come ruotare le pagine, vedere Rotazione di pagine, pagina 125.

Passaggio 6: eliminare i puntini dalle pagine con rumore

Nelle pagine "3" e "5" è presente del rumore (puntini o segni non desiderati). In questo passaggio, il
rumore verrà eliminato dalle pagine.

1. Selezionare le pagine "3" e "5" tenendo premuto il tasto Ctrl.

2. Nell'area delle impostazioni sulla destra fare clic su [Ripulisci].

3. Nel pannello [Ripulisci] fare clic su [Smacchiamento].
Il metodo [Auto] viene selezionato per impostazione predefinita.

4. In [Pagine], selezionare [Pagine valide selezionate].

5. In [Livello], selezionare [Grezzo].

6. Fare clic su [Applica].

2

1

1
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Per ulteriori informazioni sull'eliminazione delle imperfezioni, consultare Rimozione del rumore con
Elimina puntini, pagina 122.

Passaggio 7: raddrizzare una pagina disallineata

La pagina "4" è disallineata. Questo passaggio serve per allinearla.

1. Fare clic sulla pagina disallineata "4" per selezionarla.

2. Nel pannello [Ripulisci] fare clic su [Raddrizzamento].

3. In [Pagine], selezionare [Pagina attiva].
La pagina viene visualizzata nello spazio di lavoro nella visualizzazione di modifica.

6
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È possibile fare clic sul , il pulsante [Zoom out], o sul , il pulsante [Zoom in], per
regolare il formato della pagina nello spazio di lavoro.

verificare che le opzioni [Righelli], [Griglia] e [Guide] siano selezionate nel menu
[Visualizza].

4. In [Angolo], fare clic su [Manuale].

5. Fare clic sulla pagina e trascinare il cursore per disegnare una linea di riferimento parallela al
bordo disallineato dell’immagine.

6. Fare clic su [Applica].

7. Nell'area delle impostazioni a destra, fare clic su [Ripulisci] per chiudere il pannello [Ripulisci].

Per ulteriori informazioni su come correggere le pagine inclinate, vedere Allineamento delle pagine
inclinate, pagina 124.

Passaggio 8: selezionare e spostare un'area di una pagina

Il numero di pagina sulla pagina "3" si trova in una posizione diversa rispetto ai numeri di pagina sulle
altre pagine. In questo passaggio, spostare il numero della pagina al centro, nella posizione in cui si
trova anche sulle altre pagine.

1. Nell'elenco delle pagine, selezionare la pagina "3" per visualizzarla nello spazio di lavoro.

2. Sulla barra degli strumenti, fare clic sul , il pulsante [Strumento sposta area].

3. Fare clic sulla pagina e trascinare il cursore per creare una selezione che circondi il numero di
pagina.

6

3

5 4
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È possibile utilizzare punti di ancoraggio per ridimensionare l'area selezionata.

4. Fare clic con il pulsante destro del mouse sull'area selezionata e scegliere Al
centro→ Entrambi dal menu.

Per ulteriori informazioni sulla selezione e lo spostamento di un'area, consultare Spostamento di
un'area selezionata, pagina 131.

TTuuttoorriiaall 22:: CCrreeaazziioonnee ddii uunn lliibbrreettttoo
Il tutorial aiuta a familiarizzare con la procedura di creazione di un libretto utilizzando file campione
PDF e TIFF.

A seconda delle funzioni disponibili sulla stampante in uso, è possibile fare pratica creando uno dei
due tipi disponibili di libretto, [A] o [B].

2

3

1

4

Tutorial 2: Creazione di un libretto



2

40

Funzioni utilizzate in questo tutorial:

• Creare un nuovo lavoro

• Creare e rinominare i capitoli

• Modifica originale

– Inserimento testo

– Inserimento immagine

– Elimina immagine

• Impostazioni carta, imposizione e finitura

– Imposta carta lavoro

– Imposta imposizione

– Aggiungi numeri di pagina

– Inserisci schede (solo per libretto [A])

– Finitura (pinzatura e piegatura)

Selezione di un tipo di libretto

Le istruzioni del tutorial coprono due differenti tipi di libretto.

Utilizzare le informazioni nella tabella per scegliere un tipo di libretto in base alle funzioni disponibili
nella stampante. Seguire le istruzioni per il tipo di libretto selezionato.
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Tipo libretto Metodo rilegatura Funzioni stampante richieste

Libretto [A]
Stampa regolare (2 facciate)

Pinzatura: [2 a sinistra]

Inserisci divisori a rubrica
(opzionale)

Pinzatrice

Un vassoio di alimentazione dove è possibile
caricare divisori a rubrica

Se la stampante utilizzata non possiede un
vassoio di alimentazione dove è possibile
caricare divisori a rubrica, è possibile procedere
senza inserire i divisori a rubrica.

Libretto [B]
Rilegatura interna (pinzatura: [2
al centro])

Pinzatrice libretto

Unità di piegatura

Per informazioni sulle funzioni disponibili sulla stampante, consultare la documentazione della
stampante.

Preparazione

Prima di iniziare il tutorial, attenersi ai seguenti passaggi.

1. Avviare l'applicazione.

Per ulteriori informazioni su come avviare l'applicazione, consultare la Guida alla configurazione.

2. Preparare i file di prova.

File campione utilizzati in questo tutorial:

• Setup Guide.pdf

• Per un libretto formato A4:

– L_A4.tif

– R_A4.tif

• Per un libretto formato Letter:

– L_LT.tif

– R_LT.tif

Posizione dei file di prova:

• Setup Guide.pdf: Percorso d'installazione di questa applicazione\manual\

• File .tif: Percorso d'installazione di questa applicazione\samples\

Tutorial 2: Creazione di un libretto
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Se quando è stata installata l'applicazione è stato scelto il percorso di installazione predefinito, i
file di prova si trovano nella seguente cartella:

C:\Program Files\RICOH\TotalFlow Prep\

Se è stato effettuato un aggiornamento da una versione precedente di TotalFlow Prep, la nuova
versione viene installata nella stessa cartella della versione precedente.

3. Controllare la propria stampante.

Verificare di aver registrato una stampante e che sia pronta all'uso.

Vedere Registrazione delle stampanti, pagina 63.

4. Preparare la carta per la stampa.

Caricare la carta per il libretto nel vassoio di alimentazione della stampante. Impostare la carta
in base al tipo di libretto:

Per libretti [A] Per libretti [B]

Formato carta A4 (210 × 297 mm) o Letter
(8,5 × 11 pollici)

A4 (210 × 297 mm) o Letter
(8,5 × 11 pollici)

Numero di fogli (per libretto) 16 fogli per libretto, 3 fogli
per divisori a rubrica
(opzionale)

8 fogli per libretto

Per ulteriori informazioni su come caricare la carta nel vassoio di alimentazione, consultare la
documentazione della stampante.

Procedura

Seguire i passaggi illustrati per creare un libretto usando questa applicazione,

Le istruzioni variano in base a Libretto [A] e Libretto [B]. Leggere le istruzioni relative al tipo di libretto
che si sta creando.

Lasciare tutte le impostazioni non identificate in questa procedura ai valori predefiniti.

Passaggio 1: creare un lavoro dal file di prova

In questo passaggio viene creato un lavoro dal file campione (Setup Guide.pdf).

1. Fare clic su [Crea nuovo lavoro] nella schermata [Azioni rapide].
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Se un lavoro è già aperto in TotalFlow Prep, andare su File→ Crea nuovo lavoro per creare
un nuovo lavoro.

2. Nella finestra di dialogo [Apri], cercare il file Setup Guide.pdf, selezionarlo e fare clic su
[Apri].

Per ulteriori informazioni sulla creazione di lavori, consultare Preparazione dei lavori, pagina 85.

Passaggio 2: creare capitoli

In questo passaggio le pagine vengono divise in capitoli differenti. È importante per poter poi
procedere con l'impostazione dei numeri di pagina.

Impostare i capitoli in base a questa tabella:

1

2
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Numero
capitolo Nome capitolo Prima pagina del capitolo

1 Prefazione Pagina 1

2 Capitolo 1 Prima pagina di "1. Prima dell'installazione", pagina 11

3 Capitolo 2 Prima pagina di "2. Installazione", pagina 15

4 Capitolo 3 Prima pagina di "3. Avvio/Arresto", pagina 25

1. Accertarsi che [Vista elenco] sia attivo nell'elenco delle pagine.

2. Passare il mouse sulla pagina 1 e fare clic sul , il pulsante [Crea capitolo].

3. Fare clic nel campo del capitolo, eliminare il nome predefinito del capitolo e inserire
Prefazione.

4. Attenersi ai passaggi precedenti per creare e rinominare il resto dei capitoli.

21

3
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Per ulteriori informazioni sulla creazione e la ridenominazione dei capitoli, consultare Creazione di
capitoli, pagina 111.

Passaggio 3: impostare la carta e il vassoio di alimentazione

In questo passaggio viene specificata la carta che si desidera utilizzare per il lavoro.

1. Assicurarsi che la stampante che si desidera utilizzare sia selezionata nel menu delle stampanti.

2. Aprire il menu di selezione carta nella barra degli strumenti e selezionare la carta da utilizzare
per la stampa nella schermata [Seleziona carta].
I tipi di carta attualmente caricati nei vassoi della stampante sono elencati nella sezione [Carta
caricata].

3. Aprire il menu di selezione del vassoio nella barra degli strumenti e selezionare il vassoio di
alimentazione in cui è caricata la carta.

12

3
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Per ulteriori informazioni su come specificare le impostazioni carta, consultare Specificazione delle
impostazioni carta, pagina 154.

Passaggio 4: inserire un testo sulla copertina

In questo passaggio, inserire il testo Campione sulla copertina.

1. Nell'elenco delle pagine, passare alla pagina di copertina (pagina 1) e selezionarla.

2. Sulla barra degli strumenti, fare clic sul , il pulsante [Strumento testo].

3. Posizionare il cursore sulla pagina e fare clic per inserire una casella di testo.

4. Nella casella di testo, inserire Campione, quindi fare clic in qualsiasi altro punto della pagina per
salvare il testo.

5. Fare clic sul testo e tenere premuto il pulsante del mouse, quindi trascinare il testo nell'angolo in
alto a sinistra della pagina e rilasciare il pulsante del mouse.

21

43
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Per ulteriori informazioni sull'inserimento e la modifica del testo, consultare Aggiunta di testo, pagina
136 e Modifica di testo, pagina 136.

Passaggio 5: inserire un'immagine nella pagina

In questo passaggio, inserire i file immagine di prova (L_A4.tif, R_A4.tif, L_LT.tif, R_LT.tif) sui
margini delle pagine.

1. Fare clic sul , il pulsante [Zoom out], finché non viene visualizzata l'intera pagina nello
spazio di lavoro.

2. Sulla barra degli strumenti, fare clic sul , il pulsante [Strumento immagine] e fare clic su
[Scegli immagine...].

5

2

1
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3. Nella finestra di dialogo [Apri], andare nella cartella samples, selezionare il file L_A4.tif o
L_LT.tif e fare clic su [Apri].

Verificare di aver selezionato l'immagine in base alla carta che si desidera utilizzare per
stampare il lavoro:

• L_A4.tif per carta A4.

• L_LT.tif per carta Letter.

4. Selezionare l'immagine, fare clic sul pulsante , il pulsante [Mantieni proporzioni], e
specificare queste impostazioni di posizione e dimensione:

• Nel campo [x] immettere 0 mm (0 pollici).

• Nel campo [y] immettere 0 mm (0 pollici).

• Nel campo [l] immettere 22 mm (0,86 pollici).

• Nel campo [a] immettere 297 mm (11 pollici).

5. Fare clic con il pulsante destro del mouse sull'immagine e selezionare [Taglia] dal menu.

3

4

2 Tutorial



2

49

6. Fare di nuovo clic con il pulsante destro del mouse e selezionare Incolla su→ Pagine pari dal
menu.

7. Fare clic sul , il pulsante [Strumento immagine], quindi fare clic su [Scegli immagine...].

5

6
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8. Nella finestra di dialogo [Apri], andare nella cartella samples, selezionare il file R_A4.tif o
R_LT.tif e fare clic su [Apri].

Verificare di aver selezionato l'immagine in base alla carta che si desidera utilizzare per
stampare il lavoro:

• R_A4.tif per carta A4.

• R_LT.tif per carta Letter.

9. Selezionare l'immagine, fare clic sul pulsante , il pulsante [Mantieni proporzioni], e
specificare queste impostazioni di posizione e dimensione:

• Nel campo [x] immettere 188 mm (7,64 pollici).

• Nel campo [y] immettere 0 mm (0 pollici).

• Nel campo [l] immettere 22 mm (0,86 pollici).

• Nel campo [a] immettere 297 mm (11 pollici).

7

8
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10. Fare clic con il pulsante destro del mouse sull'immagine e selezionare [Taglia] dal menu.

11. Fare di nuovo clic con il pulsante destro del mouse e selezionare Incolla su→ Pagine dispari
dal menu.

9

10
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Per ulteriori informazioni sull'inserimento e la modifica delle immagini, consultare Aggiunta di
un’immagine, pagina 141, Modifica di un’immagine, pagina 142 e Taglia, copia e incolla di
un'immagine, pagina 144.

Passaggio 6: eliminare le immagini inserite sulle copertine

In questo passaggio, vengono eliminate le immagini posizionate nelle copertine anteriore e posteriore.

1. Fare clic con il pulsante destro del mouse sull'immagine sulla pagina di copertina anteriore e
selezionare [Elimina] dal menu.

2. Nell'elenco delle pagine, passare alla pagina di copertina posteriore e selezionarla.

3. Fare clic con il pulsante destro del mouse sull'immagine sulla pagina di copertina posteriore e
selezionare [Elimina] dal menu.

11

1
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Passaggio 7: impostare l'imposizione

In questo passaggio, vengono specificate le impostazioni di imposizione.

1. Fare clic sul , il pulsante [Vista foglio], e regolare il livello di zoom per la visualizzazione
di più pagine nello spazio di lavoro.

2. Nell'area delle impostazioni sulla destra fare clic su [Imposizione].

3. Specificare le impostazioni di imposizione in base al tipo di libretto che si desidera creare:

• Per il libretto [A]:

1. Fare clic su [Normale].

2. In [Lato di stampa], selezionare [Entrambi i lati (2 facciate), apri a sinistra].

3. In [Scala], selezionare [Ridimensiona e adatta].

32
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• Per il libretto [B]:

1. Fare clic su [Libretto].

2. Verificare che [Libretto] sia selezionato in [Tipo libretto].

3. In [Scala], selezionare [Ridimensiona e adatta].

Se il numero di pagine non è divisibile per quattro, TotalFlow Prep aggiunge
automaticamente pagine vuote al lavoro.

4. Nell'area delle impostazioni a destra, fare clic su [Imposizione] per chiudere il pannello
[Imposizione].

3

21

3

21
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Per ulteriori informazioni su come specificare le impostazioni di imposizione, consultare Specificazione
delle impostazioni di imposizione, pagina 157.

I passaggi successivi di questa procedura prevedono l'uso del libretto [A] per le immagini fornite con le
istruzioni.

Passaggio 8: aggiungere i numeri di pagina

In questo passaggio, vengono configurate le impostazioni necessarie alla stampa dei numeri di pagina.

1. Nell'area delle impostazioni sulla destra fare clic su [Contenuto pagina].

2. Nel pannello [Contenuto pagina] fare clic su [Numeri pagina].

3. Nella schermata [Numeri pagina], configurare queste impostazioni di numerazione delle
pagine:

1. In [Formato], selezionare [P1, P2].

2. Selezionare [Arial] per il tipo di font e specificare 7 punti per la dimensione del font.

3. In [Anteriore], selezionare [In basso] - [Al centro] e immettere 10 mm (0,39 pollici) nel
campo [Dal basso].
Per impostazione predefinita, l'opzione [Usa impostazioni per entrambi i lati] è abilitata e
le impostazioni di posizione specificate per i numeri di pagina si applicano a entrambi i lati
del foglio.

4. In [Capitoli], immettere 3 in [Pagina iniziale] e immettere 1 in [Numero iniziale] per
Capitolo 1.

Per impostazione predefinita, [Numero iniziale] per ogni capitolo è bloccato e la
numerazione continua dal capitolo precedente.

5. In [Salta numerazione sulle pagine], immettere il numero dell'ultima pagina in [Salta
pagina nr.].

2 1
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6. Fare clic su [OK].

4. Nell'area delle impostazioni a destra, fare clic su [Contenuto pagina] per chiudere il pannello
[Contenuto pagina].

Per ulteriori informazioni sull'inserimento dei numeri pagina, consultare Aggiunta di numeri di pagina,
pagina 198.

Passaggio 9: specificare le impostazioni per aggiungere un divisore a rubrica

In questo passaggio, specificare le impostazioni per inserire un divisore a rubrica.

Saltare questo passaggio e passare a Passaggio 10: specificare le impostazioni di finitura, pagina 58
se non si dispone di divisori a rubrica o se si sta creando un Libretto [B].

1. Nell'elenco delle pagine, selezionare la prima pagina del Capitolo 1, Capitolo 2 e Capitolo
3 tenendo premuto il tasto Ctrl.

2. Fare clic con il tasto destro del mouse sulla selezione e scegliere Schede→ Inserisci e
modifica... dal menu.

1 4

5 6
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3. Nella schermata [Modifica schede], configurare queste impostazioni:

1. Selezionare un'impostazione predefinita per i divisori a rubrica dall'elenco [Impostazioni
predefinite divisori a rubrica].

È possibile fare clic sul pulsante [Modifica] accanto al divisore a rubrica preimpostato per
visualizzare e modificare le sue impostazioni nella casella di dialogo [Modifica
impostazioni predefinite divisori a rubrica].

Se non sono disponibili impostazioni predefinite per i divisori a rubrica, fare clic su [Nuova
impostazione predefinita] per aprire la finestra di dialogo [Aggiungi impostazioni
predefinite divisori a rubrica] e registrare una nuova impostazione per divisore a rubrica
per il tipo di divisore a rubrica che si utilizzerà.

2. In [Vassoio di alimentazione scheda], selezionare il vassoio in cui viene caricato il
divisore a rubrica.

3. In [Divisori a rubrica], selezionare la carta da utilizzare per il divisore a rubrica.

4. Fare clic su [OK].

1 2
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Per ulteriori informazioni sull'inserimento e la modifica delle schede, consultare Inserimento di schede,
pagina 178 e Modifica schede, pagina 180.

È anche possibile stampare il contenuto dei lavori sui divisori a rubrica. Per ulteriori informazioni,
vedere Conversione di una pagina in una scheda, pagina 179.

Passaggio 10: specificare le impostazioni di finitura

In questo passaggio, vengono specificate le impostazioni di finitura necessarie per rilegare il libretto.

1. Nell'area delle impostazioni sulla destra fare clic su [Finitura].

2. Nel pannello [Finitura], specificare le impostazioni di finitura in base al tipo di libretto che si
desidera creare:

• Per il libretto [A], selezionare [2 a sinistra] in [Pinzatura].

• Per il libretto [B], selezionare [2 al centro] in [Pinzatura].

31 2
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3. Nell'area delle impostazioni a destra, fare clic su [Finitura] per chiudere il pannello [Finitura].

Per ulteriori informazioni sulle impostazioni di finitura, consultare Specificazione delle impostazioni di
finitura, pagina 171.

Passaggio 11: visualizzare l'anteprima di stampa e stampare il documento

In questo passaggio viene mostrato come visualizzare l'anteprima per assicurarsi che le impostazioni
specificate siano state applicate correttamente prima di procedere con la stampa del documento.

1. Fare clic sul , il pulsante [Vista reader], nell'angolo destro dello spazio di lavoro.

2. Fare clic sul bordo esterno delle pagine o usare il , il pulsante [Pagina precedente], e il

, il pulsante [Pagina successiva], per navigare nel lavoro e verificare l'output.
Verificare che le impostazioni vengano applicate correttamente:

• Inserimento testo

• Inserimento immagine

• Elimina immagine

• Imposizione

• Numerazione pagine

• Inserisci divisori a rubrica (solo per libretto [A])

• Finitura

3. Fare clic su , il pulsante [Stampa].

12
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• Per ulteriori informazioni sull'anteprima dei lavori, vedere Anteprima lavori, pagina 229.

• Per ulteriori dettagli sulla stampa dei lavori, vedere Invio di lavori a una stampante, pagina 230.

Passaggio 12: salvare il lavoro

In questo passaggio, il lavoro viene salvato in formato RJF. È possibile modificare o stampare
successivamente i lavori salvati.

1. Nel menu [File], selezionare [Salva con nome].

2. Nella finestra di dialogo [Salva un file], cercare la cartella in cui si desidera salvare il lavoro e
aprirla, quindi attenersi ai seguenti passaggi:

2 1

3

1

2 Tutorial



2

61

1. Digitare Guida all'installazione nel campo [Nome file].

2. Selezionare [Ricoh Job Format (*.rjf)] dall'elenco [Salva come tipo].

3. Cliccare su [Salva].

Per ulteriori informazioni sul salvataggio dei lavori, consultare Salvataggio di lavori, pagina 234.

1

2 3
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33.. Configurazione

•Registrazione delle stampanti
•Gestione del catalogo carta
•Impostazione delle preferenze

È possibile registrare e configurare le stampanti che si desidera utilizzare con TotalFlow Prep e gestire il
catalogo carta. Per migliorare la produttività, è anche possibile impostare preferenze per
personalizzare le impostazioni generali, di visualizzazione e del programma esterno.

RReeggiissttrraazziioonnee ddeellllee ssttaammppaannttii
Per poter stampare documenti utilizzando quest'applicazione è innanzitutto necessario registrare una
stampante. Per poter gestire tipi diversi di output è possibile registrare varie stampanti.

• Se non si registra una stampante, è possibile continuare a modificare i lavori usando la stampante
campione. Non è però possibile stampare un lavoro utilizzando la stampante campione.

• Nella versione browser di TotalFlow Prep, non sono disponibili le funzioni di gestione stampante.
Quando si modifica un lavoro nella versione browser, TotalFlow Prep utilizza la stampante che era
stata impostata in TotalFlow Production Manager o in TotalFlow Print Server. Per ulteriori
informazioni, vedere Modifica di lavori nella versione browser di TotalFlow Prep, pagina 225.

TotalFlow Prep può comunicare con le stampanti ticket lavoro supportate usando PostScript o una
combinazione di JDF e PDF o API Fiery.

Il linguaggio di stampa PDF/JDF offre una maggiore gamma di funzioni usando un flusso di lavoro PDF
puro ed è disponibile quando si effettua una connessione a un TotalFlow Print Server o a un server di
stampa EFI Fiery che supporti Fiery JDF. Alcune opzioni di output sono disponibili solo quando il
linguaggio della stampante è [PDF/JDF]. Ad esempio, è possibile specificare funzioni di stampa quali
le impostazioni predefinite configurate su un server di stampa EFI Fiery e le impostazioni di uscita per le
schede inutilizzate solo per le stampanti che utilizzano PDF/JDF. Vedere il file Leggimi del connettore
stampante per i dettagli sulle stampanti e sui controller supportati.

API Fiery fornisce le stesse funzioni del linguaggio per stampanti PDF/JDF e può essere utilizzato per
comunicare con alcune stampanti EFI Fiery dotate di API Fiery versione 5 o successiva. Per l'elenco
delle stampanti supportate, vedere il file Readme di Printer Connector.

È possibile registrare stampanti non RICOH utilizzando file di definizione della stampante
personalizzata creati da esperti regionali. Per ogni stampante registrata, è possibile specificare le
opzioni installabili disponibili. Le possibili opzioni installabili comprendono unità di piegatura,
rilegatura, perforazione, pinzatura e rifilatura.

TotalFlow Prep consente anche di registrare stampanti Windows collegate al sistema e utilizzare un
driver stampante compatibile con il sottosistema di stampa Windows V4.

Aggiunta stampanti

È possibile registrare nuove stampanti nella schermata [Gestione stampante].
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Prima di registrare una stampante assicurarsi che sia computer che stampante siano collegati alla rete in
maniera corretta. Per i dettagli sulle stampanti compatibili con questa applicazione, vedere il file
Leggimi del connettore stampante. Per ulteriori informazioni su come collegare la stampante alla rete,
consultare la documentazione della stampante.

Per aggiungere una stampante:

1. Andare su Impostazioni→ Gestione stampante.

È anche possibile aprire la schermata [Gestione stampante] direttamente dal menu di
selezione stampante nella barra dei menu.

2. Nella schermata [Gestione stampante], fare clic su [Aggiungi stampante].

3. Nella schermata [Aggiungi stampante], seguire questi passaggi:

3 Configurazione
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1. Nel campo [Nome stampante], immettere un nome di visualizzazione per la stampante.
Immettere fino a 32 byte.

2. In [Tipo stampante], selezionare [Stampante standard].

3. Configurare le altre impostazioni della stampante nelle schede [Generale] e [SNMP].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

• Verificare che sulla stampante sia attivato SNMP. Per ulteriori informazioni, consultare la
documentazione della stampante.

• Le impostazioni SNMP configurate devono corrispondere alle relative impostazioni sulla
stampante.

4. Fare clic su [OK].

Aggiunta di stampanti personalizzate

È possibile registrare stampanti non RICOH utilizzando file di definizione della stampante
personalizzata creati da esperti regionali.

Registrazione delle stampanti
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Prima di registrare una stampante assicurarsi che sia computer che stampante siano collegati alla rete in
maniera corretta. Per ulteriori informazioni su come collegare la stampante alla rete, consultare la
documentazione della stampante.

Per aggiungere una stampante personalizzata:

1. Andare suStart→ Tutte le app→ RICOH TotalFlow Prep e fare clic su [Strumento
Stampante Personalizzata].

La procedura potrebbe variare a seconda del sistema operativo in uso.

Lo Strumento Stampante Personalizzata si apre nel browser web predefinito.

2. Aggiungere il file di definizione della stampante personalizzata per la stampante personalizzata
che si desidera registrare.

Per ulteriori informazioni, vedere Importazione di un Custom Printer Definition File, pagina 68.

3. In TotalFlow Prep, andare su Impostazioni→ Gestione stampante.

È anche possibile aprire la schermata [Gestione stampante] direttamente dal menu di
selezione stampante nella barra dei menu.

4. Nella schermata [Gestione stampante], fare clic su [Aggiungi stampante].

5. Nella schermata [Aggiungi stampante], seguire questi passaggi:

3 Configurazione
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1. Nel campo [Nome stampante], immettere un nome di visualizzazione per la stampante.
Immettere fino a 32 byte.

2. In [Tipo stampante], selezionare [Stampante personalizzata].

3. In [Modello stampante], selezionare la stampante personalizzata da aggiungere.
L’elenco delle stampanti dipende dai file di definizione della stampante personalizzata
aggiunti attraverso lo Strumento Stampante Personalizzata.

4. Fare clic su [Impostazioni...] e specificare le opzioni installabili disponibili sulla stampante.

Le opzioni installabili specificate determinano quali impostazioni sono disponibili per i lavori
che utilizzano questa stampante.

Per ulteriori informazioni, vedere Utilizzo di Installable Options, pagina 68.

5. Configurare le altre impostazioni della stampante nella scheda [Generale].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

Registrazione delle stampanti
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Le impostazioni SNMP non sono disponibili per le stampanti personalizzate.

6. Fare clic su [OK].

Importazione di un Custom Printer Definition File

1. Fare clic sul pulsante . Il
pulsante [Import Custom Printer Definition File...] si trova nell'angolo superiore sinistro dello
schermo.
Viene visualizzata la finestra di dialogo [Apri].

2. Selezionare un file .gpz dalla finestra di dialogo e fare clic su [Apri].
Il file .gpz viene visualizzato nella tabella sulla pagina principale e selezionato
automaticamente. È ora possibile utilizzare questo file di definizione della stampante
personalizzata quando si crea un oggetto della stampante nell'applicazione TotalFlow.

Il file .gpz viene visualizzato nella tabella sulla pagina principale.

Eliminazione di un Custom Printer Definition File

1. Nella tabella sulla pagina principale, selezionare il file di definizione della stampante
personalizzata che si desidera eliminare e fare clic su , il pulsante [Elimina].
Sarà visualizzato un messaggio di avviso.

2. Fare clic su [YES].
Il file di definizione della stampante personalizzata selezionato viene eliminato da Printer
Connector.

Dopo la rimozione del file di definizione della stampante personalizzata non è più possibile utilizzare
lo stesso file di definizione eliminato per creare nuove stampanti. Tuttavia, tutte le stampanti create che
utilizzano quel file di definizione della stampante personalizzata funzioneranno ancora correttamente.

Utilizzo di Installable Options

Configurare Installable Options in base alle caratteristiche della propria stampante. Vedere la
documentazione della propria stampante per informazioni sulle capacità del dispositivo.

Per configurare Installable Options:

1. Selezionare le opzioni disponibili per la stampante.

Il [Motore] è selezionato per impostazione predefinita, e fa riferimento al componente
principale di una stampante che esegue la stampa.
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Esempi di opzioni installabili comprendono: unità di perforazione, unità di piegatura, finisher
libretti o pinzatrice.

2. Per salvare le modifiche, fare clic sul pulsante [OK].
Per modificare le caratteristiche della stampante, ritornare al pannello Installable Options e
selezionare le opzioni desiderate in base alle proprie esigenze.

Aggiunta di stampanti Windows

TotalFlow Prep consente di aggiungere stampanti collegate al sistema Windows e utilizzare un driver
stampante compatibile con il sottosistema di stampa Windows V4.

• Questa funzione è attualmente fornita solo come versione di anteprima. Per l'elenco delle limitazioni
note e delle possibili soluzioni, vedere il file Readme disponibile nel menu Start di Windows.

• Prima di registrare una stampante assicurarsi che sia computer che stampante siano collegati alla
rete in maniera corretta. Per ulteriori informazioni su come collegare la stampante alla rete,
consultare la documentazione della stampante.

Per aggiungere una stampante Windows:

1. Verificare che la stampante da aggiungere sia configurata correttamente in Windows e utilizzi un
driver stampante compatibile con il sottosistema di stampa Windows V4.

Per maggiori informazioni, consultare la Guida di Windows e la documentazione della propria
stampante.

Per gli esempi di driver supportati, andare su http://support.ricoh.com/bb/html/dr_ut_e/rc3/
model/p_i/p_i.htm?lang=en.

2. In TotalFlow Prep, andare su Impostazioni→ Gestione stampante.

È anche possibile aprire la schermata [Gestione stampante] direttamente dal menu di
selezione stampante nella barra dei menu.

3. Nella schermata [Gestione stampante], fare clic su [Aggiungi stampante].

Registrazione delle stampanti
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4. Nella schermata [Aggiungi stampante], seguire questi passaggi:

1. Nel campo [Nome stampante], immettere un nome di visualizzazione per la stampante.
Immettere fino a 32 byte.

2. In [Tipo stampante], selezionare [Stampante Windows].

3. In [Modello stampante], selezionare la stampante Windows da aggiungere.
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L'elenco di stampanti include solo le stampanti disponibili sul sistema Windows che utilizza un
driver stampante compatibile con il sottosistema di stampa Windows V4.

4. Fare clic su [OK].

5. Nella schermata [Gestione stampante], passare il mouse sulla stampante Windows registrata e
fare clic sul , il pulsante [Modifica].

6. Nella schermata [Modifica stampante], fare clic su [Impostazioni...].

7. Nella schermata Mappatura della stampante RICOH Windows, configurare le mappature per le
impostazioni disponibili nella stampante.

È già disponibile una serie predefinita di mappature in base al modello di stampante.

Per ulteriori informazioni, fare clic sul pulsante della guida nella schermata Mappatura della
stampante RICOH Windows.

Aggiunta di flussi di lavoro da TotalFlow Production Manager

È possibile registrare flussi di lavoro disponibili in TotalFlow Production Manager nella schermata
[Gestione stampante].

Per stampare lavori tramite TotalFlow Production Manager, è necessario prima impostare TotalFlow
Production Manager e verificare che sia collegato alla rete. Per ulteriori informazioni, consultare la
documentazione di TotalFlow Production Manager.

Per aggiungere un flusso di lavoro:

1. Andare su Impostazioni→ Gestione stampante.

È anche possibile aprire la schermata [Gestione stampante] direttamente dal menu di
selezione stampante nella barra dei menu.

2. Nella schermata [Gestione stampante], fare clic su [Aggiungi server].
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3. Configurare le impostazioni per il flusso di lavoro da aggiungere.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

4. Fare clic su [OK].

Modifica impostazioni stampante

È possibile modificare le impostazioni di una stampante registrata.

Per modificare le impostazioni di una stampante:

1. Andare su Impostazioni→ Gestione stampante.

2. Nella schermata [Gestione stampante], passare il mouse sulla stampante e fare clic sul , il
pulsante [Modifica].
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3. Modificare le impostazioni della stampante a seconda delle necessità.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

4. Fare clic su [OK].

Eliminazione stampanti

È possibile eliminare le stampanti registrate che non si utilizzano più.

Per eliminare una stampante:

1. Andare su Impostazioni→ Gestione stampante.

2. Nella schermata [Gestione stampante], passare il mouse sulla stampante da rimuovere e fare
clic sul , il pulsante [Elimina].
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Impostazione della stampante predefinita

È possibile specificare quale stampante usare come predefinita nella schermata [Gestione
stampante].

Per impostare la stampante predefinita:

1. Andare su Impostazioni→ Gestione stampante.

2. Nella schermata [Gestione stampante], passare il mouse sulla stampante da impostare come
predefinita e fare clic sul , il pulsante [Imposta come predefinita].

Visualizzazione delle informazioni sulla stampante

È possibile visualizzare i dettagli della connessione e le informazioni di stato per le stampanti registrate.

Per visualizzare le informazioni della stampante:

1. Andare su Impostazioni→ Gestione stampante.

2. Leggere le informazioni visualizzate per ogni stampante nella schermata [Gestione stampante]:
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• L'icona della stampante predefinita mostra quale stampante è impostata come predefinita.

• L'icona colore e l'icona bianco e nero mostrano se la stampante può stampare in
quadricromia o solo in bianco e nero.

• Sotto al nome della stampante è possibile vedere IP, numero di porta e versione SNMP
impostati per la stampante. Passare il mouse sull'icona della stampante per informazioni sul
linguaggio della stampante, il tipo di controller della stampante e link alla pagina web della
stampante.

• Le icone dello stato di connessione mostrano se la stampante è pronta ad accettare lavori:

[Pronto] La stampante è online ed è pronta a ricevere
lavori.

[Non in linea] La stampante è offline. TotalFlow Prep non può
comunicare con la stampante.

[Attenzione] La stampante è online e può ricevere lavori, ma
indica avvisi quali il livello ridotto dell'inchiostro.

[Errore] La stampante si trova in uno stato di errore e non
può ricevere lavori.

Aggiornamento delle informazioni della stampante

È possibile aggiornare le informazioni di stato e le capacità del dispositivo ricevute dalla stampanti
registrate.

Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

1. Per aggiornare lo stato di una stampante registrata, eseguire una delle seguenti operazioni:

• Chiudere e riaprire la schermata [Gestione stampante].

• Modificare e salvare le impostazioni della stampante.
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Anche lo stato della stampante viene aggiornato automaticamente a intervalli regolari, finché la
schermata [Gestione stampante] è aperta.

2. Per aggiornare le capacità del dispositivo e l'elenco carta disponibile per una stampante
registrata, verificare che la stampante sia selezionata nel menu di selezione della stampante

nella barra dei menu, quindi fare clic su , il pulsante [Aggiorna informazioni stampante],
o selezionare [Aggiorna informazioni stampante] nel menu [Impostazioni].

Anche le capacità del dispositivo e l'elenco carta disponibile vengono aggiornate
automaticamente quando si apre un lavoro, si modificano le impostazioni della stampante o si
cambia stampante dal menu di selezione stampante.

GGeessttiioonnee ddeell ccaattaallooggoo ccaarrttaa
Il catalogo carta contiene tutti i tipi di carta definiti nella stampante selezionata per i lavori e tutti i tipi di
carta personalizzata definiti localmente in TotalFlow Prep. Per tipo di carta si intende carta normale,
buste, moduli, etichette o lucidi da stampare nel lavoro e selezionabili quando vengono impostate le
proprietà carta del lavoro.

Per visualizzare e gestire il catalogo carta:

1. Nel menu [Impostazioni], selezionare [Catalogo carta].

2. Nella schermata [Catalogo carta]:
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• Per ordinare l'elenco carta in ordine alfabetico ascendente o discendente, fare clic
sull’intestazione della colonna.
La sezione [Carta caricata] visualizza i tipi di carta attualmente caricati nei vassoi della
stampante. La sezione [Catalogo completo] visualizza i tipi di carta del catalogo della
stampante non caricati nei vassoi e tutti i tipi di carta personalizzata registrata in TotalFlow
Prep.

• Per vedere se la carta viene dal catalogo della stampante della stampante o si tratta di una
carta personalizzata, controllare la prima colonna. Accanto alla carta personalizzata viene
visualizzata l' .

• Per aggiornare l'elenco carta ricevuto dalla stampante, fare clic su , il pulsante
[Aggiorna catalogo carta].
Anche l'elenco carta viene aggiornato automaticamente quando si apre un lavoro, si
modificano le impostazioni della stampante, si cambia stampante dal menu di selezione della

stampante o si fa clic su , il pulsante [Aggiorna informazioni stampante], nella barra
dei menu.

Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

Aggiunta di carta personalizzata

È possibile registrare carta personalizzata nel catalogo carta in modo che sia disponibile quando
vengono configurate le impostazioni carta.

Per stampare su carta personalizzata registrata, è necessario registrare la stessa carta anche sulla
stampante. Per ulteriori informazioni, consultare la documentazione della stampante.

Per aggiungere carta personalizzata:
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1. Nel menu [Impostazioni], selezionare [Catalogo carta].

2. Nella schermata [Catalogo carta], fare clic su [+Aggiungi carta].

È possibile inoltre aggiungere carta personalizzata direttamente dalla schermata [Seleziona
carta] facendo clic sul pulsante [+Aggiungi carta].

3. Configurare le impostazioni per la carta personalizzata nella schermata [Aggiungi carta].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.
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• Se si seleziona [Personalizzato] nel campo [Dimensione] e vengono immessi valori
personalizzati per altezza e larghezza carta, TotalFlow Prep applica automaticamente i
valori personalizzati all'orientamento della carta.

• È possibile visualizzare un'anteprima delle impostazioni nella casella [Anteprima carta].

4. Fare clic su [Salva].
La carta personalizzata registrata viene aggiunta all'elenco carta nel catalogo carta.

Viene visualizzata l'icona di personalizzazione accanto alla carta personalizzata, in modo
che sia possibile identificarla facilmente.

Modifica di carta personalizzata

È possibile modificare le impostazioni di una carta personalizzata registrata.

• Per stampare su carta personalizzata registrata, è necessario registrare la stessa carta anche sulla
stampante. Per ulteriori informazioni, consultare la documentazione della stampante.

• È possibile modificare solo le impostazioni della carta personalizzata. Per modificare altre carte,
apportare le modifiche nel catalogo carta della stampante.

• Se si modifica una carta personalizzata attualmente in uso, viene impostata una carta con le
proprietà della carta personalizzata modificata al posto della carta personalizzata originale.

Per modificare le impostazioni della carta personalizzata:

1. Nel menu [Impostazioni], selezionare [Catalogo carta].

2. Nella schermata [Catalogo carta], fare clic sul , il pulsante [Modifica] accanto alla carta
personalizzata da modificare.
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Viene visualizzata l'icona di personalizzazione accanto alla carta personalizzata, in modo
che sia possibile identificarla facilmente.

3. Modificare le impostazioni necessarie nella schermata [Aggiorna carta].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

4. Fare clic su [Aggiorna].

Eliminazione di carta personalizzata

È possibile eliminare la carta personalizzata che non si utilizza più.

Se si elimina una carta personalizzata attualmente in uso, viene impostata una carta con le proprietà
della carta personalizzata eliminata al posto della carta personalizzata originale.
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Per eliminare una carta personalizzata:

1. Nel menu [Impostazioni], selezionare [Catalogo carta].

2. Nella schermata [Catalogo carta], fare clic sul , il pulsante [Elimina] accanto alla carta
personalizzata da eliminare.

Viene visualizzata l'icona di personalizzazione accanto alla carta personalizzata, in modo
che sia possibile identificarla facilmente.

Esportazione di carta personalizzata

È possibile esportare la carta personalizzata come file XML in modo che possa essere usata su un altro
computer.

Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

Per esportare la carta personalizzata:

1. Nel menu [Impostazioni], selezionare [Catalogo carta].

2. Nella schermata [Catalogo carta], selezionare la carta personalizzata che si desidera
esportare e fare clic sul pulsante [Esporta...].
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Viene visualizzata l'icona di personalizzazione accanto alla carta personalizzata, in modo
che sia possibile identificarla facilmente.

3. Nella finestra di dialogo [Salva con nome], specificare un nome e la posizione di
memorizzazione per il file XML esportato e fare clic su [Salva].

Importazione di carta personalizzata

È possibile importare carta che è stata esportata come file XML usando TotalFlow Prep o la funzionalità
di esportazione carta disponibile su alcune stampanti con controller EFI Fiery.

• Per informazioni sulle funzioni disponibili sulla stampante, consultare la documentazione della
stampante.

• Sia che la carta sia esportata da TotalFlow Prep o da una stampante, viene importata come carta
personalizzata.

• Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

Per importare la carta personalizzata:

1. Nel menu [Impostazioni], selezionare [Catalogo carta].

2. Nella schermata [Catalogo carta], fare clic sul pulsante [Importa...].
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3. Nella finestra di dialogo [Apri], cercare un file XML con le impostazioni carta, selezionarlo e
fare clic su [Apri].
Se una carta importata ha il medesimo nome di una carta esistente nel catalogo carta, al nome
viene aggiunto un valore numerico tra parentesi,

IImmppoossttaazziioonnee ddeellllee pprreeffeerreennzzee
Per migliorare la produttività, è possibile impostare le preferenze in base al proprio flusso di lavoro e
registrare programmi esterni per la modifica dei file PDF o di documenti immagine.

È possibile personalizzare queste impostazioni:

• Unità di misura predefinita

• Formato carta predefinito per i nuovi lavori

Questa impostazione del formato carta è differente dal formato pagina PDF. È possibile impostare il
formato pagina PDF predefinito nelle impostazioni del driver PDF TotalFlow. Per modificare le
impostazioni del driver PDF TotalFlow:

1. Andare in Pannello di controllo→ Dispositivi e stampanti.

2. Fare clic con il pulsante destro del mouse sull’icona [PDF TotalFlow] e selezionare
[Preferenze di stampa].

A seconda del sistema operativo, TotalFlow PDF e Adobe PDF potrebbero essere visualizzati
come unica voce nel pannello [Dispositivi e stampanti], oppure come [TotalFlow PDF] o
[Adobe PDF]. In tal caso, per modificare le impostazioni del driver TotalFlow PDF, fare clic con
il tasto destro del mouse sull'icona [TotalFlow PDF] o [Adobe PDF] e selezionare Preferenze
di stampa→ TotalFlow PDF.

3. Nella scheda [impostazioni Adobe PDF], selezionare un'opzione dall'elenco impostazioni
[formato pagina Adobe PDF].

• Salvare le modifiche apportate al lavoro nel job ticket o nel file PDF

• Impostazioni del rapporto di aspetto
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• Impostazioni codice utente

• Impostazioni per alto contrasto

• Impostazioni per le anteprime di finitura e le finestre di avviso della descrizione lavoro

• Impostazioni per i programmi esterni

• Impostazioni griglia e guida per la modifica degli originali

Per impostare le preferenze:

1. Nel menu [Impostazioni], selezionare [Preferenze].

2. Nella schermata [Preferenze], configurare le impostazioni disponibili nelle schede [Generale],
[Visualizza], [Programmi esterni] e [Griglia, guide].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

3. Fare clic su [OK].
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44.. Preparazione dei lavori

•Creazione di un nuovo lavoro
•Costruzione di un nuovo lavoro
•Creazione di un nuovo lavoro vuoto
•Apertura dei lavori
•Passaggio tra finestre lavoro aperte
•Chiusura lavori

TotalFlow Prep consente di creare lavori da documenti scansiti e da file elettronici. È anche possibile
applicare automaticamente le impostazioni predefinite, le impostazioni scheda e le impostazioni
capitolo quando viene creato il lavoro.

• Per prestazioni migliori, si consiglia di lavorare con un massimo di 10 lavori aperti alla volta.

• Le prestazioni dell'applicazione dipendono da numerosi fattori, quali le dimensioni del file di
lavoro, le prestazioni del sistema e il carico generale sul sistema.

CCrreeaazziioonnee ddii uunn nnuuoovvoo llaavvoorroo
È possibile creare un nuovo lavoro da file esistenti sul computer utilizzando la funzione [Crea nuovo
lavoro].

Utilizzare questo metodo se il lavoro contiene un singolo file o se tutti i file vengono posizionati nella
stessa cartella e se non si desidera specificare l'ordine dei file all'interno del lavoro.

• I file devono essere collocati in una cartella accessibile dal computer client.

• Accertarsi che i file abbiano un formato supportato. Per ulteriori informazioni, vedere Formati file
supportati, pagina 263.

• Prima di aggiungere file Microsoft Office a un lavoro, accertarsi che sia installato il driver di
TotalFlow PDF. Per ulteriori informazioni, vedere la Guida all’installazione.

• Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

Per creare un nuovo lavoro:

1. Aprire TotalFlow Prep e fare clic su [Crea nuovo lavoro] nella schermata [Azioni rapide].



4

86

Se un lavoro è già aperto in TotalFlow Prep, andare su File→ Crea nuovo lavoro per creare
un nuovo lavoro.

2. Nella casella di dialogo [Apri], cercare i file che si desidera aggiungere al lavoro, selezionarli e
fare clic su [Apri].

Per impostazione predefinita, vengono visualizzati solo i file supportati. Per visualizzare tutti i file
all’interno della cartella, selezionare [Tutti i file] invece di [File personalizzati] accanto al
campo [Nome file].

Se un file è protetto da password, viene segnalato di immettere la password prima di poter
aggiungere il file al lavoro.
I filtri vengono aggiunti al lavoro in ordine alfabetico.

Se è già stato aperto un lavoro in TotalFlow Prep, il nuovo lavoro si apre in una nuova finestra.

CCoossttrruuzziioonnee ddii uunn nnuuoovvoo llaavvoorroo
È possibile costruire un nuovo lavoro da file esistenti sul computer o da file scansiti utilizzando la
funzione [Componi lavoro].

Utilizzare questo metodo se il lavoro conterrà file provenienti da cartelle diverse o da uno scanner e se
si desidera specificare l'ordine dei file all'interno del lavoro. Questo metodo consente anche di
specificare quali pagine comprendere nel lavoro, applicare impostazioni predefinite e creare
automaticamente capitoli e schede.
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• I file devono essere collocati in una cartella accessibile dal computer client.

• Accertarsi che i file abbiano un formato supportato. Per ulteriori informazioni, vedere Formati file
supportati, pagina 263.

• Prima di aggiungere file Microsoft Office a un lavoro, accertarsi che sia installato il driver di
TotalFlow PDF. Per ulteriori informazioni, vedere la Guida all’installazione.

• Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

Costruzione di un lavoro da file esistenti

Per costruire un lavoro da file esistenti:

1. Aprire TotalFlow Prep e fare clic su [Componi lavoro] nella schermata [Azioni rapide].

Se un lavoro è già aperto in TotalFlow Prep, andare su File→ Componi lavoro per costruire un
nuovo lavoro.

2. Nella finestra di dialogo [Componi lavoro], fare clic sul pulsante [Aggiungi file].

Costruzione di un nuovo lavoro
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È anche possibile trascinare file da una cartella Windows e rilasciarli nella finestra di dialogo
[Componi lavoro].

3. Nella casella di dialogo [Apri], cercare i file che si desidera aggiungere al lavoro, selezionarli e
fare clic su [Apri].

Per impostazione predefinita, vengono visualizzati solo i file supportati. Per visualizzare tutti i file
all’interno della cartella, selezionare [Tutti i file] invece di [File personalizzati] accanto al
campo [Nome file].

Se un file è protetto da password, viene segnalato di immettere la password prima di poter
aggiungere il file al lavoro.

4. Ripetere i due passaggi precedenti per aggiungere tutti i file necessari per il lavoro.

È anche possibile importare file da uno scanner per poi aggiungerli al lavoro. Per ulteriori
informazioni, vedere Costruzione di un lavoro da file scansiti, pagina 89.

5. OOppzziioonnaallee:: Nella finestra di dialogo [Componi lavoro], effettuare le regolazioni necessarie e
configurare le altre impostazioni per i file.

• Per riordinare i file all’interno del lavoro, trascinare e rilasciare un file prima o dopo gli altri
file nell’elenco.
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• Per specificare quali pagine comprendere per i file con più pagine, immettere i numeri di
pagina o gli intervalli pagina necessari nella colonna [Intervallo di pagine].
Inserire più pagine o intervalli di pagine separati da virgole.

• Per includere più copie di un file, immettere il numero richiesto di copie nella colonna
[Copie].

• Per rimuovere un file dall’elenco, passare sul file e fare clic su , il pulsante [Elimina].

• Per applicare le impostazioni in una impostazione predefinita registrata quando il lavoro
viene creato, abilitare l’opzione [Applica impostazioni predefinite] e selezionare una
impostazione predefinita dall’elenco.

• Per applicare automaticamente le impostazioni scheda o le impostazioni capitolo quando
viene creato il lavoro, abilitare l'opzione [Schede e capitoli automatici].
È possibile creare schede e capitoli in base ai file all'interno del lavoro o ai segnalibri PDF.
Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

6. Fare clic sul pulsante [Crea].

Se è già stato aperto un lavoro in TotalFlow Prep, il nuovo lavoro si apre in una nuova finestra.

Costruzione di un lavoro da file scansiti

• A seconda dello scanner che si desidera utilizzare, installare e configurare innanzitutto il driver
RICOH TWAIN corrispondente o l’utilità EFI Fiery Remote Scan.
Per informazioni sui dispositivi supportati, vedere il file Leggimi di Printer Connector. Per informazioni
sull’installazione del driver e sulla procedura di configurazione, vedere la documentazione per i
propri driver.

• Per Windows Server 2016 e Windows Server 2019, verificare che sia installata la versione del
sistema operativo Desktop Experience prima di installare il driver TWAIN.

• Per utilizzare lo scanner con l’opzione controller EFI Fiery, è richiesta l’utilità Fiery Remote Scan. In
questo caso, il driver TWAIN non può essere utilizzato.

• Verificare di utilizzare una versione 32 bit di Fiery Remote Scan. La versione 32 bit più recente è
6.6.0.60 ed è disponibile per il download sul sito Web Ricoh. Ad esempio, è possibile andare su
http://support.ricoh.com/bb/html/dr_ut_e/lan_e/model/eb_32/eb_32en.htm e selezionare un
collegamento 32 bit, come http://support.ricoh.com/bb/html/dr_ut_e/lan_e/model/eb_32/
eb_32en.htm#Microsoft%20Windows%2010%20(32-bit).

• Se l'orientamento dei dati acquisiti non è come previsto, è possibile ruotare le pagine utilizzando la
funzione di rotazione fornita da TotalFlow Prep. Per ulteriori informazioni, vedere Rotazione di
pagine, pagina 125.

Per costruire un lavoro da file scansiti:

1. Aprire TotalFlow Prep e fare clic su [Componi lavoro] nella schermata [Azioni rapide].

Costruzione di un nuovo lavoro

http://support.ricoh.com/bb/html/dr_ut_e/lan_e/model/eb_32/eb_32en.htm
http://support.ricoh.com/bb/html/dr_ut_e/lan_e/model/eb_32/eb_32en.htm#Microsoft%20Windows%2010%20(32-bit)
http://support.ricoh.com/bb/html/dr_ut_e/lan_e/model/eb_32/eb_32en.htm#Microsoft%20Windows%2010%20(32-bit)
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Se un lavoro è già aperto in TotalFlow Prep, andare su File→ Componi lavoro per costruire un
nuovo lavoro.

2. Nella finestra di dialogo [Componi lavoro], selezionare uno scanner TWAIN-compatibile
oppure l'utilità Fiery Remote Scan dall'elenco degli scanner e fare clic su [Scansione].

In base allo scanner selezionato, viene avviata la schermata di configurazione del driver TWAIN
o l'utilità Fiery Remote Scan.

3. Attenersi ai passaggi richiesti dal driver dello scanner e scegliere le impostazioni necessarie.
Il file importato dallo scanner viene visualizzato nell'elenco dei file nella finestra di dialogo
[Componi lavoro].

4. Ripetere i due passaggi precedenti per scansire e aggiungere tutti i file necessari per il lavoro.

È anche possibile cercare file esistenti sul computer per poi aggiungerli al lavoro. Per ulteriori
informazioni, vedere Costruzione di un lavoro da file esistenti, pagina 87.

5. OOppzziioonnaallee:: Nella finestra di dialogo [Componi lavoro], effettuare le regolazioni necessarie e
configurare le altre impostazioni per i file.

4 Preparazione dei lavori
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• Per riordinare i file all’interno del lavoro, trascinare e rilasciare un file prima o dopo gli altri
file nell’elenco.

• Per specificare quali pagine comprendere per i file con più pagine, immettere i numeri di
pagina o gli intervalli pagina necessari nella colonna [Intervallo di pagine].
Inserire più pagine o intervalli di pagine separati da virgole.

• Per includere più copie di un file, immettere il numero richiesto di copie nella colonna
[Copie].

• Per rimuovere un file dall’elenco, passare sul file e fare clic su , il pulsante [Elimina].

• Per applicare le impostazioni in una impostazione predefinita registrata quando il lavoro
viene creato, abilitare l’opzione [Applica impostazioni predefinite] e selezionare una
impostazione predefinita dall’elenco.

• Per applicare automaticamente le impostazioni scheda o le impostazioni capitolo quando
viene creato il lavoro, abilitare l'opzione [Schede e capitoli automatici].
È possibile creare schede e capitoli in base ai file all'interno del lavoro o ai segnalibri PDF.
Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

6. Fare clic sul pulsante [Crea].

Se è già stato aperto un lavoro in TotalFlow Prep, il nuovo lavoro si apre in una nuova finestra.

CCrreeaazziioonnee ddii uunn nnuuoovvoo llaavvoorroo vvuuoottoo
È possibile creare un lavoro vuoto con impostazioni predefinite utilizzando la funzione [Nuovo lavoro
vuoto].

Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

Per creare un lavoro vuoto:

1. Aprire TotalFlow Prep.

2. Fare clic su [Nuovo lavoro vuoto] nella schermata [Azioni rapide].

Creazione di un nuovo lavoro vuoto
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Viene creato un nuovo lavoro con una singola pagina vuota. Il formato carta lavoro corrisponde al
formato carta predefinito specificato nella schermata [Preferenze].

Se un lavoro è già aperto in TotalFlow Prep, andare su File→ Nuovo lavoro vuoto per creare un
lavoro vuoto.

AAppeerrttuurraa ddeeii llaavvoorrii
È possibile aprire i lavori salvati come file RJF o JDF per modificarne le impostazioni o ristamparli.

• Quando si apre un lavoro salvato con una stampante non più disponibile, viene usata la stampante
predefinita. Le impostazioni del lavoro vengono regolate automaticamente per corrispondere alle
capacità della stampante predefinita.

• Quando si apre un lavoro salvato con una carta non più disponibile o che ha subito modifiche,
viene utilizzata una carta personalizzata con le medesime proprietà. Lo stesso accade con la carta
specificata per copertine, inserti, schede, divisori, fogli designati e fogli di eccezione.

• Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

Per aprire un lavoro:

1. Aprire TotalFlow Prep e fare clic su [Apri lavoro] nella schermata [Azioni rapide].

I lavori su cui si è recentemente lavorato sono elencati nella sezione [Lavori recenti]. Fare clic
su uno dei lavori in elenco per aprirlo.
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Se in TotalFlow Prep è già aperto un altro lavoro, andare in File→ Apri per aprire un lavoro.
Per aprire un lavoro su cui si è recentemente lavorato, usare l'opzione [Apri recente].

2. Nella finestra di dialogo [Apri], cercare il lavoro che si desidera aprire, selezionarlo e fare clic
su [Apri].

Se un lavoro è protetto da password, viene richiesto di immettere la password prima di poterlo
aprire.
Se in TotalFlow Prep è già aperto un altro lavoro, il lavoro selezionato viene aperto in una nuova
finestra.

È anche possibile aprire un lavoro RJF direttamente da Windows Explorer. Fare doppio clic sul file del
lavoro oppure fare clic con il tasto destro del mouse e selezionare [Apri].

Per informazioni sul salvataggio dei lavori, vedere Salvataggio di lavori, pagina 234.

PPaassssaaggggiioo ttrraa ffiinneessttrree llaavvoorroo aappeerrttee
Ogni lavoro si apre in una nuova finestra di TotalFlow Prep. È possibile passare tra le finestre per
lavorare su più lavori per volta.

Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

Per passare tra finestre lavoro:

1. Fare clic su [Finestra] nella barra dei menu.

2. Selezionare il nome del lavoro che si desidera modificare.

Passaggio tra finestre lavoro aperte
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È anche possibile ridurre le finestre del lavoro usando l'opzione [Riduci] o [Riduci tutte le finestre]
nel menu [Finestra].

CChhiiuussuurraa llaavvoorrii
È possibile chiudere una singola finestra lavoro e mantenere gli altri lavori aperti. Nel caso in cui sia
aperto un solo lavoro che viene chiuso, l'applicazione torna alla schermata [Azioni rapide].

Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

Per chiudere un lavoro:

1. Nel menu [File], selezionare [Chiudi].

2. Specificare se si desidera salvare le modifiche del lavoro nella casella di dialogo di conferma.
La finestra del lavoro viene chiusa.

4 Preparazione dei lavori
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55.. Modifica dei lavori

•Specificazione di una stampante per il lavoro
•Specificazione delle informazioni del lavoro
•Modifica dei layout di pagina
•Creazione di capitoli
•Uso di programmi esterni per modificare lavori
•Modifica di file originali
•Specificazione delle impostazioni carta
•Specificazione delle impostazioni di imposizione
•Specifica delle impostazioni della quinta stazione
•Specificazione delle impostazioni di finitura
•Aggiunta e modifica di schede
•Aggiunta e modifica di schede su margini al vivo
•Aggiunta e modifica di inserti
•Aggiunta di numeri di pagina
•Aggiunta di intestazione e piè di pagina
•Aggiunta dei timbri pagina
•Aggiunta di copertine
•Aggiunta di fogli divisori e fogli designati
•Specificazione delle impostazioni colore
•Specificazione del numero di copie da stampare
•Specificazione delle impostazioni di eccezione
•Modifica di lavori nella versione browser di TotalFlow Prep
•Risoluzione dei conflitti dell’impostazione del lavoro

Una volta creato un lavoro, è possibile utilizzare le funzioni di TotalFlow Prep per cambiare il layout
della pagina e per modificare le pagine originali. È anche possibile specificare proprietà del lavoro
quali imposizione, carta, finitura e impostazioni di output.

• Per prestazioni migliori, si consiglia di lavorare con un massimo di 10 lavori aperti alla volta.

• Le prestazioni dell'applicazione dipendono da numerosi fattori, quali le dimensioni del file di
lavoro, le prestazioni del sistema e il carico generale sul sistema.

SSppeecciiffiiccaazziioonnee ddii uunnaa ssttaammppaannttee ppeerr iill llaavvoorroo
Per migliori risultati, registrare e selezionare la stampante che si desidera usare per stampare il lavoro
prima di avviare la modifica delle impostazioni del lavoro. Se si modifica la stampante dopo aver
specificato impostazioni di carta, imposizione, finitura o output, potrebbe essere necessario regolare le
impostazioni specificate per il lavoro.

Per specificare una stampante per il lavoro:

1. Registrare la stampante che si desidera utilizzare.

Per ulteriori informazioni, vedere Registrazione delle stampanti, pagina 63.

2. Nella barra dei menu, fare clic sul menu delle stampanti e selezionare una stampante
dall'elenco.
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Nel menu di selezione stampante vengono visualizzate solo le stampanti registrate.

La funzione di selezione stampante non è disponibile nella versione browser di TotalFlow Prep. Quando
si modifica un lavoro nella versione browser, TotalFlow Prep utilizza la stampante che era stata
impostata in TotalFlow Production Manager o in TotalFlow Print Server. Per ulteriori informazioni,
vedere Modifica di lavori nella versione browser di TotalFlow Prep, pagina 225.

SSppeecciiffiiccaazziioonnee ddeellllee iinnffoorrmmaazziioonnii ddeell llaavvoorroo
È possibile specificare dettagli utili per il lavoro, come ad esempio il nome cliente, il nome lavoro, il
codice utente, la descrizione del lavoro, la modalità di stampa, le informazioni della pagina banner e
istruzioni speciali.

Per specificare le informazioni sul lavoro:

1. Nell'area delle impostazioni sulla destra, fare clic su [Impostazione lavoro] per visualizzare le
proprietà del lavoro disponibili.

2. Nel pannello [Impostazione lavoro], specificare le proprietà richieste per il lavoro.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

5 Modifica dei lavori
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MMooddiiffiiccaa ddeeii llaayyoouutt ddii ppaaggiinnaa
TotalFlow Prep consente di modificare l'ordine e il layout delle pagine nel lavoro, inserire pagine vuote,
inserire altri documenti, impostare i capitoli ed eseguire programmi esterni per la modifica delle pagine
del lavoro.

Selezione di pagine e fogli

È possibile selezionare le pagine e i fogli all'interno del lavoro per interagire con essi.

Selezione di pagine

È possibile selezionare le pagine nell'elenco pagine.

Per selezionare le pagine:

1. Nell'elenco delle pagine, usare la barra di scorrimento per andare alle pagine da selezionare.

2. Selezionare le pagine usando uno dei seguenti metodi:

• Per selezionare un pagina singola, fare clic sulla miniatura della pagina.

Modifica dei layout di pagina
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• Per selezionare più pagine, tenere premuto il tasto Ctrl e fare clic su ogni pagina che si
desidera selezionare.

• Per selezionare un intervallo di pagine, fare clic sulla prima pagina nell’intervallo, quindi
tenere premuto il tastoMaiusc e fare clic sull’ultima pagina nell’intervallo.

• Per selezionare tutte le pagine, fare clic su una pagina e premere Ctrl+A o fare clic con il
pulsante destro del mouse su una pagina e selezionare [Select all].

• Per i lavori impostati per la sola stampa sul lato anteriore del foglio, per selezionare tutte le
pagine dispari o tutte le pagine pari, fare clic con il pulsante destro del mouse su una pagina
e selezionare Select→ Odd pages o Select→ Even pages.

• Per i lavori impostati per la stampa fronte/retro del foglio, per selezionare tutte le pagine
posizionate sul lato anteriore o tutte le pagine posizionate sul lato posteriore, fare clic con il
pulsante destro del mouse su una pagina e selezionare Select→ Front pages o
Select→ Back pages.

• Per selezionare tutte le pagine con il medesimo formato carta, tipo carta e colore carta di
una pagina specifica, fare clic con il pulsante destro del mouse sulla pagina e selezionare
Select→ Pages like this one.

• Per selezionare tutte le pagine con carta, colore, lato di stampa o eccezioni di pinzatura
applicate, fare clic con il pulsante destro del mouse su una pagina e selezionare
Select→ Page exceptions.

• Per selezionare tutte le schede, fare clic con il pulsante destro del mouse su una pagina e
selezionare Select→ Tab pages.

• Per selezionare tutte le pagine di un capitolo, verificare che [List view] sia attivo e fare clic
sull' nell'intestazione del capitolo. Tenere premuto il tasto Ctrl per effettuare selezioni
multiple.

• Per selezionare pagine specifiche o intervalli di pagine, fare clic con il pulsante destro del
mouse su una pagina qualsiasi e selezionare Select→ Page range.
Nella finestra di dialogo [Page range], immettere le pagine o gli intervalli di pagine da
selezionare. È possibile inserire più pagine o intervalli di pagine separati da virgole, ad
esempio 1-7, 9, 11-n, dove n è l'ultima pagina nel lavoro. Assicurarsi di inserire le pagine e
gli intervalli di pagine in ordine crescente.

Le schede inserite, le copertine prestampate, i fogli designati vuoti, gli inserti e qualsiasi altra
pagina priva di numero di pagina non sono inclusi nella selezione.
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• Per invertire la selezione corrente, fare clic con il tasto destro del mouse su una pagina
selezionata e scegliere Select→ Invert selection. Tutte le pagine selezionate in precedenza
vengono deselezionate e al loro posto vengono selezionate tutte le altre pagine del lavoro.

Quando si seleziona una o più pagine nell'elenco delle pagine, nell'area di lavoro vengono
anche selezionati tutti i fogli corrispondenti. Dopo la selezione delle pagine, è anche possibile
premere la barra spaziatrice per visualizzare i fogli corrispondenti nell'area di lavoro, se questi
inizialmente non sono visibili.

Selezione di fogli

È possibile selezionare i fogli nell'area spazio di lavoro.

Per selezionare i fogli:

1. Verificare che [Sheet view] sia attivo nell'area dello spazio di lavoro.

2. Selezionare i fogli usando uno dei seguenti metodi:

• Per selezionare un foglio singolo, fare clic sulla miniatura del foglio.

• Per selezionare più fogli, tenere premuto il tasto Ctrl e fare clic su ogni foglio che si desidera
selezionare.

• Per selezionare un intervallo di fogli, fare clic sul primo foglio nell'intervallo, quindi tenere
premuto il tasto Maiusc e fare clic sull'ultimo foglio nell'intervallo.

• Per selezionare tutti i fogli, fare clic in qualsiasi punto dello spazio di lavoro e premere Ctrl
+A o fare clic con il pulsante destro del mouse su un foglio e selezionare [Select all].

• Per selezionare tutti i fogli con il medesimo formato carta, tipo di carta e colore carta di un
foglio specifico, fare clic con il pulsante destro del mouse sul foglio e selezionare
Select→ Sheets like this one.

• Per i lavori impostati per la sola stampa sul lato anteriore del foglio, per selezionare tutti i
fogli dispari o tutti i fogli pari, fare clic con il pulsante destro del mouse su un foglio e
selezionare Select→ Odd sheets o Select→ Even sheets.
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• Per selezionare tutti i fogli con oggetti colore, fare clic con il pulsante destro del mouse su un
foglio qualsiasi e selezionare Select→ Color sheets.

• Per selezionare tutti i fogli con carta, colore, lato stampa o eccezioni di pinzatura applicate,
fare clic con il pulsante destro del mouse su un foglio e selezionare Select→ Sheet
exceptions.

• Per selezionare tutte le schede, fare clic con il pulsante destro del mouse su un foglio e
selezionare Select→ Tab sheets.

• Per invertire la selezione corrente, fare clic con il pulsante destro del mouse su un foglio
selezionato e scegliere Select→ Invert selection. Tutti i fogli selezionati in precedenza
vengono deselezionati e al loro posto vengono selezionati tutti gli altri fogli del lavoro.

Quando si seleziona uno o più fogli nell'area dello spazio di lavoro, vengono selezionate
nell'elenco pagine anche tutte le pagine corrispondenti.

Copiare, tagliare e incollare pagine e fogli

È possibile copiare o tagliare pagine e fogli e quindi incollarli all'interno del lavoro.

• Non è possibile copiare o tagliare copertine prestampate o fogli designati vuoti.

• Non è possibile incollare pagine o fogli prima di una copertina anteriore prestampata o prima di
un foglio designato vuoto che viene inserito all'inizio di un capitolo.

Copiare, tagliare e incollare pagine

Per copiare, tagliare e incollare pagine:

1. Selezionare la pagina nell’elenco delle pagine.

• Per selezionare più pagine, tenere premuto il tasto Ctrl e fare clic su ogni pagina che si
desidera selezionare.

• Per selezionare un intervallo di pagine, fare clic sulla prima pagina nell’intervallo, quindi
tenere premuto il tastoMaiusc e fare clic sull’ultima pagina nell’intervallo.

2. Fare clic con il pulsante destro del mouse e selezionare [Copia] o [Taglia] dal menu.
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È anche possibile premere Ctrl+C per copiare o Ctrl+X per tagliare.

3. Selezionare la pagina di destinazione.

Quando vengono incollate pagine copiate, vengono posizionate prima della pagina di
destinazione.

Se il lavoro ha l'imposizione [Normale] o [Combina], è possibile selezionare un foglio di
destinazione anche in [Vista foglio].

4. Fare clic con il tasto destro del mouse e selezionare [Incolla] dal menu.

È anche possibile premere Ctrl+V.

Per annullare un'azione, fare clic su , il pulsante [Annulla].

Incollare pagine all'inizio di un capitolo

Per incollare pagine all’inizio di un capitolo:
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1. Selezionare la pagina nell’elenco delle pagine.

• Per selezionare più pagine, tenere premuto il tasto Ctrl e fare clic su ogni pagina che si
desidera selezionare.

• Per selezionare un intervallo di pagine, fare clic sulla prima pagina nell’intervallo, quindi
tenere premuto il tastoMaiusc e fare clic sull’ultima pagina nell’intervallo.

2. Fare clic con il pulsante destro del mouse e selezionare [Copia] o [Taglia] dal menu.

3. Fare clic con il pulsante destro del mouse sull'intestazione del capitolo e selezionare [Incolla
pagine].

Copiare, tagliare e incollare fogli

Questa funzione non è disponibile se l'imposizione è impostata su [Libretto].

Per copiare, tagliare e incollare fogli:

1. Selezionare il foglio in [Vista foglio].

• Per selezionare più fogli, tenere premuto il tasto Ctrl e fare clic su ogni foglio che si desidera
selezionare.

• Per selezionare un intervallo di fogli, fare clic sul primo foglio nell'intervallo, quindi tenere
premuto il tasto Maiusc e fare clic sull'ultimo foglio nell'intervallo.

2. Fare clic con il pulsante destro del mouse e selezionare [Copia] o [Taglia] dal menu.

È anche possibile premere Ctrl+C per copiare o Ctrl+X per tagliare.

3. Selezionare il foglio di destinazione.
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Quando vengono incollati fogli copiati, vengono posizionati prima del foglio di destinazione.

È anche possibile selezionare una pagina di destinazione nell'elenco delle pagine.

4. Fare clic con il tasto destro del mouse e selezionare [Incolla] dal menu.

È anche possibile premere Ctrl+V.

Per annullare un'azione, fare clic su , il pulsante [Annulla].

Incollare fogli all'inizio di un capitolo

Questa funzione non è disponibile se l'imposizione è impostata su [Libretto].

Per incollare fogli all’inizio di un capitolo:

1. Selezionare il foglio in [Vista foglio].

• Per selezionare più fogli, tenere premuto il tasto Ctrl e fare clic su ogni foglio che si desidera
selezionare.

• Per selezionare un intervallo di fogli, fare clic sul primo foglio nell'intervallo, quindi tenere
premuto il tasto Maiusc e fare clic sull'ultimo foglio nell'intervallo.

2. Fare clic con il pulsante destro del mouse e selezionare [Copia] o [Taglia] dal menu.

3. Fare clic con il pulsante destro del mouse sull'intestazione del capitolo e selezionare [Incolla
pagine].
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Eliminazione di pagine e fogli

È possibile rimuovere pagine o fogli che non sono più necessari nel lavoro.

Eliminazione di pagine

È possibile eliminare pagine nell'elenco delle pagine.

Per eliminare pagine:

1. Selezionare la pagina nell’elenco delle pagine.

• Per selezionare più pagine, tenere premuto il tasto Ctrl e fare clic su ogni pagina che si
desidera selezionare.

• Per selezionare un intervallo di pagine, fare clic sulla prima pagina nell’intervallo, quindi
tenere premuto il tastoMaiusc e fare clic sull’ultima pagina nell’intervallo.

2. Fare clic con il pulsante destro del mouse e selezionare [Elimina] dal menu o premere il tasto
Elimina.

In [Vista elenco], è anche possibile passare con il mouse su una pagina e fare clic su , il
pulsante [Elimina pagina].

Per annullare un'azione di eliminazione, fare clic su , il pulsante [Annulla].

Eliminazione di fogli

È possibile eliminare fogli dall'area dello spazio di lavoro.

Per eliminare fogli:

1. Selezionare il foglio in [Vista foglio].
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• Per selezionare più fogli, tenere premuto il tasto Ctrl e fare clic su ogni foglio che si desidera
selezionare.

• Per selezionare un intervallo di fogli, fare clic sul primo foglio nell'intervallo, quindi tenere
premuto il tasto Maiusc e fare clic sull'ultimo foglio nell'intervallo.

2. Fare clic con il pulsante destro del mouse e selezionare [Elimina] dal menu o premere il tasto
Elimina.

È anche possibile passare il mouse su un foglio e fare clic su , il pulsante [Elimina foglio].

Per annullare un'azione di eliminazione, fare clic su , il pulsante [Annulla].

Spostamento di pagine

È possibile modificare l'ordine delle pagine all'interno del lavoro spostandole in una posizione
differente.

Per spostare le pagine:

1. Nell'elenco delle pagine, selezionare la pagina o le pagine che si desidera spostare.
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Non è possibile spostare copertine prestampate o fogli designati vuoti.

2. Fare clic sulla selezione e tenere premuto il pulsante del mouse, quindi trascinare le pagine nella
nuova posizione e rilasciare il pulsante del mouse.

È anche possibile trascinare le pagine nell'area dello spazio di lavoro sulla destra se lo spazio di
lavoro viene visualizzato in [Vista foglio] e se il lavoro ha l'imposizione [Normale] ed è
impostato per la stampa sul lato anteriore del foglio.

Non è possibile spostare le pagine prima di una copertina anteriore prestampata o dopo una
copertina posteriore prestampata. Non è possibile spostare le pagine prima di un foglio
designato vuoto inserito all'inizio di un capitolo o dopo un foglio designato vuoto inserito alla
fine di un capitolo.

• Per annullare un'azione di spostamento, fare clic sul , il pulsante [Annulla].

• Se il lavoro contiene capitoli, è possibile spostare le pagine direttamente all'interno di un capitolo.

• Se il lavoro ha imposizione [Normale] ed è impostato per la stampa sul lato anteriore del foglio, è
anche possibile riordinare i fogli nel lavoro dall'area dello spazio di lavoro. In [Vista foglio],
selezionare il foglio o i fogli da spostare, quindi trascinarli nella nuova posizione.
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Inserimento di fogli e pagine vuote

È possibile inserire pagine vuote o fogli vuoti all'interno del lavoro.

Non è possibile inserire un foglio o una pagina vuota prima di una copertina anteriore prestampata o
prima di un foglio designato vuoto che sia inserito all'inizio di un capitolo.

Inserimento di pagine vuote

È possibile inserire pagine vuote dall'elenco pagine.

Per inserire una pagina vuota:

1. Selezionare la pagina di destinazione nell'elenco delle pagine.

Quando viene inserita una pagina vuota, questa viene posizionata prima della pagina di
destinazione.

2. Fare clic con il tasto destro del mouse e selezionare [Inserisci pagina vuota] dal menu.

In [Vista elenco], è anche possibile passare il mouse sulla pagina di destinazione e fare clic sul

, il pulsante [Inserisci pagina].
La pagina inserita ha le medesime impostazioni carta della pagina di destinazione, Se la pagina
di destinazione ha un'eccezione carta specificata, la pagina inserita utilizza la carta impostata
per il lavoro.

Inserimento di fogli vuoti

Dall'area dello spazio di lavoro è possibile inserire fogli vuoti.
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Questa funzione non è disponibile se l'imposizione è impostata su [Libretto].

Per inserire un foglio vuoto:

1. Verificare che [Vista foglio] sia attivo nell'area dello spazio di lavoro.

2. Passare il mouse sul foglio di destinazione e fare clic sul , il pulsante [Inserisci foglio].

Quando viene inserito un foglio vuoto, questo viene posizionato prima del foglio di destinazione.

È anche possibile fare clic con il pulsante destro del mouse sul foglio di destinazione e
selezionare [Inserisci foglio vuoto] dal menu.
Il foglio inserito ha le medesime impostazioni carta del foglio di destinazione, Se il foglio di
destinazione ha un'eccezione carta specificata, il foglio inserito utilizza la carta impostata per il
lavoro.

Inserimento di pagine da file esistenti o scansiti

Mentre si modifica un lavoro, è possibile inserire pagine da file esistenti sul computer, da documenti
salvati nei lavori o da file scansiti.

Non è possibile inserire nuove pagine prima di una copertina anteriore prestampata o prima di un
foglio designato vuoto che sia inserito all'inizio di un capitolo.

Per inserire pagine in un lavoro:

1. Fare clic con il pulsante destro del mouse sulla pagina di destinazione nell'elenco delle pagine o
sul foglio di destinazione in [Vista foglio] e selezionare [Inserisci nuove pagine].
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Quando vengono inserite le pagine, vengono posizionate prima del foglio o della pagina di
destinazione.

Se l'imposizione è impostata su [Libretto], è possibile solo inserire nuove pagine dall'elenco
pagine.

2. Nella finestra di dialogo [Inserisci pagine], aggiungere i file dal computer o importare i file da
uno scanner.

• Per aggiungere file dal computer, fare clic su [Aggiungi file], cercare i file da aggiungere
nella finestra di dialogo [Apri], selezionarli e fare clic su [Apri].
È anche possibile trascinare file da una cartella Windows e rilasciarli nella finestra di dialogo
[Inserisci pagine].

Se un file è protetto da password, viene segnalato di immettere la password prima di poter
aggiungere il file al lavoro.
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– I file devono essere collocati in una cartella accessibile dal computer client.

– Accertarsi che i file abbiano un formato supportato. Per ulteriori informazioni, vedere
Formati file supportati, pagina 263.

– Prima di aggiungere file Microsoft Office a un lavoro, accertarsi che sia installato il driver
di TotalFlow PDF. Per ulteriori informazioni, vedere la Guida all’installazione.

• Per importare i file da uno scanner, selezionare uno scanner compatibile con TWAIN o
l'utilità Fiery Remote Scan dall'elenco di scanner e fare clic su [Scansione].
In base allo scanner selezionato, viene avviata la schermata di configurazione del driver
TWAIN o l'utilità Fiery Remote Scan. Attenersi ai passaggi richiesti dal driver dello scanner e
scegliere le impostazioni necessarie.

– La funzione [Scansione] non è disponibile nella versione browser di TotalFlow Prep.

– A seconda dello scanner che si desidera utilizzare, installare e configurare innanzitutto il
driver RICOH TWAIN corrispondente o l’utilità EFI Fiery Remote Scan.

Per informazioni sui dispositivi supportati, vedere il file Leggimi di Printer Connector. Per
informazioni sull’installazione del driver e sulla procedura di configurazione, vedere la
documentazione per i propri driver.

– Per utilizzare lo scanner con l’opzione controller EFI Fiery, è richiesta l’utilità Fiery
Remote Scan. In questo caso, il driver TWAIN non può essere utilizzato.

– Verificare di utilizzare una versione 32 bit di Fiery Remote Scan. La versione 32 bit più
recente è 6.6.0.60 ed è disponibile per il download sul sito Web Ricoh. Ad esempio, è
possibile andare su http://support.ricoh.com/bb/html/dr_ut_e/lan_e/model/eb_32/
eb_32en.htm e selezionare un collegamento 32 bit, come http://support.ricoh.com/bb/
html/dr_ut_e/lan_e/model/eb_32/eb_32en.htm#Microsoft%20Windows%2010%20
(32-bit).

– Se l'orientamento dei dati acquisiti non è come previsto, è possibile ruotare le pagine
utilizzando la funzione di rotazione fornita da TotalFlow Prep. Per ulteriori informazioni,
vedere Rotazione di pagine, pagina 125.

3. Ripetere il passaggio precedente per aggiungere tutti i file richiesti.

4. OOppzziioonnaallee:: Apportare le regolazioni necessarie ai file.
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• Per ordinare nuovamente i file, trascinare e rilasciare un file prima o dopo gli altri file
nell’elenco.

• Per specificare quali pagine comprendere per i file con più pagine, immettere i numeri di
pagina o gli intervalli pagina necessari nella colonna [Intervallo di pagine].
Inserire più pagine o intervalli di pagine separati da virgole.

• Per rimuovere un file dall’elenco, passare sul file e fare clic su , il pulsante [Elimina].

5. Fare clic su [OK].

CCrreeaazziioonnee ddii ccaappiittoollii
È possibile creare capitoli per organizzare le pagine nel lavoro.

I capitoli iniziano sempre sulla parte anteriore del foglio.

Per creare un capitolo:

1. Accertarsi che [Vista elenco] sia attivo nell'elenco delle pagine.

2. Passare con il mouse sulla pagina di destinazione e fare clic su , il pulsante [Crea capitolo].
Il capitolo viene inserito prima della pagina di destinazione.

Viene visualizzata un'icona segnalibro per contrassegnare l'inizio del capitolo.

Ridenominazione di capitoli

Quando si crea un capitolo, viene assegnato un numero e viene etichettato con Capitolo per
impostazione predefinita. È possibile rinominare il capitolo ma non è possibile cambiare il numero del
capitolo.

Per rinominare un capitolo:
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1. Accertarsi che [Vista elenco] sia attivo nell'elenco delle pagine.

2. Fare clic nel campo del capitolo.

3. Immettere un nome capitolo.

È possibile eliminare o sovrascrivere il nome del capitolo predefinito. Immettere fino a 255 byte.

Spostamento dei capitoli

È possibile spostare capitoli insieme alle pagine che essi contengono.

Per spostare capitoli:

1. Accertarsi che [Vista elenco] sia attivo nell'elenco delle pagine.

2. Passare sull'intestazione del capitolo che si desidera spostare per visualizzare il punto di

controllo per il trascinamento .
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3. Fare clic sul punto di controllo per il trascinamento nell'intestazione del capitolo e tenere premuto
il pulsante del mouse, quindi trascinare il capitolo nella nuova posizione e rilasciare il pulsante
del mouse.

È possibile spostare un capitolo solo tra altri capitoli, prima del primo capitolo o dopo l'ultimo
capitolo. Se le prime pagine del lavoro non sono parte di un capitolo, è anche possibile spostare
il capitolo prima di esse. Le prime pagine sono comprese nel capitolo e posizionate dopo le
pagine iniziali nel capitolo.

Fare clic su , il pulsante [Annulla], per annullare un'azione di spostamento.

Annullamento capitoli

È possibile annullare capitoli che non sono più necessari.

Per annullare un capitolo:

1. Accertarsi che [Vista elenco] sia attivo nell'elenco delle pagine.

2. Fare clic con il pulsante destro del mouse sull'intestazione del capitolo e selezionare [Annulla
capitolo] dal menu.

Fare clic su , il pulsante [Annulla], per annullare l'annullamento di un capitolo.
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UUssoo ddii pprrooggrraammmmii eesstteerrnnii ppeerr mmooddiiffiiccaarree llaavvoorrii
È possibile registrare programmi esterni in modo da poterli utilizzare per modificare i lavori.

• Per prima cosa, è necessario registrare i programmi esterni che si desidera utilizzare nella
schermata [Preferenze]. Per ulteriori informazioni, vedere Impostazione delle preferenze, pagina
83.

• Maschere, testo, immagini, numeri di pagina o intestazioni e piè di pagina inseriti nel lavoro non
vengono visualizzati e non possono essere modificati nel programma esterno.

• Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

È possibile utilizzare questi programmi esterni con TotalFlow Prep:

• Per la modifica di documenti PDF immagine, è possibile utilizzare programmi di modifica delle
immagini come Adobe Photoshop e Adobe Photoshop Elements.

Quando si registra Adobe Photoshop Elements, verificare di aver specificato
PhotoshopElementsEditor.exe nel percorso del programma nella schermata [Preferenze]. La
comunicazione con il programma potrebbe non funzionare correttamente se si specifica invece
PhotoshopElementsx.0.exe, dove x.0 è la versione del programma.

• Per la modifica di PDF, è possibile utilizzare programmi di modifica PDF come Adobe Acrobat.

Uso di un programma esterno per modificare documenti PDF immagine

È possibile usare programmi esterni per modificare le pagine del lavoro se il loro formato originale è
Image PDF.

• È possibile solo modificare una pagina per volta nei programmi di modifica delle immagini. Non è
possibile selezionare e modificare contemporaneamente più pagine di un lavoro.

• Se a un file immagine TIFF vengono aggiunte pagine nel programma di modifica delle immagini, in
TotalFlow Prep vengono applicate solo le modifiche apportate alla prima pagina. Le modifiche alle
pagine successive vengono ignorate.

Per modificare una pagina in un programma esterno:

1. Nell'elenco delle pagine, fare clic con il tasto destro del mouse sulla pagina che si desidera
modificare e fare clic su [Modifica originale immagine] nel menu.

È anche possibile selezionare la pagina e fare clic su Modifica→Modifica originale
immagine nella barra dei menu.
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Il programma esterno viene aperto in una nuova finestra.

2. Modificare l'immagine nel programma esterno e salvare le modifiche usando l'opzione [Salva].
Se si utilizza l'opzione [Salva con nome...], le modifiche non vengono apportate nel lavoro.

Se la risoluzione di un file immagine non è specificata, TotalFlow Prep imposta automaticamente
la risoluzione di immagine a 200 dpi. Quando si modifica l’immagine nel programma esterno,
potrebbe essere applicato un diverso valore predefinito. Verificare la risoluzione dell’immagine
prima di salvare l’immagine nel programma esterno. A meno che non si desideri modificare la
risoluzione dell’immagine, accertarsi che questa sia ancora impostata su 200 dpi.

3. In TotalFlow Prep, fare clic su [OK] nella finestra di dialogo del programma esterno per
applicare le modifiche.

Uso di un programma esterno per modificare il PDF di un lavoro intero

È possibile modificare l'intero contenuto di un lavoro come singolo PDF in un altro programma.

• Una volta applicate le modifiche, il formato della pagine potrebbe cambiare da Image PDF a
Object PDF. Di conseguenza, non è più possibile applicare le modifiche immagine a queste pagine,
anche se i dati originali erano un'immagine.

• Non applicare impostazioni di sicurezza al PDF, come una password o impostazioni di
autenticazione.

Per combinare tutte le pagine originali di un lavoro in un solo PDF e modificare il PDF usando un
programma esterno:

1. Fare clic con il tasto destro del mouse su una pagina nell'elenco delle pagine e fare clic su
[Modifica originale PDF] nel menu.

È anche possibile fare clic su Modifica→Modifica originale PDF sulla barra dei menu.

Uso di programmi esterni per modificare lavori
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Il programma esterno viene aperto in una nuova finestra.

2. Modificare il PDF nel programma esterno e salvare le modifiche usando l'opzione [Salva].
Se si utilizza l'opzione [Salva con nome...], le modifiche non vengono apportate nel lavoro.

3. In TotalFlow Prep, fare clic su [OK] nella finestra di dialogo del programma esterno per
applicare le modifiche.

MMooddiiffiiccaa ddii ffiillee oorriiggiinnaallii
Una volta creato un lavoro, è possibile utilizzare TotalFlow Prep per modificare le pagine originali e
aggiungere testo, immagini o maschere. È anche possibile raddrizzare, eliminare puntini, riposizionare
e ruotare gli oggetti o le pagine.

Modifica righelli, griglia e guide

È possibile modificare le impostazioni per righelli, griglia e guide.

Per visualizzare o nascondere righelli, griglia e guide quando si modificano i file originali, utilizzare le
opzioni [Righelli], [Griglia] e [Guide] nel menu [Visualizza].

Per impostazione predefinita, le opzioni [Righelli] e [Guide] sono attivate.

Modifica righelli

I segni del righello indicano la posizione del cursore sulla pagina.

Per modificare le impostazioni per i righelli:

1. Fare clic su Impostazioni→ Preferenze.

2. Per cambiare le unità del righello, selezionare [Pollici] o [Millimetri] nella scheda [Generale].
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Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

Modifica impostazioni griglia

Per modificare le impostazioni della griglia:

1. Fare clic su Impostazioni→ Preferenze, quindi fare clic sulla scheda [Griglia, guide].

2. Per cambiare il formato della griglia, impostare un valore nel menu [Dimensioni griglia].

Il formato della griglia deve essere tra 1 mm (0,01 pollici) e 10 mm (1 pollice).

3. Per cambiare il colore delle righe della griglia, utilizzare il menu [Colore linea griglia].
Selezionare dai colori predefiniti oppure immettere i valori personalizzati nei campi di
inserimento.

4. Per impostare il punto di origine della griglia, selezionare [Origine angolo sinistro superiore]
o [Origine centro]:

• [Origine angolo sinistro superiore]: disegna la griglia dall’angolo superiore sinistro della
pagina.

• [Origine centro]: disegna la griglia dal centro della pagina.

Per impostazione predefinita, il punto di origine è impostato su [Origine angolo sinistro
superiore].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

Modifica guide

Le guide non vengono salvate come parte del lavoro e devono essere applicate ogni volta che il lavoro
viene aperto.

Per aggiungere e modificare le guide:

1. Per aggiungere una guida, posizionare il cursore sulla barra del righello, quindi fare clic e
trascinare la guida sulla pagina.

2. Per spostare una guida, fare clic sulla guida nella barra del righello e trascinarla nella nuova
posizione.
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3. Per modificare il colore delle guide, fare clic su Impostazioni→ Preferenze, quindi fare clic
sulla scheda [Griglia, guide]. Per [Colore linea guida], selezionare dai colori predefiniti
oppure immettere i valori personalizzati nei campi di inserimento.

4. Per rimuovere le guide, fare clic su Visualizza→ Rimuovi guide.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

Allineamento del contenuto della pagina

È possibile allineare il contenuto della pagina utilizzando funzioni di allineamento automatiche o
manuali.

• Sono richieste specifiche impostazioni di imposizione perché [Allinea] funzioni correttamente con
lavori contenenti orientamenti o formati di pagina diversi.
Per utilizzare [Allinea] con lavori contenenti orientamenti o formati pagina diversi:

1. Fare clic su [Imposizione] nell'area delle impostazioni sulla destra.

2. Selezionare [Nessun ridimensionamento] nelle opzioni [Scala].

3. Selezionare [In alto a sinistra] nelle opzioni [Posizione immagine nella cella].

• Se si utilizza la funzione [Allinea] e una delle pagine si sposta al di fuori dello spazio di lavoro,
allineare le pagine manualmente utilizzando la modalità di allineamento [Manuale] e [Anteprima
foglio].

Uso dell’allineamento automatico

Per utilizzare l’allineamento automatico:

1. Fare clic su [Ripulisci] nell'area delle impostazioni sulla destra.

2. Nel pannello [Ripulisci] fare clic su [Allinea].
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In [Modalità di modifica], [Tavolo luminoso] o [Tavolo luminoso speculare] viene
visualizzato un reticolo nello spazio di lavoro per indicare il punto di riferimento sulla pagina.
Fare clic sul reticolo e trascinarlo per riposizionare il punto di riferimento.

3. In [Pagine], selezionare [Tutte le pagine valide], [Pagina attiva], [Pagine valide
selezionate] o [Pagina valide nella risma del tavolo luminoso].

• [Tutte le pagine valide] applica i cambiamenti di allineamento a tutte le pagine valide nel
lavoro.

• [Pagina attiva] applica i cambiamenti di allineamento alla pagina attiva. Quando questa
opzione è selezionata, la pagina attiva viene evidenziata in blu.

• [Pagine valide selezionate] applica i cambiamenti di allineamento a tutte le pagine valide
che sono selezionate nell'elenco delle pagine. Questa è l’impostazione predefinita.

• [Pagina valide nella risma del tavolo luminoso] applica i cambiamenti di allineamento a
tutte le pagine valide nella pila del tavolo luminoso.

4. In [Posizione], fare clic su [Automatico].

5. In [Allinea a], specificare un punto di riferimento per l'allineamento.
Il punto di riferimento predefinito si trova nell’angolo superiore sinistro della pagina.

6. Utilizzare i campi [Da sinistra] e [Dall'alto] per immettere distanze specifiche dal punto di
riferimento.
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7. Per allineare il punto di riferimento del lato posteriore al punto di riferimento del lato anteriore,
selezionare la casella [Speculare].
Se la casella [Speculare] non è selezionata, il punto di riferimento del lato posteriore non è
allineato con il lato anteriore.

• Questo è un esempio con la casella [Speculare] selezionata.

• Questo è un esempio con la casella [Speculare] deselezionata.

8. Se si ha una pagina con margini da applicare in altre pagine, selezionare la casella [Usa
margini della pagina di riferimento] ed immettere il numero della pagina da utilizzare come
riferimento.

• Quando si seleziona la casella [Usa margini della pagina di riferimento], la funzione di
allineamento rileva il contenuto della pagina di riferimento e non della pagina attiva.

• Se non è presente alcun contenuto sulla pagina di riferimento, viene visualizzato un
messaggio di errore e la casella [Usa margini della pagina di riferimento] viene
deselezionata automaticamente.

9. In [Intensità di rilevamento contenuto], selezionare [Grezza (testo, più rapido)] o [Fine
(immagine, più lento)].

10. Fare clic su [Applica].
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Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida contestuale
su schermo.

Uso dell’allineamento manuale

Per utilizzare l’allineamento manuale:

1. Fare clic su [Ripulisci] nell'area delle impostazioni sulla destra.

2. Nel pannello [Ripulisci] fare clic su [Allinea].

3. In [Pagine], selezionare [Tutte le pagine valide], [Pagina attiva], [Pagine valide
selezionate] o [Pagina valide nella risma del tavolo luminoso].

• [Tutte le pagine valide] applica i cambiamenti di allineamento a tutte le pagine valide nel
lavoro.

• [Pagina attiva] applica i cambiamenti di allineamento alla pagina attiva. Quando questa
opzione è selezionata, la pagina attiva viene evidenziata in blu.

• [Pagine valide selezionate] applica i cambiamenti di allineamento a tutte le pagine valide
che sono selezionate nell'elenco delle pagine. Questa è l’impostazione predefinita.

• [Pagina valide nella risma del tavolo luminoso] applica i cambiamenti di allineamento a
tutte le pagine valide nella pila del tavolo luminoso.

4. In [Posizione], fare clic su [Manuale].
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5. Impostare le coordinate [x] e [y] oppure fare clic e trascinare il contenuto della pagina nello
spazio di lavoro per riposizionarlo.

Le modifiche vengono applicate automaticamente.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida contestuale
su schermo.

Rimozione del rumore con Elimina puntini

È possibile rimuovere il rumore dalle pagine utilizzando la funzione [Smacchiamento]. Ad esempio, è
possibile rimuovere i puntini indesiderati o gli artefatti dai documenti scansiti.

• La funzione [Smacchiamento] è disponibile solo per le pagine valide. Una pagina è valida se il
tipo di file originale è Image PDF.

• Anche i segni di punteggiatura quali punti (.), due punti (:), punti e virgola (;), virgole (,), apostrofi
(') e simboli o lettere simili potrebbero venire rimossi dall'immagine. Per annullare le modifiche, fare

clic sul , il pulsante [Annulla], quindi regolare l'area di rimozione e il livello ed eseguire
nuovamente l'eliminazione dei puntini.

• Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

5 Modifica dei lavori



5

123

Per rimuovere il rumore da una pagina:

1. Nell'area delle impostazioni sulla destra fare clic su [Ripulisci].

2. Nel pannello [Ripulisci] fare clic su [Smacchiamento].

3. In [Pagine], selezionare [Tutte le pagine valide], [Pagina attiva], [Pagine valide
selezionate] o [Pagina valide nella risma del tavolo luminoso].

4. In [Livello], selezionare un livello di intensità:

• [Fine] è l'impostazione più bassa.

• [Medio] è l'impostazione media.

• [Grezzo] è l'impostazione più forte. Questa impostazione potrebbe rimuovere anche segni
di punteggiatura quali punti (.), due punti (:), punti e virgola (;), virgole (,), apostrofi (') e
simboli o lettere simili.

5. In [Posizione], fare clic su [Automatico] o [Manuale].

• La modalità [Automatico] applica le impostazioni di eliminazione dei puntini all'intera
pagina.

• La modalità [Manuale] consente di applicare le impostazioni di eliminazione dei puntini a
un'area di destinazione della pagina.

Fare clic sulla pagina e trascinare il cursore sull'area di destinazione per selezionarla.

È anche possibile inserire coordinate nei campi [x] e [y] per impostare la posizione dell'area
e specificare i valori di larghezza e altezza nei campi [l] e [h].

6. Fare clic su [Applica].

Operazioni di eliminazione dei puntini ripetute influiscono sulla qualità dell'immagine. Per
ripetere l'eliminazione dei puntini con impostazioni diverse, annullare prima le modifiche

precedenti con il , il pulsante [Annulla].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida contestuale
su schermo.
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Allineamento delle pagine inclinate

È possibile raddrizzare le pagine disallineate utilizzando la funzione [Raddrizzamento].

• La funzione [Raddrizzamento] è disponibile solo per le pagine valide. Una pagina è valida se il
tipo di file originale è Image PDF.

• Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

Per raddrizzare pagine disallineate:

1. Nell'area delle impostazioni sulla destra fare clic su [Ripulisci].

2. Nel pannello [Ripulisci] fare clic su [Raddrizzamento].

3. In [Pagine], selezionare [Tutte le pagine valide], [Pagina attiva], [Pagine valide
selezionate] o [Pagina valide nella risma del tavolo luminoso].

4. In [Angolo], fare clic su [Automatico] o [Manuale].

• La modalità [Automatico] tenta di identificare i bordi della pagina e correggere
automaticamente il disallineamento. Uno scostamento con angolo fino a ± 15 gradi può
essere corretto automaticamente.
Se la modalità [Automatico] non regola correttamente il disallineamento, utilizzare la
modalità [Manuale].
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• La modalità [Manuale] consente di inserire l'angolo di disallineamento. Può essere corretto
manualmente uno scostamento con angolo fino a ± 30 gradi.
Per impostare l'angolo, è anche possibile fare clic sulla pagina e trascinare il cursore per
disegnare una linea di riferimento parallela al bordo disallineato dell'immagine.

5. Fare clic su [Applica].

Operazioni di raddrizzamento ripetute influiscono sulla qualità dell'immagine. Per ripetere il

raddrizzamento con impostazioni diverse, annullare prima le modifiche precedenti con il , il
pulsante [Annulla].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida contestuale
su schermo.

Rotazione di pagine

È possibile ruotare le pagine utilizzando [Ruota pagina di 180°], [Ruota pagina di 90° in senso
orario] o [Ruota pagina di 90° in senso antiorario].

Per ruotare pagine:

1. Selezionare le pagine di destinazione nell'elenco delle pagine.

• Per selezionare più pagine, tenere premuto il tasto Ctrl e fare clic su ogni pagina che si
desidera selezionare.

• Per selezionare un intervallo di pagine, fare clic sulla prima pagina nell’intervallo, quindi
tenere premuto il tastoMaiusc e fare clic sull’ultima pagina nell’intervallo.

• Per selezionare tutte le pagine, fare clic su una pagina e premere Ctrl+A.

2. Nella barra degli strumenti, fare clic sul , il pulsante [Strumento ruota pagina], e
selezionare tra le opzioni di rotazione disponibili. Le pagine vengono ruotate in base al loro
orientamento corrente.

• [Ruota pagina di 180°] è disponibile per la pagine che supportano la rotazione.

• [Ruota pagina di 90° in senso orario] e [Ruota pagina di 90° in senso antiorario]
sono disponibili solo quando l'imposizione è impostata su [Combina] - [Singolo] o
[Combina] - [Ripeti].

Uso della rotazione automatica

La funzione [Rotazione automatica] forza tutte le pagine PDF originali in modo che abbiano lo stesso
orientamento prima di essere posizionate sul foglio e stampate. Per impostazione predefinita, l'opzione
[Rotazione automatica] è attivata e alcune opzioni di rotazione della pagina sono disabilitate.
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• L’orientamento di ogni pagina PDF originale viene determinato analizzando il rapporto larghezza-
altezza. Se il lavoro è [Verticale], le pagine con orientamento [Orizzontale] vengono ruotate di
90 gradi. Se il lavoro è [Orizzontale], le pagine con orientamento [Verticale] vengono ruotate di
90 gradi prima di essere posizionate sul foglio.

• Le impostazioni [Rotazione automatica] vengono applicate indipendentemente da come era stato
impostato l'orientamento per la pagina PDF originale. Ad esempio, [Rotazione automatica] si
applica quando l'orientamento originale era stato impostato importando file con un diverso
orientamento rispetto al lavoro, creando lavori da file con orientamenti diversi, ruotando
manualmente le pagine di 90 gradi o tagliando le pagine a un diverso rapporto larghezza-altezza
rispetto all'orientamento del lavoro.

• Quando l'opzione [Rotazione automatica] viene attivata, vengono disabilitate le opzioni [Ruota
pagina di 90° in senso orario] e [Ruota pagina di 90° in senso antiorario].

• Quando l'opzione [Rotazione automatica] viene disattivata, vengono abilitate le opzioni [Ruota
pagina di 90° in senso orario] e [Ruota pagina di 90° in senso antiorario].

• Se [Rotazione automatica] capovolge una pagina dall'alto verso il basso, utilizzare [Ruota
pagina di 180°] per correggere l'orientamento della pagina.

Per disattivare [Rotazione automatica]:

1. Aprire il pannello [Imposizione].

2. In [Rotazione automatica], fare clic su [Disattivo].

• Le impostazioni [Rotazione automatica] sono modificabili solo nell'imposizione [Normale].

• È possibile salvare un lavoro con l'opzione [Rotazione automatica] disattivata.

Rotazione di pagine su un foglio

È possibile ruotare tutte le pagine posizionate su un foglio quando il layout dello spazio di lavoro è
impostato su [Vista foglio].

Per ruotare tutte le pagine su un foglio:

1. Impostare il layout dello spazio di lavoro su [Vista foglio].

2. Selezionare i fogli di destinazione nello spazio di lavoro.

• Per selezionare più fogli, tenere premuto il tasto Ctrl e fare clic su ogni foglio che si desidera
selezionare.

• Per selezionare un intervallo di fogli, fare clic sul primo foglio nell'intervallo, quindi tenere
premuto il tasto Maiusc e fare clic sull'ultimo foglio nell'intervallo.

• Per selezionare tutti i fogli, fare clic su un foglio e premere Ctrl+A.

3. Nella barra degli strumenti, fare clic sul , il pulsante [Strumento ruota pagina], e
selezionare tra le opzioni di rotazione disponibili. Le pagine vengono ruotate in base al loro
orientamento corrente.
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• [Ruota pagina di 180°] è disponibile per la pagine che supportano la rotazione.

• [Ruota pagina di 90° in senso orario] e [Ruota pagina di 90° in senso antiorario]
sono disponibili solo quando l'imposizione è impostata su [Combina] - [Singolo] o
[Combina] - [Ripeti].

Aggiunta di una maschera

È possibile aggiungere una maschera a una pagina per coprire contenuti.

Per aggiungere una maschera a una pagina:

1. Sulla barra degli strumenti, fare clic sul , il pulsante [Strumento maschera].

2. Fare clic su , il pulsante [Tipo maschera], e selezionare un tipo di maschera dall'elenco.

• [Maschera]: copre il contenuto che è all'interno dell'area selezionata.

• [Inverti maschera]: copre il contenuto che è al di fuori dell'area selezionata.
Questa opzione è utile, ad esempio, per rimuovere le ombreggiature dei bordi dai
documenti scansiti.

3. Fare clic su , il pulsante [Colore], per aprire la tavolozza dei colori, quindi impostare il
colore della maschera e fare clic su [OK].
È possibile selezionare dai colori predefiniti oppure inserire i valori personalizzati nei campi di
inserimento. Per selezionare un colore da un qualsiasi oggetto nello spazio di lavoro, utilizzare il
selezionatore di colore.

4. Fare clic sulla pagina e trascinare il cursore per creare la maschera.

A seconda del tipo di maschera, la maschera viene aggiunta sopra il contenuto all'interno
dell'area selezionata o sopra il contenuto all'esterno dell'area selezionata.

Modifica di una maschera

È possibile modificare una maschera cambiandone tipo, colore, dimensioni, rotazione o posizione.
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Modifica del tipo di maschera

Per cambiare il tipo di maschera:

1. Fare clic sulla maschera per selezionarla.

2. Sulla barra degli strumenti, fare clic su , il pulsante [Tipo maschera], e selezionare un tipo
di maschera dall'elenco:

• [Maschera]: copre il contenuto che è all'interno dell'area selezionata.

• [Inverti maschera]: copre il contenuto che è al di fuori dell'area selezionata.
Questa opzione è utile, ad esempio, per rimuovere le ombreggiature dei bordi dai
documenti scansiti.

Modifica del colore della maschera

Per cambiare il colore di una maschera:

1. Fare clic sulla maschera per selezionarla.

2. Sulla barra degli strumenti, fare clic su , il pulsante [Colore], per aprire la tavolozza dei
colori.

3. Selezionare dai colori predefiniti oppure inserire i valori personalizzati nei campi di inserimento.

Per selezionare un colore da un qualsiasi oggetto nello spazio di lavoro, utilizzare il
selezionatore di colore.

4. Fare clic su [OK].

Ridimensionamento di una maschera

Per ridimensionare una maschera:

1. Fare clic sulla maschera per selezionarla.

2. Fare clic su un punto di ancoraggio e tenere premuto, quindi trascinare la maschera alle
dimensioni desiderate.
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Il pulsante di blocco [Mantieni proporzioni] sulla barra degli strumenti limita il rapporto di
larghezza e altezza quando la maschera viene ridimensionata. Per impostazione predefinita, è
selezionato il pulsante di blocco [Mantieni proporzioni].

Posizionamento di una maschera

È possibile posizionare una maschera immettendo coordinate nei campi di inserimento [x] e [y] sulla
barra degli strumenti oppure spostando manualmente la maschera sulla pagina. È possibile anche
centrare automaticamente la maschera utilizzando le opzioni del menu a comparsa attivato dal tasto
destro del mouse.

Posizionamento manuale

Per posizionare una maschera manualmente:

1. Fare clic sulla maschera per selezionarla.

2. Posizionare il cursore sulla maschera.

Il cursore diventa un'icona di posizione.

3. Fare clic e tenere premuto, quindi spostare la maschera nella posizione desiderata.

Posizionamento con coordinate X e Y

Per posizionare una maschera con coordinate X e Y:

1. Fare clic sulla maschera per selezionarla.

2. Immettere le coordinate nei campi di immissione [x] e [y] sulla barra degli strumenti per
posizionare la maschera sulla pagina.
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Centratura di una maschera

Per centrare una maschera:

1. Fare clic sulla maschera per selezionarla.

2. Fare clic con il pulsante destro del mouse e selezionare [Al centro], quindi [Orizzontalmente],
[Verticalmente] o [Entrambi] dal menu.

Tagliare, copiare e incollare una maschera

È possibile tagliare, copiare e incollare una maschera. È possibile incollare una maschera che viene
copiata negli appunti del sistema sulla pagina corrente o su più pagine.

Per tagliare, copiare o incollare una maschera:

1. Fare clic sulla maschera per selezionarla.

2. Fare clic con il pulsante destro del mouse e selezionare [Taglia] o [Copia] dal menu.

• Utilizzare [Taglia] per rimuovere la maschera dalla pagina corrente e incollarla su altre
pagine.

• Utilizzare [Copia] per copiare la maschera e incollarla nella pagina corrente o in altre
pagine.

3. Andare alla pagina di destinazione, fare clic con il pulsante destro del mouse e selezionare
[Incolla] per incollare la maschera.

Per eliminare la maschera, fare clic con il pulsante destro del mouse su di essa e selezionare
[Elimina].

Copia di una maschera su più pagine

Per copiare una maschera su più pagine:

1. Fare clic sulla maschera per selezionarla.

2. Fare clic con il tasto destro del mouse e selezionare [Copia] dal menu.

3. Fare clic nuovamente con il pulsante destro del mouse e selezionare [Incolla su].

4. Specificare le pagine di destinazione selezionando una delle opzioni disponibili nel menu
[Incolla su]:

• L'opzione [Tutte le pagine] consente di incollare la maschera su tutte le pagine.

• L'opzione [Pagine selezionate] incolla la maschera sulle pagine selezionate dall'elenco
pagine.
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Per impostazione predefinita, l'opzione [Pagine selezionate] è visualizzata in grigio.
Perché l'opzione sia disponibile, selezionare le pagine dall’elenco pagine. Vedere
passaggio numero 5.

• L'opzione [Pagine pari] consente di incollare la maschera su tutte le pagine pari.

• L'opzione [Pagine dispari] consente di incollare la maschera su tutte le pagine dispari.

Le opzioni [Pagine pari] e [Pagine dispari] non dipendono dai numeri di pagina, ma dal
numero reale di pagine in un lavoro.

5. Per utilizzare l'opzione [Pagine selezionate]:

1. Selezionare le pagine di destinazione dall'elenco delle pagine.

• Per selezionare più pagine, tenere premuto il tasto Ctrl e fare clic su ogni pagina che si
desidera selezionare.

• Per selezionare un intervallo di pagine, fare clic sulla prima pagina nell’intervallo, quindi
tenere premuto il tasto Maiusc e fare clic sull’ultima pagina nell’intervallo.

2. Fare clic con il pulsante destro del mouse e selezionare Incolla su→ Pagine selezionate.

A volte quando viene copiata una maschera su pagine di dimensioni minori, le coordinate X,Y della
maschera cadono al di fuori dell'area stampabile delle pagine di destinazione. Viene visualizzato un
messaggio con le opzioni per incollare e centrare automaticamente gli oggetti non stampabili oppure
ignorarli e incollare solo gli oggetti stampabili.

• Fare clic su [OK] per incollare e centrare automaticamente gli oggetti non stampabili nella pagina
di destinazione. Se vengono selezionate più pagine di destinazione, gli oggetti non stampabili
vengono incollati e automaticamente centrati su tali pagine con aree stampabili più piccole.

• Fare clic su [Annulla] per ignorare gli oggetti non stampabili. Tutti gli oggetti stampabili che sono
stati copiati vengono incollati nella pagina di destinazione. Se vengono selezionate più pagine di
destinazione, gli oggetti stampabili vengono incollati su tali pagine.

Spostamento di un'area selezionata

È possibile selezionare e spostare un'area di una pagina immagine.
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• È possibile utilizzare [Strumento sposta area] solo se il tipo di file originale è Image PDF.

• [Strumento sposta area] è disponibile solo nella visualizzazione di modifica pagina.

• Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

Per selezionare e spostare un'area di una pagina immagine:

1. Fare clic con il pulsante destro del mouse su una pagina e selezionare [Modifica pagina] dal
menu oppure fare doppio clic sulla pagina per aprirla nella visualizzazione di modifica pagina.

2. Nella barra degli strumenti, fare clic sullo , il pulsante [Strumento sposta area].
L’aspetto del cursore cambia da freccia a forma di croce.

3. Fare clic e trascinare sull’area dell’immagine. Viene visualizzato un riquadro blu attorno all’area
selezionata con vari punti di ancoraggio. Utilizzare i punti di ancoraggio per ridimensionare
l'area selezionata.

Non è possibile ridimensionare l'area selezionata una volta spostata.

4. Fare clic sull'area selezionata.

Il cursore a forma di croce cambia in cursore mobile e vengono applicate le proprietà del
formato.

5. Trascinare l’area verso la posizione desiderata sulla pagina.

• Non è possibile modificare o ridimensionare l’area selezionata una volta spostata.

• L'area selezionata può essere spostata solo sulla stessa pagina. Non è possibile spostarla su
altre pagine nel lavoro.

• Per spostare l'area selezionata su più pagine, vedere Spostamento di un'area selezionata su
più pagine, pagina 133.

6. Per centrare l'area selezionata, fare clic con il pulsante destro del mouse e selezionare [Al
centro], quindi [Orizzontalmente], [Verticalmente] o [Entrambi] dal menu.

5 Modifica dei lavori



5

133

Utilizzare , il pulsante [Annulla], per eseguire modifiche all'area selezionata una volta che questa
viene spostata.

Spostamento di un'area selezionata su più pagine

Per selezionare e spostare un'area su più pagine:

1. Fare clic con il pulsante destro del mouse su una pagina e selezionare [Modifica pagina] dal
menu oppure fare doppio clic sulla pagina per aprirla nella visualizzazione di modifica pagina.

2. Selezionare più pagine nell’elenco delle pagine.

• Per selezionare più pagine, tenere premuto il tasto Ctrl e fare clic su ogni pagina che si
desidera selezionare.

• Per selezionare un intervallo di pagine, fare clic sulla prima pagina nell’intervallo, quindi
tenere premuto il tastoMaiusc e fare clic sull’ultima pagina nell’intervallo.

3. Sulla barra degli strumenti, fare clic sul , il pulsante [Strumento sposta area].
L’aspetto del cursore cambia da freccia a forma di croce.

4. Fare clic e trascinare sull’area dell’immagine. Viene visualizzato un riquadro blu attorno all’area
selezionata con vari punti di ancoraggio. Un'area identica viene selezionata su tutte le pagine
selezionate nell'elenco pagine. Utilizzare i punti di ancoraggio per ridimensionare l'area
selezionata.

Non è possibile ridimensionare l'area selezionata una volta spostata.

5. Fare clic sull'area selezionata.

Il cursore a forma di croce cambia in cursore mobile e vengono applicate le proprietà del
formato.

6. Trascinare l’area verso la posizione desiderata sulla pagina.

L'area si sposta su tutte le pagine di destinazione selezionate nell'elenco pagine.
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Non è possibile modificare o ridimensionare le aree selezionate una volta spostate.

7. Per centrare le aree selezionate, fare clic con il pulsante destro del mouse e selezionare [Al
centro], quindi [Orizzontalmente], [Verticalmente] o [Entrambi] dal menu.

Utilizzare , il pulsante [Annulla], per eseguire modifiche all'area selezionata una volta che questa
viene spostata.

Ritaglio di una pagina

È possibile ritagliare un'area su una singola pagina o su più pagine utilizzando [Strumento taglio].

• Questa funzione non è disponibile nella versione browser di TotalFlow Prep se il tipo di file
originale è Image PDF.

Per ritagliare un’area su una pagina:

1. Selezionare la pagina di destinazione dall'elenco delle pagine.

• Per selezionare più pagine, tenere premuto il tasto Ctrl e fare clic su ogni pagina che si
desidera selezionare.

• Per selezionare un intervallo di pagine, fare clic sulla prima pagina nell’intervallo, quindi
tenere premuto il tastoMaiusc e fare clic sull’ultima pagina nell’intervallo.

2. Sulla barra degli strumenti, fare clic sul , il pulsante [Strumento taglio]. L’aspetto del
cursore cambia da freccia a icona di ritaglio.

3. Fare clic e trascinare sull’area della pagina. Viene visualizzato un riquadro blu attorno all’area
selezionata con vari punti di ancoraggio.

4. Utilizzare i punti di ancoraggio per ridimensionare l’area selezionata in base alle necessità.

5. Fare clic con il tasto destro del mouse e selezionare [Taglia] dal menu.

Utilizzare , il pulsante [Annulla], per annullare le impostazioni di ritaglio. Utilizzare , il
pulsante [Ripeti], per riapplicare le impostazioni di ritaglio.

Impostazione dell'area di ritaglio con l'immissione di valori

È possibile definire manualmente l'area di ritaglio immettendo le coordinate X e Y e i valori di
larghezza e altezza.

Per impostare l'area di ritaglio con l'immissione di valori:
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1. Sulla barra degli strumenti, fare clic sul , il pulsante [Strumento taglio]. L’aspetto del
cursore cambia da freccia a icona di ritaglio.

2. Per posizionare l'area di ritaglio sulla pagina, immettere le coordinate nei campi di immissione
[x] e [y] sulla barra degli strumenti.

3. Per impostare il formato dell'area di ritaglio, immettere i valori di larghezza e altezza nei campi
di immissione [l] e [a].

Ridimensionamento di una pagina

È possibile ridimensionare una singola pagina o più pagine utilizzando [Strumento ridimensiona
pagina].

Le pagine ridimensionate potrebbero non essere stampate correttamente o non avere un layout corretto
a seconda delle impostazioni della carta e delle opzioni di ridimensionamento dal pannello
[Imposizione].

Per ridimensionare le pagine:

1. Selezionare la pagina di destinazione dall'elenco delle pagine.

• Per selezionare più pagine, tenere premuto il tasto Ctrl e fare clic su ogni pagina che si
desidera selezionare.

• Per selezionare un intervallo di pagine, fare clic sulla prima pagina nell’intervallo, quindi
tenere premuto il tastoMaiusc e fare clic sull’ultima pagina nell’intervallo.

2. Sulla barra degli strumenti, fare clic sul , il pulsante [Strumento ridimensiona pagina].
Le opzioni di ridimensionamento vengono visualizzate sulla barra degli strumenti.

3. Immettere una percentuale o dimensioni specifiche per ridimensionare la pagina e premere il
tasto Invio.

• Gli oggetti della pagina (testo, maschera, immagine) non sono selezionabili in modalità di
modifica.

• Gli oggetti della pagina (testo, maschera, immagine) vengono spostati e ridimensionati
proporzionalmente al ridimensionamento della pagina.
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La qualità dell'immagine si degrada ad ogni applicazione di [Strumento ridimensiona

pagina]. Utilizzare , il pulsante [Annulla], per annullare le impostazioni di

ridimensionamento. Utilizzare , il pulsante [Ripeti], per riapplicare le impostazioni di
ridimensionamento. Questi pulsanti preservano la qualità dell’immagine quando le impostazioni
di ridimensionamento vengono annullate o ripristinate.

Aggiunta di testo

È possibile aggiungere testo a una pagina inserendo una casella di testo.

Per inserire una casella di testo:

1. Nella barra degli strumenti, fare clic su , il pulsante [Strumento testo].

2. Posizionare il cursore sulla pagina e fare clic per inserire una casella di testo.

3. Inserire testo digitandolo. Al testo vengono applicati font e dimensione font predefiniti.

Modifica di testo

È possibile modificare il testo e cambiare font, dimensioni del font, colore del testo, orientamento del
testo o applicare grassetto e corsivo.

Le modifiche vengono applicate a tutto il testo nella casella di testo e non è possibile applicarle a
singoli caratteri.

Per modificare testo:

1. Fare clic nella casella di testo.

Il cursore attivo lampeggia e consente di modificare il testo.

Modifica font

Le modifiche al font vengono applicate a tutto il testo nella casella di testo e non è possibile applicarle
a singoli caratteri.

Per modificare il font:

1. Fare clic nella casella di testo ed evidenziare il testo per selezionarlo.

2. Selezionare un font dall'elenco dei caratteri nella barra degli strumenti.
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Nell'elenco dei font vengono visualizzati solo i font installati nel sistema.

Modifica dimensione font

Per modificare la dimensione del font:

1. Fare clic nella casella di testo ed evidenziare il testo per selezionarlo.

2. Selezionare la dimensione del font dall'elenco nella barra degli strumenti o immettere una
dimensione personalizzata nel campo di inserimento.

Modifica colore font

Le modifiche al colore vengono applicate a tutto il testo nella casella di testo e non è possibile
applicarle a singoli caratteri.

Per modificare il colore del font:

1. Fare clic nella casella di testo ed evidenziare il testo per selezionarlo.

2. Fare clic su , lo strumento di selezione del colore nella barra degli strumenti.

3. Selezionare dai colori predefiniti oppure inserire i valori personalizzati nei campi di inserimento.

È anche possibile usare il selezionatore di colore per selezionare un colore da qualsiasi oggetto
nello spazio di lavoro.

Applicazione di grassetto o corsivo

• Se il font selezionato supporta il grassetto e il corsivo, nella barra degli strumenti vengono
visualizzati i pulsanti [Grassetto] e [Corsivo].

• Il grassetto e il corsivo vengono applicati a tutto il testo nella casella di testo e non è possibile
applicarli a singoli caratteri.

• È possibile applicare contemporaneamente il grassetto e il corsivo.

Per applicare il grassetto o il corsivo
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1. Fare clic sulla casella di testo per selezionarla.

2. Nella barra degli strumenti, fare clic sui pulsanti [Grassetto] o [Corsivo] per applicare la
formattazione.

Modifica orientamento testo

Se il font selezionato supporta l'orientamento del testo sia orizzontale che verticale, nella barra degli
strumenti vengono visualizzate le icone direzionali [O] per orizzontale o [V] per verticale.

Per modificare l'orientamento della casella di testo:

1. Fare clic sulla casella di testo per selezionarla.

2. Per modificare l'orientamento del testo, fare clic sullo strumento di orientamento.

Rotazione testo

Per ruotare il testo:

1. Fare clic sulla casella di testo per selezionarla.

Viene visualizzato un contorno blu con un punto di controllo.

2. Fare clic sul punto di controllo e trascinarlo per ruotare la casella di testo con incrementi di 90
gradi.
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Centratura del testo

Per centrare il testo:

1. Fare clic sulla casella di testo per selezionarla.

2. Fare clic con il pulsante destro del mouse e selezionare [Al centro], quindi [Orizzontalmente],
[Verticalmente] o [Entrambi] dal menu.

Tagliare, copiare e incollare testo

Dopo aver aggiunto il testo a una pagina, è possibile tagliarlo, copiarlo e incollarlo usando il menu
visualizzato facendo clic con il pulsante destro del mouse.

Il testo copiato negli appunti del sistema può essere incollato nella casella di testo della pagina
corrente o nelle caselle di testo di altre pagine.

Per tagliare, copiare o incollare del testo:

1. Fare clic nella casella di testo ed evidenziare il testo per selezionarlo.

2. Fare clic con il pulsante destro del mouse e selezionare [Taglia] o [Copia] dal menu.

• Usare [Taglia] per rimuovere il testo e incollarlo in un'altra casella di testo.

• Usare [Copia] per copiare il testo e incollarlo nelle altre caselle di testo.

3. Andare alla casella di testo di destinazione, fare clic con il pulsante destro del mouse e
selezionare [Incolla] per incollare il testo.

Utilizzare i tasti Elimina o Backspace per eliminare il testo.
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Tagliare, copiare e incollare una casella di testo

È possibile copiare o tagliare una casella di testo e incollarla in una posizione diversa.

Per tagliare, copiare o incollare una casella di testo:

1. Fare clic sulla casella di testo per selezionarla.

2. Fare clic con il pulsante destro del mouse e selezionare [Taglia] o [Copia] dal menu.

• Usare [Taglia] per rimuovere la casella di testo dalla pagina corrente e incollarla su altre
pagine.

• Usare [Copia] per copiare la casella di testo e incollarla nella pagina corrente o in altre
pagine.

3. Andare alla pagina di destinazione, fare clic con il pulsante destro del mouse e selezionare
[Incolla] per incollare la casella di testo.

Per eliminare la casella di testo, fare clic con il pulsante destro del mouse su di essa e selezionare
[Elimina].

Copia di una casella di testo su più pagine

Per copiare una casella di testo su più pagine:

1. Fare clic sulla casella di testo per selezionarla.

2. Fare clic con il tasto destro del mouse e selezionare [Copia] dal menu.

3. Fare clic nuovamente con il pulsante destro del mouse e selezionare [Incolla su].

4. Specificare le pagine di destinazione selezionando una delle opzioni disponibili nel menu
[Incolla su]:

• L'opzione [Tutte le pagine] consente di incollare la casella di testo su tutte le pagine.

• L'opzione [Pagine selezionate] incolla la casella di testo sulle pagine selezionate
dall'elenco pagine.

Per impostazione predefinita, l'opzione [Pagine selezionate] è visualizzata in grigio.
Perché l'opzione sia disponibile, selezionare le pagine dall’elenco pagine. Vedere
passaggio numero 5.

• L'opzione [Pagine pari] consente di incollare la casella di testo su tutte le pagine pari.

• L'opzione [Pagine dispari] consente di incollare la casella di testo su tutte le pagine dispari.

Le opzioni [Pagine pari] e [Pagine dispari] non dipendono dai numeri di pagina, ma dal
numero reale di pagine in un lavoro.
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5. Per utilizzare l'opzione [Pagine selezionate]:

1. Selezionare le pagine di destinazione dall'elenco delle pagine.

• Per selezionare più pagine, tenere premuto il tasto Ctrl e fare clic su ogni pagina che si
desidera selezionare.

• Per selezionare un intervallo di pagine, fare clic sulla prima pagina nell’intervallo, quindi
tenere premuto il tasto Maiusc e fare clic sull’ultima pagina nell’intervallo.

2. Fare clic con il pulsante destro del mouse e selezionare Incolla su→ Pagine selezionate.

A volte quando viene copiata una casella di testo su pagine di dimensioni minori, le coordinate X,Y
della casella di testo cadono al di fuori dell'area stampabile delle pagine di destinazione. Viene
visualizzato un messaggio con le opzioni per incollare e centrare automaticamente gli oggetti non
stampabili oppure ignorarli e incollare solo gli oggetti stampabili.

• Fare clic su [OK] per incollare e centrare automaticamente gli oggetti non stampabili nella pagina
di destinazione. Se vengono selezionate più pagine di destinazione, gli oggetti non stampabili
vengono incollati e automaticamente centrati su tali pagine con aree stampabili più piccole.

• Fare clic su [Annulla] per ignorare gli oggetti non stampabili. Tutti gli oggetti stampabili che sono
stati copiati vengono incollati nella pagina di destinazione. Se vengono selezionate più pagine di
destinazione, gli oggetti stampabili vengono incollati su tali pagine.

Aggiunta di un’immagine

È possibile aggiungere immagini JPEG, PNG o TIFF a una pagina. Altri formati di file immagine non
sono supportati.

Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

Per aggiungere un’immagine:

1. Nella barra degli strumenti, fare clic su , il pulsante [Strumento immagine].
Viene visualizzato l'elenco [Scegli immagine...].

Una volta aggiunte immagini al lavoro, l'elenco si popola con i file immagine utilizzati di recente.

2. Selezionare un'immagine dal browser dei file.
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Per impostazione predefinita, l'immagine è centrata nella pagina.

Modifica di un’immagine

È possibile modificare un'immagine, cambiandone dimensioni, rotazione, posizione o trasparenza.

Ridimensionamento di un'immagine

Per ridimensionare un’immagine utilizzando punti di ancoraggio:

1. Fare clic sull'immagine per selezionarla.

2. Fare clic su un punto di ancoraggio e tenere premuto, quindi trascinare l'immagine alle
dimensioni desiderate.
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• Il pulsante di blocco [Mantieni proporzioni] sulla barra degli strumenti limita il rapporto di
larghezza e altezza quando l'immagine viene ridimensionata. Per impostazione predefinita, è
selezionato il pulsante di blocco [Mantieni proporzioni].

• Oltre al pulsante di blocco [Mantieni proporzioni], è anche possibile limitare le proporzioni
dell'immagine tenendo premuto il tastoMaiusc mentre si trascina un punto di ancoraggio.

Posizionamento di un’immagine

È possibile posizionare le immagini immettendo coordinate nei campi di inserimento [x] e [y] sulla
barra degli strumenti oppure spostando manualmente l'immagine sulla pagina.

Posizionamento manuale

Per posizionare un'immagine manualmente:

1. Fare clic sull'immagine per selezionarla.

2. Posizionare il cursore sull'immagine.

Il cursore diventa un'icona di posizione.

3. Fare clic e tenere premuto, quindi spostare l'immagine nella posizione desiderata.

Posizionamento con coordinate X e Y

Per posizionare un’immagine con coordinate X e Y:

1. Fare clic sull'immagine per selezionarla.

2. Immettere le coordinate nei campi di immissione [x] e [y] sulla barra degli strumenti per
posizionare l'immagine sulla pagina.

Centratura di un’immagine

Per centrare un'immagine:

1. Fare clic sull'immagine per selezionarla.

2. Fare clic con il pulsante destro del mouse e selezionare [Al centro], quindi [Orizzontalmente],
[Verticalmente] o [Entrambi] dal menu.
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Rotazione di un’immagine

Per ruotare un’immagine:

1. Fare clic sull'immagine per selezionarla.

2. Fare clic sul punto di controllo e trascinarlo per ruotare l'immagine con incrementi di 90 gradi.

Modifica della trasparenza dell’immagine

I formati immagine PNG e TIFF supportano la trasparenza. Quando si apre un file PNG o TIFF
trasparente nello spazio di lavoro, viene visualizzato uno strumento di trasparenza sulla barra degli
strumenti.

Per modificare la trasparenza dell'immagine:

1. Fare clic sull'immagine per selezionarla.

2. Sulla barra degli strumenti, fare clic sullo strumento di trasparenza e selezionare [Trasparente]
o [Pieno].

Le modifiche alla trasparenza dell'immagine non sono visibili in [Modalità di modifica]. È
possibile visualizzare un'anteprima dei risultati in [Vista foglio].

Taglia, copia e incolla di un'immagine

È possibile tagliare o copiare un'immagine e incollarla sulla stessa pagina o su più pagine utilizzando il
menu a comparsa attivato dal tasto destro del mouse.

Per tagliare, copiare o incollare un'immagine:

1. Fare clic sull'immagine per selezionarla.

2. Fare clic con il pulsante destro del mouse e selezionare [Taglia] o [Copia] dal menu.

5 Modifica dei lavori



5

145

• Utilizzare [Taglia] per rimuovere l'immagine dalla pagina corrente e incollarla su altre
pagine.

• Utilizzare [Copia] per copiare l'immagine e incollarla nella pagina corrente o in altre
pagine.

3. Andare alla pagina di destinazione, fare clic con il pulsante destro del mouse e selezionare
[Incolla] per incollare l'immagine.

Per eliminare l'immagine, fare clic con il pulsante destro del mouse su di essa e selezionare
[Elimina].

Copia di un'immagine su più pagine

Per copiare un'immagine su più pagine:

1. Fare clic sull'immagine per selezionarla.

2. Fare clic con il tasto destro del mouse e selezionare [Copia] dal menu.

3. Fare clic nuovamente con il pulsante destro del mouse e selezionare [Incolla su].

4. Specificare le pagine di destinazione selezionando una delle opzioni disponibili nel menu
[Incolla su]:

• L'opzione [Tutte le pagine] consente di incollare l'immagine su tutte le pagine.

• L'opzione [Pagine selezionate] incolla l'immagine sulle pagine selezionate dall'elenco
pagine.

Per impostazione predefinita, l'opzione [Pagine selezionate] è visualizzata in grigio.
Perché l'opzione sia disponibile, selezionare le pagine dall’elenco pagine. Vedere
passaggio numero 5.

• L'opzione [Pagine pari] consente di incollare l'immagine su tutte le pagine pari.

• L'opzione [Pagine dispari] consente di incollare l'immagine su tutte le pagine dispari.

Le opzioni [Pagine pari] e [Pagine dispari] non dipendono dai numeri di pagina, ma dal
numero reale di pagine in un lavoro.

5. Per utilizzare l'opzione [Pagine selezionate]:

1. Selezionare le pagine di destinazione dall'elenco delle pagine.

• Per selezionare più pagine, tenere premuto il tasto Ctrl e fare clic su ogni pagina che si
desidera selezionare.

• Per selezionare un intervallo di pagine, fare clic sulla prima pagina nell’intervallo, quindi
tenere premuto il tasto Maiusc e fare clic sull’ultima pagina nell’intervallo.

2. Fare clic con il pulsante destro del mouse e selezionare Incolla su→ Pagine selezionate.
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A volte quando viene copiata un'immagine su pagine di dimensioni minori, le coordinate X,Y
dell'immagine cadono al di fuori dell'area stampabile delle pagine di destinazione. Viene visualizzato
un messaggio con le opzioni per incollare e centrare automaticamente gli oggetti non stampabili
oppure ignorarli e incollare solo gli oggetti stampabili.

• Fare clic su [OK] per incollare e centrare automaticamente gli oggetti non stampabili nella pagina
di destinazione. Se vengono selezionate più pagine di destinazione, gli oggetti non stampabili
vengono incollati e automaticamente centrati su tali pagine con aree stampabili più piccole.

• Fare clic su [Annulla] per ignorare gli oggetti non stampabili. Tutti gli oggetti stampabili che sono
stati copiati vengono incollati nella pagina di destinazione. Se vengono selezionate più pagine di
destinazione, gli oggetti stampabili vengono incollati su tali pagine.

Incollare immagini o testo dagli appunti del sistema

È possibile incollare immagini o testo dagli appunti del sistema in un lavoro utilizzando la funzione
[Incolla speciale].

• Occorre aprire TotalFlow Prep prima di poter incollare immagini o testo dagli appunti del sistema in
un lavoro.

• La funzione [Incolla speciale] è disponibile solo nella visualizzazione di modifica pagina.

• La funzione [Incolla speciale] supporta i formati di file immagine PNG, TIFF, JPEG e GIF.

• Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

Per incollare un'immagine o testo dagli appunti del sistema in un lavoro:

1. Aprire la pagina di destinazione nella visualizzazione di modifica pagina.

2. Copiare l'immagine o il testo da un programma esterno negli appunti del sistema. Selezionare il
testo o l'immagine e premere Ctrl+C.

3. Posizionare il cursore sulla pagina di destinazione.

4. Fare clic con il tasto destro del mouse e selezionare [Incolla speciale] dal menu. L'immagine o il
testo viene incollato dagli appunti del sistema sulla pagina.

Quando il testo vien incollato dagli appunti del sistema, le opzioni di formattazione del testo,
quali grassetto, corsivo o sottolineatura, vengono rimosse. Riapplicare la formattazione del testo
utilizzando la funzionalità di modifica testo in TotalFlow Prep. Per ulteriori informazioni,
consultare Modifica di testo, pagina 136.
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Modifica dell’ordine degli oggetti

È possibile cambiare l'ordine di più oggetti (caselle di testo, immagini o maschere) su una pagina
utilizzando le opzioni del menu a comparsa attivato dal tasto destro del mouse.

Per modificare l'ordine degli oggetti:

1. Fare clic sull'oggetto per selezionarlo.

2. Fare clic con il tasto destro del mouse e selezionare [Ordine] dal menu.

3. Specificare l'ordine degli oggetti selezionando una delle opzioni disponibili nel menu [Ordine]:

• [Porta su fronte] porta un oggetto in primo piano rispetto agli altri oggetti sulla pagina.

• [Porta in avanti] sposta un oggetto avanti di un livello.

• [Porta su retro] posiziona un oggetto dietro a tutti gli altri oggetti nella pagina.

• [Porta indietro] sposta un oggetto indietro di un livello.

Modifica di file originali



5

148

Creazione, modifica e applicazione di sovrapposizioni

È possibile creare sovrapposizioni di testo, immagine o maschera e riutilizzarle nei lavori.

• Le sovrapposizioni di immagini non sono disponibili nella versione browser di TotalFlow Prep.

Creazione di sovrapposizioni

• È possibile creare solo sovrapposizioni in [Modalità di modifica].

• Le sovrapposizioni possono contenere singoli oggetti o gruppi di oggetti.

Per creare e salvare una sovrapposizione:

1. Aggiungere un oggetto (testo, immagine o maschera) a una pagina.

2. Selezionare l'oggetto o gli oggetti.

Per selezionare più oggetti, fare clic sulla pagina e trascinare il cursore per creare un'area di
selezione che circonda gli oggetti.

3. Fare clic con il tasto destro del mouse e selezionare [Crea sovrapposizione...] dal menu.

4. Immettere un nome per la sovrapposizione nella finestra di dialogo [Sovrapposizioni] e fare
clic su [OK].

Modifica ed eliminazione di sovrapposizioni

Per modificare o eliminare le sovrapposizioni:
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1. Sulla barra degli strumenti, fare clic sul , il pulsante [Sovrapposizioni].
Le sovrapposizioni disponibili sono visualizzate nel menu.

2. Per modificare il nome di una sovrapposizione, passare il mouse sulla sovrapposizione e fare clic

su , il pulsante [Modifica sovrapposizione].

3. Per eliminare una sovrapposizione, passare il mouse sulla sovrapposizione e fare clic su , il
pulsante [Elimina sovrapposizione].

Applicazione di sovrapposizioni

Per applicare una sovrapposizione:

1. Selezionare la pagina di destinazione dall'elenco delle pagine.

• Per selezionare più pagine, tenere premuto il tasto Ctrl e fare clic su ogni pagina che si
desidera selezionare.

• Per selezionare un intervallo di pagine, fare clic sulla prima pagina nell’intervallo, quindi
tenere premuto il tastoMaiusc e fare clic sull’ultima pagina nell’intervallo.

2. Sulla barra degli strumenti, fare clic sul , il pulsante [Sovrapposizioni].

3. Selezionare una delle sovrapposizioni disponibili.

Il menu [Sovrapposizioni] visualizza le dimensioni della pagina e la posizione della
sovrapposizione sulla pagina.

Uso delle funzioni di modifica avanzate

Le funzioni di modifica avanzate includono le visualizzazioni [Tavolo luminoso] e [Tavolo luminoso
speculare] e la funzione [Rilevamento contenuto].

Uso del tavolo luminoso

La funzione [Tavolo luminoso] consente di visualizzare, modificare e allineare una pila di pagine.

Per utilizzare la funzione [Tavolo luminoso]:

1. Nella barra dei menu, fare clic su [Visualizza].
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2. Selezionare [Tavolo luminoso].

3. Aggiungere pagine alla pila immettendo numeri di pagina o un intervallo di pagine nel campo
[Pagine] nella parte inferiore dello spazio di lavoro.
Ad esempio, è possibile immettere 1, 2, 3, 4–10, 14–16.

4. Specificare le opzioni per [Tavolo luminoso] nel menu [Impostazioni tavolo luminoso] nella
parte inferiore dello spazio di lavoro.
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• [Pagina di riferimento] consente di designare una pagina specifica che resti visibile anche
quando si cambiano e modificano altre pagine nella pila.

• [Profondità della risma del tavolo luminoso] controlla il numero delle pagine impilate
visibili nel tavolo luminoso.

• [Colora pagina attiva] consente di applicare una tinta alla pagina superiore per
differenziarla dalle altre pagine nella pila.

Le prestazioni del computer potrebbero essere influenzate dal numero di pagine in una pila.
L'elaborazione delle pile con un gran numero di pagine potrebbe richiedere più tempo.

Utilizzo del rilevamento contenuto

La funzione [Rilevamento contenuto] rileva il bordo del contenuto della pagina.

Per utilizzare la funzione [Rilevamento contenuto]:

1. Fare clic su , il pulsante del menu [Rilevamento contenuto] nella parte inferiore dello
spazio di lavoro. Si apre il menu [Rilevamento contenuto].

2. Impostare le opzioni per [Rilevamento contenuto].
[Rileva il contenuto di tutta la pagina] rileva il bordo del contenuto sull'intera pagina. Questa
opzione è l'impostazione predefinita. [Crea cornice contenuto] consente di definire un'area
della pagina specifica per il rilevamento del contenuto.
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3. Selezionare un livello di intensità dall'elenco [Intensità di rilevamento contenuto].
L'opzione [Grezza (testo, più rapido)] funziona meglio per documenti con testo semplice.
L'opzione [Fine (immagine, più lento)] è più adatta al rilevamento di contenuto nelle immagini.

Creazione di un frame contenuto

La funzione [Crea cornice contenuto] consente di definire un'area della pagina specifica per il
rilevamento del contenuto.

Per utilizzare la funzione [Crea cornice contenuto]:

1. Fare clic sull'opzione [Crea cornice contenuto] nel menu [Rilevamento contenuto].

5 Modifica dei lavori



5

153

Sulla pagina viene visualizzato un frame contenuto che utilizza le impostazioni del margine
predefinite in [Posizione cornice contenuto].

2. Impostare la posizione del frame contenuto.

È possibile definire la posizione del frame contenuto immettendo margini specifici nei campi [A
sinistra], [Superiore], [A destra], o [In basso]. È anche possibile fare clic su uno degli
ancoraggi blu e trascinarlo per regolare manualmente la posizione del frame contenuto.

Uso del tavolo luminoso speculare

La funzione [Tavolo luminoso speculare] visualizza il retro delle pagine riflesse.

L'opzione [Tavolo luminoso speculare] è disponibile solo se il lavoro è impostato per la stampa su
entrambi i lati del foglio.

Per utilizzare la funzione [Tavolo luminoso speculare]:

1. Nella barra dei menu, fare clic su [Visualizza].

2. Selezionare [Tavolo luminoso speculare].
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• Se il lato di stampa è impostato su [Entrambi i lati (2 facciate), apri in alto], le immagini
vengono riflesse verticalmente.

• Se il lato di stampa è impostato su [Entrambi i lati (2 facciate), apri a sinistra] o
[Entrambi i lati (2 facciate), apri a destra], le immagini vengono riflesse orizzontalmente.

SSppeecciiffiiccaazziioonnee ddeellllee iimmppoossttaazziioonnii ccaarrttaa
È possibile specificare carta e vassoio di alimentazione che si desidera utilizzare per la stampa del
lavoro.

• La carta e i vassoi di alimentazione disponibili variano in base alla stampante selezionata per il
lavoro. Per prima cosa, verificare di aver selezionato una stampante, quindi specificare le
impostazioni carta.

• La carta predefinita utilizzata per il lavoro dipende dall'impostazione[Formato carta nuovo
lavoro] nella schermata [Preferenze].

Per specificare le impostazioni carta:

1. Aprire il menu di selezione carta nella barra degli strumenti per visualizzare la schermata
[Seleziona carta].

2. Nella schermata [Seleziona carta], eseguire una delle seguenti operazioni:

• Usare l'impostazione [Automatica] per mantenere il formato pagina originale.

– Questa opzione non è disponibile per l'imposizione [Libretto] o [Combina] - [Veloce].

– Se il lavoro contiene documenti con formati pagina diversi viene utilizzato [Auto:
formati multipli] per il formato pagina originale.

– Se il formato pagina originale è più grande rispetto ai formati di carta supportati dalla
stampante, viene utilizzato il formato carta più grande supportato.

• Selezionare una carta dall'elenco [Carta caricata], che contiene i tipi di carta attualmente
caricati nei vassoi della stampante.

• Selezionare una carta dall'elenco [Catalogo completo], che contiene i tipi di carta del
catalogo della stampante non caricati nei vassoi e i tipi di carta personalizzata registrata che
sono supportati dalla stampante.
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– Per creare una nuova carta personalizzata e aggiungerla all'elenco [Catalogo
completo], fare clic sul pulsante [+Aggiungi carta]. Per ulteriori informazioni, vedere
Aggiunta di carta personalizzata, pagina 77.

– Per ulteriori informazioni sulla gestione della carta nel catalogo carta, consultare
Gestione del catalogo carta, pagina 76.

• Selezionare una carta dall'elenco [Selezioni recenti].

• Fare clic sul pulsante [Carta personalizzata] per specificare manualmente le proprietà
della carta.

Per dettagli sulle proprietà disponibili, fare clic sul pulsante per visualizzare la guida di
campo su schermo.

• Accertarsi che anche sulla stampante sia disponibile una carta con le stesse proprietà. Per
informazioni relative alle impostazioni carta della stampante, consultare la documentazione
della stampante.

• Selezionare l'opzione [Usa valori predefiniti] o lasciare il campo vuoto per le proprietà
carta che non si desidera inviare alla stampante.

La carta risultante viene visualizzata come Personalizzata nel menu di selezione carta.

3. Aprire il menu di selezione del vassoio nella barra degli strumenti e selezionare il vassoio di
alimentazione in cui è caricata la carta.

Utilizzare l'opzione [Selezione auto vassoio] se si desidera che la stampante selezioni
automaticamente il vassoio in base alle impostazioni carta specificate.

Specificazione delle impostazioni carta



5

156

Per le stampanti che utilizzano un'unità interfaccia per il collegamento a un dispositivo di input esterno,
è possibile selezionare [Vassoio alimentazione opzione estesa] per abilitare una funzione
supportata attraverso l'unità interfaccia. Vedere le impostazioni della stampante per le informazioni
sulle opzioni disponibili.

È anche possibile specificare impostazioni carta per fogli individuali. Per ulteriori informazioni sulle
eccezioni carta, consultare Specificazione delle eccezioni carta, pagina 220.

Impostazione supporto carta lunga

• La carta lunga è disponibile solo se la stampante selezionata supporta Carta lunga e se la modalità
SP è abilitata.

• Contattare il servizio di assistenza per informazioni sull'attivazione della modalità SP sulla
stampante.

Per impostare il supporto per la carta lunga:

1. Verificare che la stampante sia configurata per la carta lunga e che la modalità SP sia abilitata.

2. Andare su Impostazioni→ Gestione stampante.

3. Nella schermata [Gestione stampante], passare il mouse sulla stampante con carta lunga da
impostare come predefinita e fare clic sul , il pulsante [Imposta come predefinita].

4. Aprire un lavoro con opzioni carta lunga definite.

Se la stampante selezionata non supporta carta lunga o se la modalità SP non è stata abilitata,
viene visualizzato un messaggio di errore e il lavoro viene automaticamente ridimensionato per
adattarsi al maggiore formato carta disponibile.
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SSppeecciiffiiccaazziioonnee ddeellllee iimmppoossttaazziioonnii ddii iimmppoossiizziioonnee
Le impostazioni di imposizione consentono di collocare delle pagine nel lavoro in base alla posizione
in cui devono trovarsi nel prodotto finito. Ad esempio, è possibile stampare più pagine su un foglio o
preparare libretti. Configurare l'imposizione può migliorare l'efficienza specialmente per lavori con un
gran numero di pagine.

Per specificare le impostazioni di imposizione:

1. Nell'area delle impostazioni sulla destra fare clic su [Imposizione].

2. Nel pannello [Imposizione], specificare un tipo di imposizione facendo clic su [Normale],
[Libretto] o [Combina].

Per ulteriori informazioni su ogni tipo di imposizione, consultare Impostazione imposizione
Normale, pagina 158, Impostazione imposizione Libretto, pagina 158 o Impostazione
imposizione raggruppata, pagina 161.

3. Configurare tutte le impostazioni necessarie per il tipo selezionato di imposizione.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.
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Impostazione imposizione Normale

Se per il lavoro viene scelto in tipo di imposizione normale, le pagine vengono stampate in sequenza,
una per foglio. È possibile configurare diverse impostazioni, incluso lato di stampa, orientamento,
ridimensionamento, formato di finitura, crocini di registro, margini al vivo, posizionamento immagine e
spostamento immagine.

Per specificare l'imposizione normale:

1. Nell'area delle impostazioni sulla destra fare clic su [Imposizione].

2. Nel pannello [Imposizione] fare clic su [Normale].

3. Configurare le impostazioni disponibili nel pannello [Normale].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

Impostazione imposizione Libretto

L'imposizione libretto consente di stampare le pagine di un documento in stile libretto. Le pagine
vengono sistemate e stampate in un ordine differente rispetto a quello del documento originale in modo
che vengano visualizzate nella sequenza corretta dopo la piegatura e la rilegatura.

• Alcune funzioni potrebbero non essere disponibili quando l'imposizione è impostata su [Libretto].

• Alcune impostazioni lavoro potrebbero essere rimosse o modificate quando l'imposizione è
impostata su [Libretto].

Per specificare l'imposizione libretto:

1. Nell'area delle impostazioni sulla destra fare clic su [Imposizione].

2. Nel pannello [Imposizione] fare clic su [Libretto].
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3. Selezionare un tipo di libretto dall'elenco [Tipo libretto]:

• [Libretto]: i fogli stampati vengono impilati, piegati lungo la linea centrale, quindi rilegati
lungo la linea centrale.

• [Libretto doppio]: due copie vengono prodotte contemporaneamente. I fogli stampati
vengono impilati, piegati lungo la linea centrale, tagliati e infine rilegati lungo la linea
centrale.

Se il lavoro ha molte pagine o se si stampa su carta spessa, è possibile regolare l'output
usando l'opzione [Scorrimento] per evitare l'errato allineamento delle pagine che può
verificarsi durante la piegatura dei fogli.
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Per rilegare un documento con l'imposizione [Libretto] (rilegatura interna), specificare le
seguenti impostazioni di finitura:

– [Pinzatura]: [2 al centro]

– [Rifilatura]: [Bordo anteriore]

Durante la rilegatura, usare [Libretto] invece di [Libretto doppio].

Per informazioni dettagliate relative alle impostazioni di finitura, vedere Specificazione delle
impostazioni di finitura, pagina 171.

• [Adesiva]: i fogli stampati vengono innanzitutto piegati lungo la linea centrale, quindi
impilati e infine rilegati lungo il bordo.

• [Adesiva doppia]: due copie vengono prodotte contemporaneamente. I fogli stampati
vengono innanzitutto piegati lungo la linea centrale, quindi impilati, tagliati e infine rilegati
lungo il bordo.

È possibile specificare su quale lato tagliare i libretti usando l'impostazione [Ruota di 180].
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Per rilegare un documento con l'imposizione [Adesiva], specificare le seguenti impostazioni
di finitura:

– [Piegatura]: [Piegatura a metà]

– [Pinzatura] o [Perforazione]

Per informazioni dettagliate relative alle impostazioni di finitura, vedere Specificazione delle
impostazioni di finitura, pagina 171.

4. Configurare le impostazioni disponibili per il tipo selezionato di libretto.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

Impostazione imposizione raggruppata

È possibile utilizzare un'imposizione raggruppata per combinare più pagine su un foglio di carta. Sono
disponibili opzioni di layout diverse per le pagine.

• Alcune funzioni potrebbero non essere disponibili quando l'imposizione è impostata su [Combina].

• Alcune impostazioni lavoro potrebbero essere rimosse o modificate quando l'imposizione è
impostata su [Combina].

Per specificare l'imposizione raggruppata:

1. Nell'area delle impostazioni sulla destra fare clic su [Imposizione].

2. Nel pannello [Imposizione] fare clic su [Combina].
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3. Selezionare un tipo di imposizione raggruppata nella sezione [COMBINA / TAGLIA E
IMPILA]:

• [Singolo]: più pagine del documento vengono stampate su un singolo foglio.

È possibile specificare il numero di pagine da stampare su un foglio e il relativo ordine.

• [Ripeti]: una pagina documento viene stampata ripetutamente per un determinato numero di
volte su un foglio.

• [Veloce]: due pagine vengono disposte e stampate su entrambi i lati di un foglio. Le pagine
stampate vengono quindi sovrapposte e tagliate lungo il centro.

Dato che per ogni foglio tagliato vengono create più pagine, si riducono tempi e costi di
stampa.
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È possibile usare l'opzione [Ruota di 180] per ruotare una delle due pagine su ogni lato del
foglio. È possibile quindi tagliare i fogli stampati e allineare i bordi di taglio.

4. Configurare le impostazioni disponibili per il tipo selezionato di imposizione raggruppata.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

Uso dei crocini di registro per la rifilatura

I crocini di registro sono linee stampate agli angoli di ogni pagina per indicare dove rifilare il foglio
stampato.

È possibile selezionare uno stile specifico per i crocini di registro: I crocini romani sono crocini singoli
che indicano le posizioni di rifilatura.
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I crocini giapponesi sono crocini doppi formati da un crocino interno e uno esterno. Il crocino interno
indica la posizione di rifilatura. Il crocino esterno indica il bordo esterno del contenuto della pagina che
si estende oltre i crocini interni. Il contenuto della pagina che si estende oltre l'area di rifilatura verso i
crocini esterni viene tagliato quando il foglio viene rifilato.

Per specificare impostazioni per i crocini di registro:

1. Nell'area delle impostazioni sulla destra fare clic su [Imposizione].

2. Nel pannello [Imposizione], verificare che il tipo di imposizione richiesto sia specificato per il
lavoro.

3. Configurare le impostazioni disponibili nella sezione [Contrassegni].

È possibile selezionare un stile dei crocini di registro e specificare lo spessore e la lunghezza
delle linee del crocino. È anche possibile specificare sul quale facciata del foglio stampare i
crocini.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.
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• Se viene specificato un valore del margine al vivo, i crocini si spostano verso l’interno dall’angolo
della pagina per quanto specificato dal margine al vivo. Per i crocini doppi, il crocino interno si
sposta verso l’interno dall’angolo della pagina per quanto specificato dal margine al vivo, mentre il
crocino esterno mantiene la sua posizione originale.

• La posizione dei crocini viene anche regolata in base alle impostazioni [Spostamento
immagine], [Scorrimento] e [Margini interni].

• È possibile visualizzare un’anteprima delle impostazioni nell’area di lavoro.

Specificazione delle impostazioni di orientamento

È possibile usare il menu [Orientamento] sulla barra degli strumenti per specificare se i fogli hanno
layout verticale o orizzontale.

• Quando si modifica l'orientamento usando la barra degli strumenti, viene anche aggiornata
l'impostazione [Orientamento] nel pannello [Imposizione].

• Le opzioni disponibili per l'impostazione dell'orientamento variano in base alla carta selezionata
per il lavoro. Non è possibile modificare l'orientamento se viene utilizzata l'impostazione
[Automatica] per la carta del lavoro.

Per specificare le impostazioni di orientamento del lavoro:

1. Fare clic sul , il pulsante [Orientamento], sulla barra degli strumenti.

2. Selezionare una delle opzioni di orientamento disponibili:

• [Verticale]: i fogli hanno un layout verticale.
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• [Orizzontale]: i fogli hanno un layout orizzontale.

L’orientamento del contenuto sul foglio dipende dal tipo di imposizione e dalle specifiche
impostazioni di imposizione specificate per il lavoro.

Specificazione delle impostazioni del lato di stampa

È possibile usare il menu [Lato di stampa] nella barra degli strumenti per specificare su quale lato del
foglio stampare e la direzione in cui vengono aperti i fogli.
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• Quando si modifica l'opzione del lato di stampa usando la barra degli strumenti, viene anche
aggiornata l'impostazione [Lato di stampa] nel pannello [Imposizione].

• Le opzioni per il lato di stampa disponibili dipendono dal tipo di imposizione specificata per il
lavoro.

• Le impostazioni per il lato di stampa determinano il bordo di rilegatura e le opzioni di finitura che
possono essere specificate per il lavoro. Ad esempio, se l'impostazione per il lato di stampa è [Lato
anteriore (1 facciata), apri a sinistra], non è possibile impostare le opzioni di pinzatura o
perforazione per il bordo destro dei fogli.

Per specificare le impostazioni per il lato stampa del lavoro:

1. Fare clic sul , il pulsante [Lato di stampa], sulla barra degli strumenti.

2. Selezionare una delle opzioni per il lato stampa disponibili:

• [Lato anteriore (1 facciata), apri a sinistra]: il lavoro viene stampato sul lato anteriore del
foglio e i fogli si aprono da destra a sinistra.

• [Entrambi i lati (2 facciate), apri a sinistra]: il lavoro viene stampato su entrambi i lati del
foglio e i fogli si aprono da destra a sinistra.

• [Lato anteriore (1 facciata), apri in alto]: il lavoro viene stampato sul lato anteriore del
foglio e i fogli si aprono dal basso verso l'alto.

• [Entrambi i lati (2 facciate), apri in alto]: il lavoro viene stampato su entrambi i lati del
foglio e i fogli si aprono dal basso verso l'alto.

• [Lato anteriore (1 facciata), apri a destra]: il lavoro viene stampato sul lato anteriore del
foglio e i fogli si aprono da sinistra a destra.

• [Entrambi i lati (2 facciate), apri a destra]: il lavoro viene stampato su entrambi i lati del
foglio e i fogli si aprono da sinistra a destra.

È anche possibile specificare impostazioni per il lato stampa per fogli individuali. Per ulteriori
informazioni sulle eccezioni lato stampa, consultare Specificazione delle eccezioni del lato di stampa,
pagina 222.

SSppeecciiffiiccaa ddeellllee iimmppoossttaazziioonnii ddeellllaa qquuiinnttaa ssttaazziioonnee
[Quinta stazione] è una stazione di marcatura speciale in cui è possibile selezionare diversi toner da
utilizzare. Offre l'opzione di stampare con un quinto colore.
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Impostazione delle proprietà del toner trasparente

• Le impostazioni [Quinta stazione] sono disponibili solo quando è installato un modulo [Quinta
stazione] sulla stampante. La disponibilità di tali impostazioni dipende dal modello di stampante,
dal controller della stampante e dalla configurazione [Quinta stazione].

• Le opzioni [Colore spot con nome] e [Regola tono] non sono disponibili per le stampanti con
controller EFI Fiery.

Quando [Trasparente] è il toner a effetto speciale installato:

1. Fare clic su [Quinta stazione] nell'area delle impostazioni sulla destra.

2. In [Toner effetto speciale], selezionare [Trasparente].

3. In [Target di elaborazione], selezionare una delle seguenti opzioni:

• [Nessuno]
Non viene applicato alcun toner ad effetto speciale. Qualsiasi colore spot utilizzato viene
elaborato utilizzando i valori CMYK.

• [Pagina intera]
Il toner ad effetto speciale viene applicato a tutta la pagina.

• [Colore spot con nome]
Il toner a effetto speciale viene applicato a un colore spot specifico nel file di stampa.

Nel campo [Nome colore spot], selezionare un colore spot dall’elenco o inserire un nome
colore spot. Il nome del colore spot deve corrispondere al colore spot utilizzato nel file di
stampa PDF. TotalFlow Prep non fornisce alcuna avvertenza se si immette un nome di colore
spot che non è riconosciuto.

Nel campo [Priorità colore spot], impostare quale colore spot ha la priorità sugli altri.

• [Oggetti specificati]
Il toner a effetto speciale è applicato solo a oggetti specifici. Selezionare uno o più oggetti
dall’elenco di opzioni disponibili per la configurazione.

4. In [Regola tono], immettere un valore da 0 a 100%.

5. In [Priorità di stampa], selezionare [Qualità] o [Velocità].
Quando la modalità di stampa è impostata su [Velocità], la quantità di toner a effetto speciale
viene ridotta per abilitare una stampa più rapida.

6. In [Intervallo di pagine], immettere l'intervallo di pagine che si desidera stampare con toner a
effetto speciale.

7. In [Speculare], specificare se applicare la stampa speculare a tutti i fogli nel lavoro.
La funzione [Speculare] si applica all’intero lavoro, anche se si imposta un intervallo di pagine
per le altre opzioni [Quinta stazione].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida contestuale
su schermo.
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Impostazione delle proprietà del toner bianco

• Le impostazioni [Quinta stazione] sono disponibili solo quando è installato un modulo [Quinta
stazione] sulla stampante. La disponibilità di tali impostazioni dipende dal modello di stampante,
dal controller della stampante e dalla configurazione [Quinta stazione].

• Le opzioni [Colore spot con nome], [Regola tono] e [Priorità di stampa] non sono disponibili
per le stampanti con controller EFI Fiery.

Quando [Bianco] è il toner a effetto speciale installato:

1. Fare clic su [Quinta stazione] nell'area delle impostazioni sulla destra.

2. In [Toner effetto speciale], selezionare [Bianco].

3. In [Target di elaborazione], selezionare una delle seguenti opzioni:

• [Nessuno]
Non viene applicato alcun toner ad effetto speciale. Qualsiasi colore spot utilizzato viene
elaborato utilizzando i valori CMYK.

• [Pagina intera]
Il toner ad effetto speciale viene applicato a tutta la pagina.

• [Colore spot con nome]
Il toner a effetto speciale viene applicato a un colore spot specifico nel file di stampa.

Nel campo [Nome colore spot], selezionare un colore spot dall’elenco o inserire un nome
colore spot. Il nome del colore spot deve corrispondere al colore spot utilizzato nel file di
stampa PDF. TotalFlow Prep non fornisce alcuna avvertenza se si immette un nome di colore
spot che non è riconosciuto.

Nel campo [Priorità colore spot], impostare quale colore spot ha la priorità sugli altri.

• [Oggetti specificati]
Il toner a effetto speciale è applicato solo a oggetti specifici. Selezionare uno o più oggetti
dall’elenco di opzioni disponibili per la configurazione.

4. In [Regola tono], immettere un valore da 0 a 100%.

5. In [Priorità di stampa], selezionare [Qualità] o [Velocità].
Quando la modalità di stampa è impostata su [Velocità], la quantità di toner a effetto speciale
viene ridotta per abilitare una stampa più rapida.

6. In [Intervallo di pagine], immettere l'intervallo di pagine che si desidera stampare con toner a
effetto speciale.

7. In [Speculare], specificare se applicare la stampa speculare a tutti i fogli nel lavoro.
La funzione [Speculare] si applica all’intero lavoro, anche se si imposta un intervallo di pagine
per le altre opzioni [Quinta stazione].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida contestuale
su schermo.
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Impostazione delle proprietà del toner speciale

• Le impostazioni [Quinta stazione] sono disponibili solo quando è installato un modulo [Quinta
stazione] sulla stampante. La disponibilità di tali impostazioni dipende dal modello di stampante,
dal controller della stampante e dalla configurazione [Quinta stazione].

• Le opzioni [Colore spot con nome] e [Regola tono] non sono disponibili per le stampanti con
controller EFI Fiery.

Quando [Speciale] è il toner a effetto speciale installato:

1. Fare clic su [Quinta stazione] nell'area delle impostazioni sulla destra.

2. In [Toner effetto speciale], selezionare [Speciale].

3. In [Target di elaborazione], selezionare una delle seguenti opzioni:

• [Nessuno]
Non viene applicato alcun toner ad effetto speciale. Qualsiasi colore spot utilizzato viene
elaborato utilizzando i valori CMYK.

• [Pagina intera]
Il toner ad effetto speciale viene applicato a tutta la pagina.

• [Colore spot con nome]
Il toner a effetto speciale viene applicato a un colore spot specifico nel file di stampa.

Nel campo [Nome colore spot], selezionare un colore spot dall’elenco o inserire un nome
colore spot. Il nome del colore spot deve corrispondere al colore spot utilizzato nel file di
stampa PDF. TotalFlow Prep non fornisce alcuna avvertenza se si immette un nome di colore
spot che non è riconosciuto.

Nel campo [Priorità colore spot], impostare quale colore spot ha la priorità sugli altri.

• [Oggetti specificati]
Il toner a effetto speciale è applicato solo a oggetti specifici. Selezionare uno o più oggetti
dall’elenco di opzioni disponibili per la configurazione.

4. In [Regola tono], immettere un valore da 0 a 100%.

5. In [Priorità di stampa], selezionare [Qualità] o [Velocità].
Quando la modalità di stampa è impostata su [Velocità], la quantità di toner a effetto speciale
viene ridotta per abilitare una stampa più rapida.

6. In [Intervallo di pagine], immettere l'intervallo di pagine che si desidera stampare con toner a
effetto speciale.

7. In [Speculare], specificare se applicare la stampa speculare a tutti i fogli nel lavoro.
La funzione [Speculare] si applica all’intero lavoro, anche se si imposta un intervallo di pagine
per le altre opzioni [Quinta stazione].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida contestuale
su schermo.
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SSppeecciiffiiccaazziioonnee ddeellllee iimmppoossttaazziioonnii ddii ffiinniittuurraa
È possibile specificare diverse impostazioni di finitura per i documenti stampati, come ad esempio
fascicolazione, pinzatura, perforazione, piegatura, rilegatura, rifilatura, vassoio di uscita, espulsione
output e funzioni stampante.

• È possibile specificare solo funzioni di finitura disponibili nella stampante in uso. Per prima cosa,
verificare di aver selezionato una stampante per il lavoro, quindi impostare le opzioni di finitura.

• Se una funzione è disponibile sulla stampante ma i valori specificati per le impostazioni non
corrispondono esattamente a quelli impostati sulla stampante, si verificherà un errore sulla
stampante.

• Se nel lavoro sono presenti formati carta misti e si desidera specificare impostazioni di finitura, si
consiglia di utilizzare le seguenti combinazioni di formati carta:

– A3 (297 × 420 mm) e A4 (210 × 297 mm)

– B4 (257 × 364 mm) e B5 (182 × 257 mm)

– 11 × 17 pollici e Letter (8,5 × 11 pollici)

– 8K (267 × 390 mm) e 16K (195 × 267 mm)

Per specificare le impostazioni di finitura:

1. Nell'area delle impostazioni sulla destra, fare clic su [Finitura] per visualizzare le opzioni di
finitura disponibili.

2. Nel pannello [Finitura], specificare le opzioni di finitura richieste per il lavoro.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.
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È possibile visualizzare l'anteprima delle impostazioni nell'area dello spazio di lavoro, in [Vista
foglio] e [Vista reader].

• Vengono visualizzate solo le opzioni di finitura disponibili sulla stampante. Ad esempio, se la
stampante non è dotata di unità di piegatura, l'impostazione [Piegatura] non viene
visualizzata.

• Le opzioni non compatibili con le impostazioni di lavoro corrente vengono contrassegnate
con un punto rosso . Ad esempio, se il lavoro è impostato per l'apertura a sinistra, tutte le
opzioni di pinzatura sul bordo destro sono contrassegnate come incompatibili.

Se si seleziona un’opzione incompatibile, regolare le impostazioni del lavoro in base alle
opzioni elencate nella finestra di dialogo per la risoluzione dei conflitti.

Stampa di documenti fascicolati

Se vengono stampate più copie di un lavoro, è possibile impostare l'ordine di stampa in modo che le
copie siano stampate in fascicoli.

Per specificare la modalità di fascicolazione delle copie del lavoro:

1. Nell'area delle impostazioni sulla destra fare clic su [Finitura].

2. Nel pannello [Finitura]:
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• Selezionare la casella di controllo [Fascicolazione] in [Generale] per ordinare le copie del
lavoro.

• Deselezionare la casella [Fascicolazione] se non si desidera che le copie del lavoro
vengano ordinate.

Non è possibile specificare le impostazioni di finitura per il lavoro se la casella
[Fascicolazione] non è selezionata.

Pinzatura del documento stampato

Se la stampante è dotata di un'unità di finitura per pinzatura, è possibile eseguire la pinzatura dei fogli
di un documento stampato.

Per specificare le opzioni di pinzatura:

1. Nell'area delle impostazioni sulla destra fare clic su [Finitura].

È anche possibile impostare le opzioni di pinzatura dal menu [Pinzatura] nella barra degli
strumenti.

2. Nel pannello [Finitura], selezionare una delle opzioni di pinzatura disponibili in [Pinzatura].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

Per ulteriori informazioni sul finisher installato, sui tipi di carta compatibili e sulle impostazioni di
pinzatura disponibili, consultare la documentazione della stampante.

Perforazione del documento stampato

Se la stampante è dotata di un'unità di finitura per perforazione, è possibile perforare i fogli di un
documento stampato.
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Per specificare le opzioni di perforazione:

1. Nell'area delle impostazioni sulla destra fare clic su [Finitura].

2. Nel pannello [Finitura], selezionare una delle opzioni di perforazione disponibili in
[Perforazione].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

Per ulteriori informazioni sul finisher installato, sui tipi di carta compatibili e sulle impostazioni di
perforazione disponibili, consultare la documentazione della stampante.

Piegatura del documento stampato

Se la stampante è dotata di un'unità di piegatura carta, è possibile piegare i fogli di un documento
stampato.

Per specificare le opzioni di piegatura:

1. Nell'area delle impostazioni sulla destra fare clic su [Finitura].

2. Nel pannello [Finitura], selezionare una delle opzioni di piegatura disponibili in [Piegatura].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

Per ulteriori informazioni su formati e grammatura carta compatibili, consultare la
documentazione della stampante e dell’unità di piegatura carta.
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Rilegatura del documento stampato

Se la stampante è dotata di un'unità di rilegatura, è possibile rilegare i fogli di un documento.

Con un'unità di rilegatura ad anelli, è possibile inserire anelli lungo il bordo di rilegatura.

Con a un'unità di rilegatura adesiva è possibile inserire i fogli del documento in una copertina e
incollarli insieme.

• Per eseguire una rilegatura adesiva è necessario configurare le impostazioni [Orientamento] e
[Lato di stampa] nel seguente modo:

– Se [Orientamento] è [Verticale], l'impostazione [Lato di stampa] deve essere [Lato
anteriore (1 facciata), apri a sinistra], [Entrambi i lati (2 facciate), apri a sinistra], [Lato
anteriore (1 facciata), apri a destra] o [Entrambi i lati (2 facciate), apri a destra].

– Se [Orientamento] è [Orizzontale], l'impostazione [Lato di stampa] deve essere [Lato
anteriore (1 facciata), apri in alto] o [Entrambi i lati (2 facciate), apri in alto].

Per specificare le impostazioni di rilegatura:

1. Nell'area delle impostazioni sulla destra fare clic su [Finitura].

2. Nel pannello [Finitura], selezionare una delle opzioni di rilegatura disponibili in [Rilegatura].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

Per ulteriori informazioni su formati e grammatura carta compatibili, consultare la
documentazione della stampante e dell’unità per la rilegatura.
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Rifilatura del documento stampato

È possibile specificare opzioni di rifilatura per lavori con pinzatura centrale e rilegatura a colla.

Per lavori con pinzatura centrale, con opzione [2 al centro] impostata nella sezione [Pinzatura], è
possibile rifilare l'estremità di apertura del documento. È necessario che sulla stampante sia installata
una rifilatrice.

Per lavori con rilegatura adesiva con l'opzione [Rilegatura adesiva] impostata nella sezione
[Rilegatura], è possibile rifilare l'estremità superiore, inferiore e di apertura del documento. È
necessario che sulla stampante sia installata un'unità di rilegatura a colla.

• Questa funzione non esegue il taglio centrale per i metodi di stampa [Adesiva doppia], [Libretto
doppio], [Veloce] e [Ripeti].

• [Allineamento immagine] cambia automaticamente in [Lato rilegatura] quando l'impostazione
[Rilegatura] è [Rilegatura adesiva] e si seleziona [Nessuno], [Specifica formato finito] o
[Specifica bordo di testa, di coda e anteriore] per l'impostazione [Rifilatura].

Per specificare le opzioni di rifilatura:

1. Nell'area delle impostazioni sulla destra fare clic su [Finitura].

2. Nel pannello [Finitura], selezionare una delle seguenti opzioni di rifilatura disponibili in
[Rifilatura] e configurare le impostazioni in base alle necessità del lavoro.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.
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Per ulteriori informazioni su formati e grammatura carta compatibili, consultare la
documentazione della stampante, della rifilatrice e dell’unità per la rilegatura.

Impostazione del vassoio di uscita

È possibile specificare un vassoio di uscita per i fogli stampati.

Per specificare un vassoio di uscita:

1. Nell'area delle impostazioni sulla destra fare clic su [Finitura].

2. Nel pannello [Finitura], selezionare una delle opzioni del vassoio di uscita disponibili in
[Vassoi di uscita].

È possibile scegliere [Selezione auto vassoio] per la selezione automatica del vassoio.

Specificazione di come espellere l'output

È possibile specificare se espellere l'output rivolgendolo verso l'alto o verso il basso.

Per specificare come espellere l'output:

1. Nell'area delle impostazioni sulla destra fare clic su [Finitura].

2. Nel pannello [Finitura], selezionare una delle opzioni disponibili in [Espelli output].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

Uso delle funzioni della stampante

A seconda della stampante selezionata, è possibile utilizzare una serie di funzioni specifiche per la
stampante.

Per visualizzare e selezionare le funzioni stampante disponibili:

1. Nell'area delle impostazioni sulla destra fare clic su [Finitura].

2. Nel pannello [Finitura], selezionare una impostazione predefinita stampante dall'elenco
[Funzione stampante] e un valore dall'elenco [Opzione funzione].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.
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AAggggiiuunnttaa ee mmooddiiffiiccaa ddii sscchheeddee
TotalFlow Prep consente di inserire schede, convertire pagine in schede e configurare impostazioni
predefinite di schede. È anche possibile stampare testo e immagini sulle linguette delle schede e
configurare impostazioni per l’espulsione delle schede inutilizzate in un vassoio separato.

Inserimento di schede

È possibile inserire schede usando il menu attivato con il tasto destro del mouse.

Per inserire schede:

1. Selezionare una pagina di destinazione nell'elenco delle pagine.

2. Fare clic con il tasto destro del mouse e selezionare Schede→ Inserisci scheda dal menu.
Una scheda viene inserita prima della pagina di destinazione.

• Non è possibile inserire una scheda prima di una copertina anteriore o dopo una copertina
posteriore.

• Non è possibile inserire una scheda prima di un foglio designato posizionato all'inizio di un
capitolo.

• [Inserisci scheda] non è supportato se l'imposizione è impostata su [Libretto] o [Combina]
- [Veloce].

Inserimento di schede prima dei capitoli

È possibile automatizzare l'inserimento di schede prima dei capitoli.

La funzione di automazione scheda non è disponibile se il lavoro non ha capitoli.

Per inserire schede prima dei capitoli:

1. Accertarsi che il lavoro abbia almeno un capitolo.

Per informazioni sulla creazione di capitoli, consultare Creazione di capitoli, pagina 111.
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2. Nella barra dei menu, fare clic su Inserisci→ Impostazioni automatiche scheda→ Inserisci
schede ai capitoli.

• Vengono inserite schede prima di tutti i capitoli del lavoro.

• Le schede non vengono inserite prima dei capitoli che dispongono già di schede all'inizio.

Inserimento dei nomi dei capitoli sulle linguette delle schede

Sulle linguette delle schede è possibile inserire il nome del capitolo.

Questa funzione è disponibile solo se il lavoro contiene capitoli e sono presenti schede inserite prima
dei capitoli.

Per inserire i nomi di capitolo sulle linguette delle schede:

1. Accertarsi che il lavoro abbia almeno un capitolo.

Per informazioni sulla creazione di capitoli, consultare Creazione di capitoli, pagina 111.

2. Accertarsi che le schede siano inserite prima dei capitoli.

Per informazioni sull’inserimento di schede prima dei capitoli, consultare Inserimento di schede
prima dei capitoli, pagina 178.

3. Nella barra dei menu, fare clic su Inserisci→ Impostazioni automatiche scheda→ Inserisci
nomi capitolo su linguette.

• I nomi dei capitoli vengono inseriti sulle linguette delle schede all'inizio di ogni capitolo.

• Questa funzione inserisce i nomi dei capitoli, ma non aggiorna automaticamente il testo della
linguetta della scheda se i capitoli vengono rinominati, spostati o eliminati.

• Selezionare nuovamente [Inserisci nomi capitolo su linguette] per aggiornare i nomi dei
capitoli sulle linguette delle schede dopo aver rinominato, spostato o eliminato dei capitoli.

Conversione di una pagina in una scheda

Per convertire una pagina in una scheda:

1. Selezionare una pagina nell'elenco delle pagine.

• Per selezionare più pagine, tenere premuto il tasto Ctrl e fare clic su ogni pagina che si
desidera selezionare.

• Per selezionare un intervallo di pagine, fare clic sulla prima pagina nell’intervallo, quindi
tenere premuto il tastoMaiusc e fare clic sull’ultima pagina nell’intervallo.

2. Fare clic con il tasto destro del mouse e selezionare Schede→ Converti in scheda dal menu.
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• Il contenuto della pagina viene spostato verso la linguetta della scheda quando la pagina
viene convertita in scheda.

• Non è possibile convertire in schede le copertine anteriore e posteriore.

• Non è possibile convertire un foglio designato in scheda.

• [Converti in scheda] è disabilitato per [Libretto] e l'imposizione [Combina].

• Le schede convertite restano nel lavoro se vengono create prima della modifica
dell'imposizione in [Combina] - [Singolo] o [Combina] - [Ripeti].

• Le schede convertite vengono modificate in pagine normali quando l'imposizione è impostata
su [Libretto] o [Combina] - [Veloce].

Modifica schede

È possibile modificare le impostazioni della scheda, aggiungere testo o immagini alle linguette delle
schede e gestire le impostazioni predefinite dei divisori a rubrica.

Per modificare le schede:

1. Fare clic con il tasto destro del mouse su una scheda e selezionare Schede→Modifica
scheda... dal menu.

Si apre la schermata [Modifica schede].
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2. Selezionare un'impostazione predefinita per i divisori a rubrica dall'elenco [Impostazioni
predefinite divisori a rubrica].
Per ulteriori informazioni sulla modifica delle impostazioni predefinite e l'aggiunta di nuove
impostazioni predefinite, consultare Gestione delle impostazioni predefinite dei divisori a rubrica,
pagina 181.

3. Specificare le impostazioni richieste per le schede.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

Gestione delle impostazioni predefinite dei divisori a rubrica

È possibile selezionare, modificare e eliminare le impostazioni predefinite dei divisori a rubrica usando
l'elenco delle impostazioni predefinite.

• Selezionare un'impostazione predefinita del divisore a rubrica facendo clic su un nome
impostazione predefinita nell'elenco [Impostazioni predefinite divisori a rubrica].
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• Fare clic su , l'icona [Modifica], per modificare l'impostazione predefinita del divisore a
rubrica. Si apre la finestra di dialogo [Modifica impostazioni predefinite divisori a rubrica].

• Fare clic su , l'icona [Elimina], per eliminare l'impostazione predefinita del divisore a rubrica.

• Fare clic su [Nuova impostazione predefinita] per aggiungere una nuova impostazione
predefinita del divisore a rubrica. Si apre la finestra di dialogo [Aggiungi impostazioni
predefinite divisori a rubrica].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida contestuale
su schermo.

Espulsione delle schede non utilizzate

Se un lavoro utilizza meno schede rispetto a quelle presenti in una serie, è possibile scegliere di
espellere le schede non utilizzate. Ad esempio, se il lavoro ha quattro schede definite e sono presenti
cinque schede per serie, la scheda non utilizzata viene espulsa nel vassoio di uscita quando il lavoro
viene stampato.

• Il menu [Espelli schede non usate] è disponibile solo se la stampante selezionata supporta la
funzionalità di espulsione delle schede non utilizzate.

• La funzione [Espelli schede non usate] non è disponibile per schede convertite.

• L'aggiunta di un'immagine a una scheda disabilita la funzione [Espelli schede non usate].

Per selezionare un vassoio di uscita per [Espelli schede non usate]:

1. Aprire [Impostazione lavoro] nell'area impostazioni. Deselezionare la casella [Applica
impostazioni a PDF e rimuovi da job ticket].

2. Nella schermata [Modifica schede], selezionare un vassoio di uscita disponibile dal menu
[Espelli schede non usate].

5 Modifica dei lavori



5

183

Per impostazione predefinita, la casella [Applica impostazioni a PDF e rimuovi da job ticket] è
selezionata. Per cambiare l’impostazione predefinita, fare clic su Impostazioni→ Preferenze, quindi
fare clic sulla scheda [Generale]. In [Impostazioni di stampa], deselezionare la casella [Applica
impostazioni a PDF e rimuovi da job ticket].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida contestuale
su schermo.

Specificazione delle dimensioni della scheda

Specificare altezza, lunghezza e distanza della scheda dal bordo del foglio.

Sono disponibili quattro impostazioni per il formato della scheda

1. [Da bordo scheda a bordo foglio]: specificare la distanza dal bordo del foglio ai bordi
superiore e inferiore della serie di schede. Utilizzare incrementi di 0,1 mm (0,01 pollici).

2. [Lato corto]: specificare la lunghezza del bordo corto della scheda. Questo è il lato della scheda
più lontano dal foglio. Utilizzare incrementi di 0,1 mm (0,01 pollici).

3. [Lato lungo]: specificare la lunghezza del bordo lungo della scheda. Questo è il lato della scheda
a contatto con il foglio. Utilizzare incrementi di 0,1 mm (0,01 pollici).

4. [Altezza]: specificare l'altezza della scheda. Questa è la distanza dal bordo corto della scheda al
bordo del foglio. Utilizzare incrementi di 0,1 mm (0,01 pollici).

Aggiunta di testo e immagini a una scheda

Sulle linguette della scheda è possibile stampare testo e immagini.

Per aggiungere testo o immagini alle linguette delle schede:

1. Fare clic con il tasto destro del mouse su una scheda e selezionare Schede→Modifica
scheda... dal menu.

2. Nella schermata [Modifica schede], usare le funzioni nelle sezioni [TESTO] e [IMMAGINE]
per aggiungere testo o inserire un'immagine.
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Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

Controllare l'anteprima per verificare che il testo e le immagini appaiano correttamente.

La funzione di inserimento immagine non è disponibile nella versione browser di TotalFlow Prep.

Spostamento di schede

Per spostare le schede:

1. Fare clic sulla scheda nell'elenco delle pagine e tenere premuto il pulsante del mouse.

2. Trascinare la scheda nella nuova posizione nell'elenco delle pagine e rilasciare il pulsante del
mouse.
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Taglia, copia e incolla di schede

Per tagliare, copiare o incollare una scheda

1. Selezionare la scheda nell'elenco delle pagine.

• Per selezionare più schede, tenere premuto il tasto Ctrl e fare clic su ogni scheda che si
desidera selezionare.

• Per selezionare un intervallo di schede, fare clic sulla prima scheda nell'intervallo, quindi
tenere premuto il tastoMaiusc e fare clic sull'ultima scheda nell'intervallo.

2. Fare clic con il pulsante destro del mouse e selezionare [Taglia] o [Copia] dal menu.

3. Selezionare la pagina di destinazione, fare clic con il pulsante destro del mouse e selezionare
[Incolla].

• Le schede vengono incollate prima della pagina di destinazione.

• Non è possibile incollare schede prima della copertina anteriore o dopo la copertina
posteriore.

• Le schede esistenti si riposizionano automaticamente dopo che la scheda è stata incollata.

Eliminazione di schede

Per eliminare le schede:

1. Selezionare la scheda.

• Per selezionare più schede, tenere premuto il tasto Ctrl e fare clic su ogni scheda che si
desidera selezionare.

• Per selezionare un intervallo di schede, fare clic sulla prima scheda nell'intervallo, quindi
tenere premuto il tastoMaiusc e fare clic sull'ultima scheda nell'intervallo.

2. Fare clic con il tasto destro del mouse e selezionare [Elimina] dal menu.
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• Le schede esistenti si riposizionano automaticamente dopo che la scheda è stata eliminata.

Applicazione, modifica e creazione di temi per le schede

I temi memorizzano la formattazione delle schede e del testo che può essere applicata rapidamente
alle schede. È possibile selezionare da una raccolta di temi predefinita o personalizzare un tema e
salvarlo.

• I temi salvano le impostazioni seguenti:

– Orientamento, posizione, allineamento e formattazione del testo

– Motivi a colori di caratteri

– Rotazione, ridimensionamento e posizione dell'immagine

• I temi non memorizzano testo e immagini inseriti o informazioni predefinite delle schede.

Per applicare un tema:

1. Nella schermata [Modifica schede], fare clic su , il pulsante [Temi], sulla barra degli
strumenti.

2. Selezionare un tema.

Le impostazioni vengono applicate a tutte le schede nel lavoro.

• Quando si applica un tema con un motivo di colori, quest'ultimo viene ripetuto
automaticamente sulle schede.

Modifica di temi per le schede

È possibile modificare i nomi dei temi esistenti.

Per modificare il nome di un tema:

1. Nella schermata [Modifica schede], fare clic su , il pulsante [Temi], sulla barra degli
strumenti.

2. Fare clic sul , il pulsante [Modifica].

3. Immettere un nuovo nome per il tema nella finestra di dialogo.

4. Fare clic su [OK].
I temi vengono disposti in ordine alfabetico.
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Creazione di temi personalizzati per le schede

È possibile creare e salvare temi personalizzati. I temi non salvano testo, immagini o informazioni
predefinite delle schede.

Per creare un tema personalizzato:

1. Nella schermata [Modifica schede], personalizzare le impostazioni per testo e immagini.
I temi salvano le impostazioni seguenti:

• Orientamento, posizione, allineamento e formattazione del testo

• Motivi a colori di caratteri

• Rotazione, ridimensionamento e posizione dell'immagine

2. Fare clic sul , il pulsante [Temi], sulla barra degli strumenti.

3. Fare clic su [Salva tema...].

4. Immettere un nome per il tema nella finestra di dialogo [Salva tema].

5. Fare clic su [OK].
I temi vengono disposti in ordine alfabetico.

• Un motivo di colori può salvare impostazioni di colore diverse per ogni scheda.

• Un motivo si basa sul numero di schede in un lavoro. È possibile creare un motivo di colori
specifico, salvarlo come tema personalizzato e applicarlo ad altri lavori.
Ad esempio, per creare un tema personalizzato con un motivo di colori alternante di schede in
bianco e nero:

1. Creare un lavoro con due schede.

2. Definire impostazioni di colore diverse per ogni scheda.

3. Salvare il tema personalizzato.

4. Chiudere il lavoro.

5. Aprire un altro lavoro con più schede.

6. Applicare il nuovo tema personalizzato. Il motivo di colori viene ripetuto automaticamente sulle
schede del lavoro. Se il lavoro ha 20 schede, il motivo alternante viene ripetuto 10 volte.

AAggggiiuunnttaa ee mmooddiiffiiccaa ddii sscchheeddee ssuu mmaarrggiinnii aall vviivvoo
È possibile aggiungere schede su margini al vivo per creare sezioni nel documento. Le schede su
margini al vivo sono poste sul margine delle pagine e possono includere testo, immagini e motivi a
colori.

Le schede su margini al vivo sono poste sul margine della pagina opposto alla rilegatura. La posizione
dipende dalla direzione di apertura dei fogli come specificato nel menu [Lato di stampa]. Le schede
su margini al vivo vengono riposizionate e ridimensionate quando si modificano le opzioni [Lato di
stampa].
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• Quando la direzione è impostata su apri a sinistra, le schede su margini al vivo sono posizionate
sul margine destro.

• Quando la direzione è impostata su apri a destra, le schede su margini al vivo sono posizionate
sul margine sinistro.

• Quando la direzione è impostata su apri in alto, le schede su margini al vivo sono posizionate sul
margine inferiore.

Vedere Specificazione delle impostazioni del lato di stampa, pagina 166.

Per aggiungere schede su margine al vivo:

1. Selezionare le pagine di destinazione nell'elenco delle pagine o in [Vista foglio].

• Per selezionare più pagine, tenere premuto il tasto Ctrl e fare clic su ogni pagina che si
desidera selezionare.

• Per selezionare un intervallo di pagine, fare clic sulla prima pagina nell’intervallo, quindi
tenere premuto il tastoMaiusc e fare clic sull’ultima pagina nell’intervallo.

2. Fare clic con il tasto destro del mouse e selezionare Scheda su margine al vivo→ Crea
gruppo schede su margine al vivo dal menu.

Se nel lavoro sono presenti capitoli, è possibile fare clic su Inserisci→ Schede su margine al
vivo sulla barra dei menu per creare un gruppo di schede su margini al vivo per ogni capitolo.
Le schede su margini al vivo si popolano automaticamente con i nomi dei capitoli e gli intervalli
pagine. I nomi dei capitoli vengono inseriti automaticamente per impostazione predefinita.

Si apre la schermata [Schede su margine al vivo].

La schermata [Schede su margine al vivo] è formata dalle seguenti aree:

1. Area impostazioni per impostazioni predefinite scheda su margine al vivo, lato di stampa,
modello, lunghezza scheda, margini, bordo, distanza scheda, schede per serie e profondità
scheda.
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2. Barra degli strumenti per cambiare la forma dello sfondo della scheda, formattare il testo,
aggiungere immagini, modificare immagini applicare e modificare temi.

3. Elenco schede per aggiungere, modificare e ordinare schede su margine al vivo.

4. Anteprima scheda per la visualizzazione in anteprima delle schede su margini al vivo. La
finestra superiore visualizza la scheda corrente e la finestra inferiore visualizza il
posizionamento delle schede nelle pagine campione.

• Solo le impostazioni provenienti dall’Area impostazioni vengono salvate come
impostazione predefinita scheda su margine al vivo. Le impostazioni da Barra degli
strumenti, Elenco schede o Anteprima scheda non vengono salvate come impostazione
predefinita.

• La funzione di inserimento immagine non è disponibile nella versione browser di TotalFlow
Prep.

3. Configurare le impostazioni richieste per le schede su margini al vivo.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

4. Fare clic su [OK].
È possibile visualizzare un’anteprima delle impostazioni nell’area di lavoro.

Gestione impostazioni predefinite scheda su margine al vivo

È possibile selezionare, modificare, salvare ed eliminare impostazioni predefinite scheda su margine al
vivo utilizzando l’elenco impostazione predefinita.

• Selezionare una impostazione predefinita scheda su margini al vivo facendo clic su un nome
impostazione predefinita nell'elenco [Impostazione predefinita].

• Fare clic su , l’icona [Elimina], per eliminare l'impostazione predefinita scheda su margine al
vivo.

• Fare clic su [Salva impostazioni come predefinite] nell'elenco [Impostazione predefinita] per
salvare le impostazioni della scheda su margini al vivo come impostazione predefinita. Si apre la
finestra di dialogo [Salva impostazione predefinita].

La funzione [Salva impostazioni come predefinite] non salva tutte le impostazioni della scheds
su margine al vivo. Solo [Schede per serie], [Modello], [Lunghezza scheda], [Margini],
[Bordo], [Distanza scheda] e [Profondità scheda] vengono salvati come impostazione
predefinita.

• Fare clic su [Gestisci impostazioni predefinite] nell'elenco [Impostazione predefinita] per
visualizzare, modificare ed eliminare impostazioni predefinite già esistenti.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida contestuale
su schermo.
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Impostazione del lato di stampa

È possibile impostare il lato di stampa selezionando una delle seguenti opzioni:

• [Lato anteriore (1 facciata)]: colloca una scheda sul lato anteriore della pagina.

• [Entrambi i lati (2 facciate)]: colloca una scheda su entrambi i lati della pagina. La scheda e i
contenuti non vengono ruotati.

• [Entrambi i lati (2 facciate), speculare]: colloca una scheda su entrambi i lati della pagina. I
contenuti della scheda del lato posteriore vengono ruotati in modo da corrispondere alla scheda
del lato anteriore.

Anteprima lato anteriore:

Anteprima lato posteriore:

• [Entrambi i lati (2 facciate), rotazione 180°]: colloca una scheda su entrambi i lati della
pagina. La scheda del lato posteriore viene ruotata di 180°.

Anteprima lato anteriore:

Anteprima lato posteriore:
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Impostazione delle schede per serie

Le impostazioni della scheda su margini al vivo vengono applicate e ripetute in base al numero di
schede nella serie.

Impostazione dell’ordine modello

Impostare l’ordine modello per le schede su margine al vivo dalle seguenti opzioni:

• [Discendente]: sistemare le schede in ordine decrescente dalla parte superiore della pagina a
quella inferiore.

• [Crescente]: sistemare le schede in ordine crescente dalla parte inferiore della pagina a quella
superiore.

• [Nessuno]: tutte le schede vengono posizionate nell'angolo superiore destro.

Impostazione della lunghezza

Impostare la lunghezza della scheda scegliendola dalle opzioni disponibili:

• [Automatico in base al contenuto]: imposta automaticamente la lunghezza per ogni scheda in
base all'oggetto di scheda più grande (testo, immagine o forma).

• [Lunghezza fissa]: immettere manualmente la lunghezza specifica per tutte le schede nella serie.
Utilizzare incrementi di 0,1 mm (0,01 pollici).

• [Pari lunghezza]: imposta automaticamente ogni scheda a una lunghezza uguale in base al
numero di schede in ogni serie.

• [Pari alla lunghezza pagina]: regola automaticamente la lunghezza di ogni scheda in modo che
si adatti a tutte le schede in ogni serie all'interno della lunghezza della pagina.

• [Lunghezza pagina intera]: imposta automaticamente ogni scheda alla lunghezza della pagina.
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Impostazione dei margini

Impostare i margini della scheda immettendo manualmente i valori per le seguenti opzioni:

• [Superiore]: specificare la distanza dal bordo del foglio alla parte superiore della serie di schede.
Utilizzare incrementi di 0,1 mm (0,01 pollici).

• [In basso]: specificare la distanza dal bordo del foglio alla parte inferiore della serie di schede.
Utilizzare incrementi di 0,1 mm (0,01 pollici).

Impostazione del bordo

Immettere manualmente il bordo specifico per tutte le schede nella serie. Utilizzare incrementi di 0,1
mm (0,01 pollici).

• Un margine negativo sposta la scheda al bordo della pagina. Qualsiasi contenuto della scheda
che fuoriesce dalla pagina viene troncato.

• Un margine positivo sposta la scheda sulla pagina.

Impostazione della distanza scheda

Immettere manualmente la distanza specifica per tutte le schede nella serie. Utilizzare incrementi di 0,1
mm (0,01 pollici).

Impostazione della profondità

Selezionare dalle opzioni disponibili la profondità della scheda su margine al vivo:

• [Automatico in base al contenuto]: imposta automaticamente la profondità per ogni scheda in
base all'oggetto più grande (testo, immagine o forma).

• [Profondità fissa]: immettere manualmente la profondità specifica per tutte le schede nella serie.
Utilizzare incrementi di 0,1 mm (0,01 pollici).

• [Pari profondità]: imposta automaticamente ogni scheda a una profondità uguale in base alla
scheda più grande.

Applicazione, modifica e creazione di temi per le schede su margini al vivo

I temi memorizzano la formattazione delle schede su margini al vivo e del testo che può essere
applicata rapidamente a tutte le schede su margini al vivo. È possibile selezionare da una raccolta di
temi predefinita o personalizzare un tema e salvarlo.
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• I temi salvano le impostazioni seguenti:

– Orientamento, posizione, allineamento e formattazione del testo

– Rotazione, posizione e ridimensionamento delle immagini

– Colore dei caratteri, colore riempimento forme, colore bordo forme o motivi a colori. I motivi a
colori includono colore dei caratteri, colore riempimento forme e colore bordo forme.

• I temi non memorizzano testo e immagini inseriti o informazioni predefinite sulle schede su margini
al vivo.

Per applicare un tema:

1. Nella schermata [Schede su margine al vivo], fare clic su , il pulsante [Temi], sulla
barra degli strumenti.

2. Selezionare un tema.

Le impostazioni vengono applicate a tutte le schede su margini al vivo nel lavoro.

• Quando si applica un tema con un motivo di colori, quest'ultimo viene ripetuto
automaticamente sulle schede su margini al vivo.

Modifica di temi per le schede su margini al vivo

È possibile modificare i nomi dei temi esistenti. I temi vengono disposti in ordine alfabetico.

Per modificare il nome di un tema:

1. Nella schermata [Schede su margine al vivo], fare clic su , il pulsante [Temi], sulla
barra degli strumenti.

2. Fare clic sul , il pulsante [Modifica].

3. Immettere un nuovo nome per il tema nella finestra di dialogo.

4. Fare clic su [OK].
I temi vengono disposti in ordine alfabetico.

Creazione di temi personalizzati per le schede su margini al vivo

È possibile creare e salvare temi personalizzati. I temi non salvano le informazioni predefinite sulle
schede su margini al vivo, testo o immagini.

Per creare un tema personalizzato:

1. Nella schermata [Schede su margine al vivo], personalizzare le impostazioni per testo e
immagini.

I temi salvano le impostazioni seguenti:
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• Orientamento, posizione, allineamento e formattazione del testo

• Rotazione, posizione e ridimensionamento delle immagini

• Colore dei caratteri, colore riempimento forme, colore bordo forme o motivi a colori. I motivi
a colori includono colore dei caratteri, colore riempimento forme e colore bordo forme.

2. Fare clic sul , il pulsante [Temi], sulla barra degli strumenti.

3. Fare clic su [Salva tema...].

4. Immettere un nome per il tema nella finestra di dialogo [Salva tema].

5. Fare clic su [OK].
I temi vengono disposti in ordine alfabetico.

• Un motivo di colori può salvare impostazioni di colore diverse per ogni scheda su margini al vivo.

• Un motivo si basa sul numero di schede su margini al vivo in un lavoro. È possibile creare un motivo
di colori specifico, salvarlo come tema personalizzato e applicarlo ad altri lavori.
Ad esempio, per creare un tema personalizzato con un motivo di colori alternante di schede su
margini al vivo in bianco e nero:

1. Creare un lavoro con due schede su margini al vivo.

2. Definire impostazioni di colore diverse per ogni scheda su margini al vivo.

3. Salvare il tema personalizzato.

4. Chiudere il lavoro.

5. Aprire un altro lavoro con più schede su margini al vivo.

6. Applicare il nuovo tema personalizzato. Il motivo di colori viene ripetuto automaticamente su
tutte le schede su margini al vivo del lavoro. Se il lavoro ha 20 schede su margini al vivo, il
motivo alternante viene ripetuto 10 volte.

AAggggiiuunnttaa ee mmooddiiffiiccaa ddii iinnsseerrttii
Gli inserti sono fogli vuoti o prestampati posizionati tra le pagine del lavoro. È possibile aggiungere
inserti all'interno del lavoro o modificare le impostazioni specificate per gli inserti esistenti.

Aggiunta di inserti

È possibile aggiungere inserti prima o dopo una pagina.

Per aggiungere inserti:

1. Fare clic con il pulsante destro del mouse sulla pagina di destinazione nell'elenco delle pagine o
sul foglio di destinazione in [Vista foglio] e selezionare Inserti→ Inserisci prima... o
Inserti→ Inserisci dopo....
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È possibile selezionare e fare clic con il pulsante destro del mouse su più pagine o fogli di
destinazione.

2. Nella finestra di dialogo [Aggiungi inserti prima] o [Aggiungi inserti dopo], configurare le
impostazioni richieste per gli inserti.

È possibile impostare la carta e il vassoio di alimentazione, specificare diverse pagine di
destinazione e impostare il numero di fogli da aggiungere.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

3. Fare clic su [OK].

• Non è possibile posizionare gli inserti prima di una copertina anteriore o dopo una copertina
posteriore.

• Non è possibile posizionare gli inserti prima di un foglio designato posizionato all'inizio di un
capitolo o dopo un foglio designato posizionato alla fine di un capitolo.

• Non è possibile posizionare inserti tra due schede inserite.

• Non è possibile aggiungere inserti se l'imposizione è impostata su [Libretto] o [Combina] -
[Veloce].
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Modifica di inserti

È possibile modificare le impostazioni di carta e vassoio specificate per un inserto.

Per modificare gli inserti:

1. Selezionare l'inserto nell'elenco delle pagine o in [Vista foglio].

• Per selezionare più inserti, tenere premuto il tasto Ctrl e fare clic su ogni inserto da
selezionare.

• Per selezionare un intervallo di inserti, fare clic sul primo inserto nell'intervallo, quindi tenere
premuto il tasto Maiusc e fare clic sull'ultimo inserto nell'intervallo.

2. Fare clic con il pulsante destro del mouse e selezionare Inserti→Modifica....

3. Nella finestra di dialogo [Modifica inserti], modificare le impostazioni di carta e vassoio come
necessario.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.
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• Se sono stati selezionati più inserti con impostazioni di carta e vassoio diverse, la finestra di
dialogo [Modifica inserti] visualizza la carta e il vassoio del primo inserto.

4. Fare clic su [OK].

Spostamento di inserti

Per spostare gli inserti:

1. Nell'elenco delle pagine, selezionare l'inserto o gli inserti da spostare.

• Per selezionare più inserti, tenere premuto il tasto Ctrl e fare clic su ogni inserto da
selezionare.

• Per selezionare un intervallo di inserti, fare clic sul primo inserto nell'intervallo, quindi tenere
premuto il tasto Maiusc e fare clic sull'ultimo inserto nell'intervallo.

2. Fare clic sulla selezione e tenere premuto il pulsante del mouse, quindi trascinare gli inserti nella
nuova posizione e rilasciare il pulsante del mouse.

• Non è possibile spostare gli inserti prima della copertina anteriore o dopo la copertina
posteriore.

• Non è possibile spostare gli inserti prima di un foglio designato posizionato all'inizio di un
capitolo o dopo un foglio designato posizionato alla fine di un capitolo.

• Non è possibile spostare gli inserti tra due schede inserite.

• Se il lavoro ha imposizione [Normale] ed è impostato per la stampa sul lato anteriore del
foglio, è anche possibile spostare gli inserti da [Vista foglio].

Taglia, copia e incolla di inserti

Per tagliare, copiare e incollare gli inserti:

1. Selezionare l'inserto nell'elenco delle pagine o in [Vista foglio].

• Per selezionare più inserti, tenere premuto il tasto Ctrl e fare clic su ogni inserto da
selezionare.

• Per selezionare un intervallo di inserti, fare clic sul primo inserto nell'intervallo, quindi tenere
premuto il tasto Maiusc e fare clic sull'ultimo inserto nell'intervallo.

2. Fare clic con il pulsante destro del mouse e selezionare [Taglia] o [Copia] dal menu.

3. Selezionare la pagina o il foglio di destinazione, fare clic con il pulsante destro del mouse e
selezionare [Incolla].
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• Gli inserti vengono incollati prima della pagina o del foglio di destinazione.

• Non è possibile incollare gli inserti prima della copertina anteriore o dopo la copertina
posteriore.

• Non è possibile incollare gli inserti prima di un foglio designato posizionato all'inizio di un
capitolo o dopo un foglio designato posizionato alla fine di un capitolo.

• Non è possibile incollare gli inserti tra due schede inserite.

Eliminazione di inserti

Per eliminare gli inserti:

1. Selezionare l'inserto nell'elenco delle pagine o in [Vista foglio].

• Per selezionare più inserti, tenere premuto il tasto Ctrl e fare clic su ogni inserto da
selezionare.

• Per selezionare un intervallo di inserti, fare clic sul primo inserto nell'intervallo, quindi tenere
premuto il tasto Maiusc e fare clic sull'ultimo inserto nell'intervallo.

2. Fare clic con il tasto destro del mouse e selezionare [Elimina] dal menu.

AAggggiiuunnttaa ddii nnuummeerrii ddii ppaaggiinnaa
Prima della stampa, è possibile aggiungere numeri di pagina a un documento.

Per aggiungere i numeri di pagina:

1. Nell'area delle impostazioni sulla destra fare clic su [Contenuto pagina].
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2. Nel pannello [Contenuto pagina] fare clic su [Numeri pagina].

3. Nella schermata [Numeri pagina], configurare le impostazioni di numerazione delle pagine
richieste per il lavoro.

Se il lavoro è impostato per la stampa su entrambi i lati del foglio, è possibile specificare le stesse
impostazioni per entrambe i lati o impostazioni differenti per il lato posteriore.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.
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Per annullare tutte le modifiche e tornare alle impostazioni predefinite, fare clic su [Reimposta].

4. Fare clic su [OK].
È possibile visualizzare un’anteprima delle impostazioni nell’area di lavoro.

AAggggiiuunnttaa ddii iinntteessttaazziioonnee ee ppiièè ddii ppaaggiinnaa
Prima della stampa, è possibile aggiungere un'intestazione e un piè di pagina a un documento.

Per aggiungere una intestazione e un piè di pagina

1. Nell'area delle impostazioni sulla destra fare clic su [Contenuto pagina].
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2. Nel pannello [Contenuto pagina] fare clic su [Intestazioni/Pié di pagina].

3. Nella schermata [Intestazioni/Pié di pagina], configurare le impostazioni di intestazione e piè
di pagina richieste per il lavoro.

Se il lavoro è impostato per la stampa su entrambi i lati del foglio, è possibile specificare le stesse
impostazioni per entrambe i lati o impostazioni differenti per il lato posteriore.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.
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Per annullare tutte le modifiche e tornare alle impostazioni predefinite, fare clic su [Reimposta].

4. Fare clic su [OK].
È possibile visualizzare un’anteprima delle impostazioni nell’area di lavoro.

AAggggiiuunnttaa ddeeii ttiimmbbrrii ppaaggiinnaa
Prima della stampa, è possibile aggiungere timbri pagina al documento.

Per aggiungere i timbri pagina:

1. Nell'area delle impostazioni sulla destra fare clic su [Contenuto pagina].

2. Nel pannello [Contenuto pagina] fare clic su [Timbratura pagina].

Se non sono presenti altri timbri pagina nel lavoro, si apre la schermata [Timbratura pagina].

Se sono presenti altri timbri pagina nel lavoro, si apre la schermata [Seleziona timbro pagina].
Per aprire la schermata [Timbratura pagina], fare clic sul pulsante [Aggiungi timbro].

3. Nella schermata [Timbratura pagina], configurare le impostazioni di timbratura pagina
richieste per il lavoro.
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Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

Per annullare tutte le modifiche e tornare alle impostazioni predefinite, fare clic su [Reimposta].

4. Fare clic su [OK].
È possibile visualizzare un’anteprima delle impostazioni nell’area di lavoro.

Uso della timbratura pagina per lavori di stampa ripetitivi

È possibile aggiungere una timbratura pagina incrementale per grandi lavori di stampa ripetitivi dove
sono necessari numeri di timbro pagina univoci.

Per aggiungere una timbratura pagina a grandi lavori di stampa ripetitivi:

1. Andare in File→ Componi lavoro per aggiungere file al lavoro.

2. Nella finestra di dialogo [Componi lavoro], aggiungere i file dal computer o importare i file da
uno scanner.
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• Per aggiungere file dal computer, fare clic su [Aggiungi file], cercare i file da aggiungere
nella finestra di dialogo [Apri], selezionarli e fare clic su [Apri].
Se un file è protetto da password, viene segnalato di immettere la password prima di poter
aggiungere il file al lavoro.

• Per importare i file da uno scanner, selezionare uno scanner compatibile con TWAIN o
l'utilità Fiery Remote Scan dall'elenco di scanner e fare clic su [Scansione].
In base allo scanner selezionato, viene avviata la schermata di configurazione del driver
TWAIN o l'utilità Fiery Remote Scan. Attenersi ai passaggi richiesti dal driver dello scanner e
scegliere le impostazioni necessarie.

3. Immettere il numero di copie richieste per la batch nella colonna [Copie].

Ad esempio, per creare una batch di 100 ticket, immettere 100 nella colonna [Copie].

4. Fare clic sul pulsante [Crea].

5. Nell'area delle impostazioni sulla destra fare clic su [Imposizione].

6. Nel pannello [Imposizione] fare clic su [Combina].

7. Selezionare [Singolo] nella sezione [COMBINA / TAGLIA E IMPILA].

8. Nell'area delle impostazioni sulla destra fare clic su [Contenuto pagina].

9. Nel pannello [Contenuto pagina] fare clic su [Timbratura pagina].
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10. Nel campo [Ripeti], immettere il numero di volte in cui un numero di timbro pagina viene ripetuto
prima del suo incremento.

Il valore [Ripeti] si calcola in base al numero delle pagine idonee in un lavoro.

Ad esempio, se si stampano 100 ticket ed è necessario incrementare il numero del timbro della
pagina a ogni 10° ticket, impostare il valore di [Ripeti] su 10. Il numero del timbro della pagina
si ripete 10 volte prima di incrementarsi e continua fino al raggiungimento di 100 ticket.

11. Fare clic su [OK].
È possibile visualizzare un’anteprima delle impostazioni nell’area di lavoro.

Modifica dei timbri pagina

È possibile modificare un timbro pagina esistente.

Per modificare un timbro pagina:

1. Nell'area delle impostazioni sulla destra fare clic su [Contenuto pagina].

2. Nel pannello [Contenuto pagina] fare clic su [Timbratura pagina].
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3. Nella schermata [Seleziona timbro pagina], passare il mouse sul timbro pagina e fare clic su
, il pulsante [Modifica timbro pagina].

4. Nella schermata [Timbratura pagina], modificare le impostazioni di timbratura pagina come
necessario.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

5. Fare clic su [OK].
È possibile visualizzare un’anteprima delle impostazioni nell’area di lavoro.

Eliminazione dei timbri pagina

È possibile rimuovere i timbri pagina dal lavoro.

Per eliminare un timbro pagina:

1. Nell'area delle impostazioni sulla destra fare clic su [Contenuto pagina].

2. Nel pannello [Contenuto pagina] fare clic su [Timbratura pagina].

3. Nella schermata [Seleziona timbro pagina], passare il mouse sul timbro pagina e fare clic su
, il pulsante [Elimina timbro pagina].

4. Fare clic su [OK].
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AAggggiiuunnttaa ddii ccooppeerrttiinnee
Quando viene stampato, è possibile aggiungere delle copertine a un documento. Inoltre è anche
possibile stampare sulle copertine.

I tipi di copertine che si possono aggiungere dipendono dalle impostazioni di imposizione e finitura
specificate per il lavoro.

Non è possibile aggiungere copertine se l'imposizione è impostata su [Adesiva], [Adesiva doppia] o
[Veloce].

Aggiunta di una copertina anteriore e posteriore a un lavoro

È possibile aggiungere copertine anteriori e posteriori ai lavori con l'imposizione [Normale] o
[Combina].

Per aggiungere le copertine anteriori e posteriori:

1. Verificare che l'imposizione sia impostata su [Normale], [Combina] - [Singolo], o [Combina]
- [Ripeti] nel pannello [Imposizione].

2. Nell'area delle impostazioni sulla destra fare clic su [Copertine].

3. Nel pannello [Copertine], specificare le impostazioni richieste per le copertine anteriori e
posteriori.
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È possibile impostare la carta e il vassoio di alimentazione e specificare se le copertine sono
prestampate o stampate con il contenuto del lavoro. Per dettagli su un'impostazione specifica,
fare clic sul pulsante per visualizzare la guida contestuale su schermo.

Aggiunta di una copertina a un libretto

È possibile aggiungere una copertina libretto a un lavoro con l'imposizione [Libretto] o [Libretto
doppio]. La copertina si avvolge intorno a tutto il lavoro creando la copertina anteriore e posteriore.

Per aggiungere una copertina a un libretto:

1. Verificare che l'imposizione sia impostata su [Libretto] o [Libretto doppio] nel pannello
[Imposizione].

2. Nell'area delle impostazioni sulla destra fare clic su [Copertine].

3. Nel pannello [Copertine], specificare le impostazioni richieste per la copertina libretto.

È possibile impostare la carta e il vassoio di alimentazione e specificare se la copertina è
prestampata o stampata con il contenuto del lavoro. Per dettagli su un'impostazione specifica,
fare clic sul pulsante per visualizzare la guida contestuale su schermo.

Aggiunta di una copertina a una rilegatura adesiva

È possibile aggiungere una copertina a un documento con rilegatura adesiva. La copertina si avvolge
intorno a tutto il lavoro creando la copertina anteriore, il dorso e la copertina posteriore. Inoltre è
anche possibile stampare sulle copertine, progettare le pagine di copertina e configurare il dorso.
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• Le seguenti impostazioni di imposizione non si applicano alla copertina con rilegatura adesiva:

– Impostazione [Manuale] per [Formato finitura]

– [Margini rilegatura]

– [Spostamento immagine]

Per aggiungere una copertina con rilegatura adeviv:

1. Verificare che la stampante impostata per il lavoro supporti la rilegatura adesiva.

Per stampare il contenuto del lavoro sulla copertina, la stampante deve supportare anche la
stampa sulla copertina.

2. Nell'area delle impostazioni sulla destra fare clic su [Finitura].

3. In [Rilegatura], selezionare [Rilegatura adesiva].

4. Nell'area delle impostazioni sulla destra fare clic su [Copertine].

5. Nel pannello [Copertine], specificare le impostazioni richieste per la copertina per rilegatura
adesiva.

È possibile impostare la carta e il vassoio di alimentazione e specificare se la copertina è
prestampata o stampata con il contenuto del lavoro. Se sulla copertina è stampato il contenuto
del lavoro, è anche possibile configurare lo spessore del dorso, il metodo di avvolgimento della
copertina e i valori di offset dorso e spostamento immagine per il contenuto della copertina.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

6. Per progettare la copertina, fare clic su [Strumento di composizione copertina].

È possibile specificare le pagine stampate sulla copertina e sul dorso e impostare la posizione,
l'ordine, il formato e la rotazione della pagina. Per ulteriori informazioni, vedere Creazione della
copertina per rilegatura adesiva, pagina 210.

• [Strumento di composizione copertina] è disponibile solo quando si stampa il contenuto
del lavoro sulla copertina.
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7. Per progettare il dorso, fare clic su [Strumento di composizione dorso].

È possibile aggiungere maschere, testo e immagini e impostare la posizione, l'ordine, il formato e
la rotazione degli oggetti. Per ulteriori informazioni, vedere Modifica del dorso di una copertina
per rilegatura adesiva, pagina 213.

• [Strumento di composizione dorso] è disponibile solo quando si stampa il contenuto del
lavoro all'esterno della copertina.

• Per prima cosa, verificare di creare la copertina in [Strumento di composizione
copertina]. Se si utilizza [Strumento di composizione copertina] dopo aver progettato il
dorso, gli oggetti posizionato sul dorso vengono rimossi.

È possibile impostare le impostazioni di rifilatura per i documenti con rilegatura adesiva nel pannello
[Finitura]. Per ulteriori informazioni, vedere Rifilatura del documento stampato, pagina 176.

Creazione della copertina per rilegatura adesiva

È possibile progettare e creare la copertina per un lavoro con rilegatura adesiva utilizzando
[Strumento di composizione copertina].

Per progettare e creare la copertina con rilegatura adesiva:

1. Nel pannello [Copertine], specificare le impostazioni richieste per la copertina per rilegatura
adesiva.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

2. Verificare di impostare la stampa del contenuto del lavoro sul lato esterno, interno o su entrambi i
lati della copertina.

A seconda dell'opzione di stampa selezionata per la copertina, è possibile modificare la
copertina esterna, la copertina interna o entrambe nella visualizzazione [Strumento di
composizione copertina]. La procedura fornisce i passaggi necessari per la modifica di
entrambe le copertine.

3. Fare clic su [Strumento di composizione copertina].
La visualizzazione [Strumento di composizione copertina] è mostrata nello spazio di lavoro.
Le aree disponibili per le pagine di copertina e il dorso sono contrassegnate sul foglio di
copertina. L'area del dorso può essere modificata solo per la copertina esterna.

• Quando si seleziona un'opzione di stampa della copertina, per impostazione predefinita sul
foglio di copertina viene posizionata la prima o l'ultima pagina del lavoro, a seconda della
stampante. Se il formato della pagina PDF posizionata sul foglio di copertina per
impostazione predefinita è doppio rispetto a quello della carta del lavoro, [Strumento di
composizione copertina] la riconosce come copertina. Per iniziare a progettare una nuova
copertina, è necessario fare prima clic su [Elimina copertina]. Anche le pagine PDF
corrispondenti vengono rimosse dal lavoro.
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4. Fare clic su , il pulsante [Posizione dorso], al fondo dello spazio di lavoro e regolare le
impostazioni configurate per il dorso come necessario.

Le impostazioni del dorso determinano la posizione del dorso sulla copertina e il formato degli
spazi della copertina anteriore e posteriore. Verificare di configurare correttamente queste
impostazioni prima di iniziare la progettazione della copertina.

5. Selezionare la pagina da posizionare sulla copertina nell'elenco pagine e trascinarla su una
delle aree della copertina o sull'area del dorso.

È anche possibile immettere il numero della pagina nel menu [Impostazioni copertina
esterna].

Dopo aver posizionato le pagine sulla copertina, è possibile utilizzare i pulsanti al fondo dello
spazio di lavoro o fare clic con il pulsante destro del mouse sul menu per impostare la posizione,
l'ordine, il formato e la rotazione delle pagine.

• Le pagine posizionate sulla copertina sono le pagine del documento originali e non
includono oggetti inseriti come maschere, testo o immagini. Per includere gli oggetti inseriti
nelle pagine di copertina, è necessario salvare prima gli oggetti nel documento di input
salvando il lavoro come file PDF. Quindi, è possibile utilizzare il file PDF risultante per creare
il lavoro con rilegatura adesiva.
Lo stesso vale per le impostazioni del contenuto delle pagine, ad esempio numeri di pagina,
intestazioni e piè di pagina, timbri pagina o schede su margini al vivo.

6. Per modificare l'ordine delle pagine quando le pagine posizionate sulla copertina si

sovrappongono, selezionare una pagina, fare clic su , il pulsante [Ordine], e selezionare
l'opzione di ordine.

7. Per posizionare una pagina, selezionarla e fare clic su , il pulsante [Allinea].

Selezionare un punto di riferimento per allineare la pagina in base a esso. È possibile inserire
valori di offset nei campi di immissione per spostare la pagina orizzontalmente o verticalmente
rispetto al punto di riferimento selezionato.

È anche possibile fare clic sulla pagina e trascinarla in una nuova posizione.

Aggiunta di copertine



5

212

8. Per ritagliare una pagina, selezionarla e fare clic su , il pulsante [Taglia], e selezionare
un'opzione di ritaglio.

È possibile utilizzare l'opzione [Taglia e adatta] per tagliare la pagina e adattarla all'area
della copertina o del dorso disponibile.

9. Per ridimensionare una pagina, selezionarla e fare clic su , il pulsante [Scala], e
selezionare un'opzione di ridimensionamento.

10. Per ruotare una pagina, selezionarla e fare clic su , il pulsante [Ruota], e selezionare
un'opzione di rotazione.

11. Per centrare una pagina, fare clic con il pulsante destro del mouse e selezionare [Al centro],
quindi [Verticalmente], [Orizzontalmente], [Entrambi] o [Al dorso].
L'opzione [Al dorso] centra la pagina nell'area del dorso.

12. Per rimuovere una pagina, fare clic con il pulsante destro del mouse e selezionare [Rimuovi].

13. Fare clic su , il pulsante [Impostazioni copertina esterna], al fondo dello spazio di lavoro
e fare clic su [Crea copertina].

14. Fare clic su [Elimina pagine origine].
Una volta rimosse le pagine di origine dal lavoro, non è più possibile modificarle. Prima di
eliminare le pagine, verificare che la stampa finale sia corretta stampando una copia di prova.

Per rimuovere la copertina creata, fare clic su [Elimina copertina].

15. Fare clic su [Cambia copertina] e ripetere la procedura per progettare la copertina interna.
Non è possibile stampare nell'area del dorso sulla copertina interna.

16. Fare clic su , il pulsante [Impostazioni copertina interna], al fondo dello spazio di lavoro
e fare clic su [Crea copertina].

17. Fare clic su [Elimina pagine origine].
Una volta rimosse le pagine di origine dal lavoro, non è più possibile modificarle. Prima di
eliminare le pagine, verificare che la stampa finale sia corretta stampando una copia di prova.

Per rimuovere la copertina creata, fare clic su [Elimina copertina].
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Modifica del dorso di una copertina per rilegatura adesiva

È possibile configurare il dorso di una copertina con rilegatura adesiva utilizzando [Strumento di
composizione dorso].

Per modificare il dorso:

1. Nel pannello [Copertine], specificare le impostazioni richieste per la copertina per rilegatura
adesiva.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

2. Verificare di impostare la stampa del contenuto del lavoro sul lato esterno o su entrambi i lati
della copertina.

Se è stato utilizzato [Strumento di composizione copertina] per progettare il foglio di
copertina, verificare anche di aver salvato le modifiche della copertina esterna.

3. Fare clic su [Strumento di composizione dorso].
La visualizzazione [Strumento di composizione dorso] è mostrata nello spazio di lavoro.

L'area disponibile per il dorso è evidenziata. Tutte le pagine del documento posizionate sulla
copertina esterna sono visibili nel visualizzatore.

4. Fare clic su , il pulsante [Posizione dorso], al fondo dello spazio di lavoro e regolare le
impostazioni configurate per il dorso come necessario.

Le impostazioni del dorso determinano la posizione del dorso sulla copertina e il formato degli
spazi della copertina anteriore e posteriore. Verificare di configurare correttamente queste
impostazioni prima di iniziare la progettazione del dorso.

5. Fare clic su , il pulsante [Ruota vista in senso antiorario], o su , il pulsante [Ruota
vista in senso orario], per visualizzare il dorso verticalmente o orizzontalmente nel
visualizzatore.

6. Per aggiungere una maschera, fare clic su , il pulsante [Strumento maschera], sulla barra
degli strumenti, impostare il tipo di maschera e il colore, quindi fare clic sulla pagina e trascinare
il cursore per creare la maschera.
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Per ulteriori informazioni, vedere Aggiunta di una maschera, pagina 127 e Modifica di una
maschera, pagina 127.

7. Per aggiungere testo, fare clic su , il pulsante [Strumento testo], sulla barra degli strumenti,
fare clic sulla pagina per inserire una casella di testo e digitare il testo.

Per ulteriori informazioni, vedere Aggiunta di testo, pagina 136 e Modifica di testo, pagina 136.

8. Per aggiungere un'immagine, fare clic su , il pulsante [Strumento immagine], sulla barra
degli strumenti, quindi fare clic su [Scegli immagine...] e selezionare un'immagine dal browser
dei file.

Per ulteriori informazioni, vedere Aggiunta di un’immagine, pagina 141 e Modifica di
un’immagine, pagina 142.

9. Per incollare un'immagine o testo dagli appunti del sistema, fare clic con il pulsante destro del
mouse e selezionare [Incolla speciale].
Per ulteriori informazioni, vedere Incollare immagini o testo dagli appunti del sistema, pagina
146.

10. Per selezionare maschere, caselle di testo o immagini inserite:

• Per selezionare un singolo oggetto, fare clic sull'oggetto.

• Per selezionare più oggetti, fare clic sulla pagina e trascinare il cursore per creare un'area di
selezione che circonda gli oggetti.

• Per selezionare tutti gli oggetti, fare clic con il pulsante destro del mouse e selezionare
[Seleziona tutto].

• Per selezionare tutti gli oggetti nell'area del dorso, fare clic con il pulsante destro del mouse e
selezionare [Seleziona tutto nell'area del dorso].

11. Per riposizionare un oggetto, selezionarlo e trascinarlo in una nuova posizione o immettere le
coordinate nei campi di immissione [x] e [y] sulla barra degli strumenti.
Il punto di origine (0,0) è al centro del dorso.

12. Per ridimensionare un oggetto, selezionarlo e utilizzare i punti di ancoraggio o immettere i valori
di larghezza e altezza nei campi di immissione [l] e [a] sulla barra degli strumenti.

13. Per copiare, tagliare e incollare un oggetto:

1. Fare clic con il pulsante destro del mouse sull'oggetto e selezionare [Copia] o [Taglia].

2. Fare clic con il pulsante destro del mouse e selezionare [Incolla].
L'oggetto viene incollato al centro del foglio di copertina.

14. Per impostare l'ordine di più oggetti, fare clic con il pulsante destro del mouse su un oggetto e
selezionare [Ordine], quindi [Porta su fronte], [Porta in avanti], [Porta su retro] o [Porta
indietro].

• [Porta su fronte]: porta l'oggetto davanti a tutti gli altri oggetti.

• [Porta in avanti]: porta l'oggetto avanti di un livello.

• [Porta su retro]: porta l'oggetto dietro a tutti gli altri oggetti.

• [Porta indietro]: porta l'oggetto indietro di un livello.
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15. Per centrare un oggetto, fare clic con il pulsante destro del mouse e selezionare [Al centro],
quindi [Verticalmente], [Orizzontalmente], [Entrambi] o [Al dorso].
L'opzione [Al dorso] centra l'oggetto nell'area del dorso.

16. Per ruotare un oggetto, fare clic con il pulsante destro del mouse e selezionare [Ruota 90° in
senso orario] o [Ruota 90° in senso antiorario].

17. Per eliminare un oggetto, fare clic con il pulsante destro del mouse e selezionare o [Elimina].

18. Per creare una sovrapposizione, selezionare gli oggetti da includere nella sovrapposizione, fare
clic con il pulsante destro del mouse e selezionare [Crea sovrapposizione...].
Nella finestra di dialogo [Sovrapposizioni], immettere un nome per la sovrapposizione e fare
clic su [OK]. È possibile utilizzare la sovrapposizione per lavori con le stesse impostazioni di
copertina e dorso.

In questo esempio, sul doso sono state posizionate una casella di testo e un'immagine. Gli oggetti sono
stati ridimensionati e centrati.

AAggggiiuunnttaa ddii ffooggllii ddiivviissoorrii ee ffooggllii ddeessiiggnnaattii
TotalFlow Prep consente di aggiungere fogli divisori e fogli designati all'interno dei propri lavori.

Inserimento di fogli divisori

È possibile proteggere i fogli stampati del lavoro inserendo fogli divisori tra di loro. Inoltre, è possibile
stampare sui fogli divisori.
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• Non è possibile inserire fogli divisori se il lavoro ha l'imposizione [Libretto] o [Combina] -
[Veloce].

• Le impostazioni dei fogli divisori non sono visualizzate nell’elenco delle pagine o nello spazio di
lavoro.

• Se un lavoro con fogli divisori viene salvato come file PDF con la funzione Salva con nome, i fogli
divisori non vengono salvati nel file PDF.

• Se il formato carta dei fogli divisori differisce dal formato carta del lavoro, non è possibile
configurare le impostazioni di finitura.

Per inserire fogli divisori:

1. Nell'area delle impostazioni sulla destra fare clic su [Fogli].

2. Nella sezione [Fogli separatori], specificare le impostazioni del foglio divisore richieste per il
lavoro.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.
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Inserimento dei fogli designati nelle interruzioni di capitolo

È possibile inserire fogli designati tra i capitoli creati all'interno di un lavoro. È anche possibile stampare
sui fogli designati.

• Non è possibile inserire fogli designati se il lavoro ha l'imposizione [Libretto] o [Combina] -
[Veloce].

• È possibile inserire fogli designati solo se il lavoro ha almeno un capitolo.

Per inserire fogli designati:

1. Nell'area delle impostazioni sulla destra fare clic su [Fogli].

2. Nella sezione [Fogli designati], specificare le impostazioni del foglio designato richieste per il
lavoro.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.
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Per maggiori informazioni sulla creazione di capitoli, consultare Creazione di capitoli, pagina 111.

SSppeecciiffiiccaazziioonnee ddeellllee iimmppoossttaazziioonnii ccoolloorree
È possibile specificare se il lavoro viene stampato in bianco e nero o in quadricromia.

Le opzioni disponibili per l’impostazione del colore dipendono dalla stampante selezionata per il
lavoro.

Per specificare le impostazioni colore per un lavoro:

1. Fare clic sul , il pulsante [Colore/Bianco e nero], sulla barra degli strumenti.

2. Selezionare una delle opzioni colore disponibili:

• [Bianco e nero]: il lavoro viene stampato in bianco e nero.

• [Quadricromia]: il lavoro viene stampato in quadricromia.

Quando si passa a una stampante a colori, l'impostazione [Colore/Bianco e nero] cambia
automaticamente in [Quadricromia].

È anche possibile specificare le impostazioni colore per fogli singoli. Per maggiori informazioni sulle
eccezioni colore, consultare Specificazione delle eccezioni colore, pagina 223.
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SSppeecciiffiiccaazziioonnee ddeell nnuummeerroo ddii ccooppiiee ddaa ssttaammppaarree
È possibile specificare il numero di copie da stampare.

Per specificare il numero di copie:

1. Fare clic all'interno del campo [Copie:] nella barra degli strumenti.

2. Immettere un valore da 1 a 9999.

Vedere la documentazione della stampante per maggiori informazioni sul numero massimo di
copie supportate.

È anche possibile utilizzare i pulsanti [Aumenta] e [Diminuisci] per modificare il numero di
copie.

SSppeecciiffiiccaazziioonnee ddeellllee iimmppoossttaazziioonnii ddii eecccceezziioonnee
È possibile applicare impostazioni separate per fogli o pagine specifici nel lavoro. Ad esempio, alcune
pagine del documento possono essere impostate per la stampa su carta blu e su un solo lato.

Queste impostazioni possono essere applicate come eccezioni:

• Carta

• Lato di stampa

• Colore/Bianco e nero

• Pinzatura

• L’icona eccezione viene visualizzata per i fogli o le pagine a cui è stata applicata
un’impostazione eccezione.

• Non è possibile impostare eccezioni carta e lato di stampa per lavori con l'imposizione [Libretto] o
[Combina] - [Veloce].

• Non è possibile impostare eccezioni di pinzatura per lavori con l'imposizione [Libretto] o
[Combina].

• Non è possibile impostare eccezioni carta, lato di stampa o pinzatura per fogli designati, copertine
o schede.
Se alla pagina sono state applicate eccezioni carta, lato di stampa o pinzatura, non è possibile
impostare il contenuto della pagina per la stampa come copertina, foglio designato o scheda.

• Non è possibile impostare eccezioni per gli inserti.

Specificazione del numero di copie da stampare
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Specificazione delle eccezioni carta

È possibile specificare diverse impostazioni carta per pagine specifiche nel lavoro.

1. Selezionare le pagine di destinazione nell'elenco delle pagine o i fogli di destinazione in [Vista
foglio].

Se vengono impostate più pagine per la stampa su un foglio e si applica un'eccezione carta solo
ad alcune delle pagine, le pagine con l'eccezione vengono posizionate su un foglio separato. È
possibile visualizzare il risultato nell'area dello spazio di lavoro.

2. Fare clic con il pulsante destro del mouse sulla selezione, quindi fare clic su Carta→ Seleziona
carta....

3. Nella schermata [Selezione carta], specificare la carta da utilizzare.

• Per applicare una carta attualmente caricata in un vassoio della stampante, selezionare la
carta dall'elenco [Carta caricata] e fare clic su [OK].
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• Per applicare una carta del catalogo carta della stampante o una carta personalizzata
registrata, selezionare la carta dall'elenco [Catalogo completo] e fare clic su [OK].

Per creare una nuova carta personalizzata e aggiungerla all'elenco [Catalogo completo],
fare clic sul pulsante [+Aggiungi carta]. Per ulteriori informazioni, vedere Aggiunta di carta
personalizzata, pagina 77.

• Per applicare una carta utilizzata di recente, selezionare la carta dall'elenco [Selezioni
recenti] e fare clic su [OK].

• Per specificare manualmente le proprietà della carta, fare clic sul pulsante [Carta
personalizzata], impostare le proprietà nella schermata [Carta personalizzata] e fare clic
su [Applica].

Per dettagli sulle proprietà disponibili, fare clic sul pulsante per visualizzare la guida di
campo su schermo.

• Accertarsi che anche sulla stampante sia disponibile una carta con le stesse proprietà. Per
informazioni relative alle impostazioni carta della stampante, consultare la documentazione
della stampante.

• Selezionare l'opzione [Usa valori predefiniti] o lasciare il campo vuoto per le proprietà
carta che non si desidera inviare alla stampante.

Per rimuovere l'eccezione carta e applicare nuovamente la carta del lavoro, selezionare le pagine o i
fogli, fare clic con il pulsante destro del mouse sulla selezione, quindi fare clic su Carta→ Ripristina
carta lavoro.

Specificazione delle eccezioni carta mediante selezione di un vassoio

È anche possibile specificare diverse impostazioni carta per pagine specifiche selezionando il vassoio
in cui è caricata la carta.

1. Selezionare le pagine di destinazione nell'elenco delle pagine o i fogli di destinazione in [Vista
foglio].
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Se vengono impostate più pagine per la stampa su un foglio e si applica un'eccezione carta solo
ad alcune delle pagine, le pagine con l'eccezione vengono posizionate su un foglio separato. È
possibile visualizzare il risultato nell'area dello spazio di lavoro.

2. Fare clic con il pulsante destro del mouse sulla selezione, quindi fare clic su Carta→ Seleziona
vassoio....

3. Nella schermata [Vassoio carta], selezionare il vassoio in cui è caricata la carta e fare clic su
[OK].

Per rimuovere l'eccezione carta e applicare nuovamente la carta del lavoro, selezionare le pagine o i
fogli, fare clic con il pulsante destro del mouse sulla selezione, quindi fare clic su Carta→ Ripristina
carta lavoro.

Specificazione delle eccezioni del lato di stampa

È possibile applicare diverse impostazioni lato stampa per pagine specifiche nel lavoro.

Per specificare le eccezioni lato stampa:

5 Modifica dei lavori
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1. Selezionare le pagine di destinazione nell'elenco delle pagine o i fogli di destinazione in [Vista
foglio].

Se vengono impostate più pagine per la stampa su un foglio e si applica un'eccezione lato
stampa solo ad alcune delle pagine, le pagine non selezionate vengono posizionate su un foglio
separato. È possibile visualizzare il risultato nell'area dello spazio di lavoro.

2. Fare clic con il tasto destro del mouse sulla selezione, quindi fare clic su [Lato di stampa] e
selezionare [Lato anteriore (1 facciata)] o [Entrambi i lati (2 facciate)].

Per rimuovere l'eccezione lato stampa, selezionare le pagine o i fogli, fare clic con il tasto destro del
mouse sulla selezione, quindi fare clic su Lato di stampa→ Ripristina impostazioni lavoro.

Specificazione delle eccezioni colore

È possibile applicare diverse impostazioni colore per pagine o fogli specifici nel lavoro.

Per specificare le eccezioni colore:

1. Selezionare le pagine di destinazione nell'elenco delle pagine o i fogli di destinazione in [Vista
foglio].

2. Fare clic con il tasto destro del mouse sulla selezione, quindi fare clic su [Colore/Bianco e
nero] e selezionare [Colore] o [Bianco e nero].

Specificazione delle impostazioni di eccezione
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Per rimuovere l'eccezione colore, selezionare le pagine o i fogli, fare clic con il tasto destro del mouse
sulla selezione, quindi fare clic su Colore/Bianco e nero→ Ripristina impostazioni lavoro.

Specificazione delle eccezioni di pinzatura

È possibile applicare le impostazioni di pinzatura solo a intervalli specifici di fogli, in modo che venga
pinzata solo parte del lavoro.

Per specificare le eccezioni di pinzatura:

1. Selezionare un intervallo di pagine nell'elenco delle pagine o un intervallo di fogli in [Vista
foglio].

2. Fare clic con il pulsante destro del mouse sulla selezione, quindi fare clic su Finitura
sottoinsieme...→ Imposta sottoinsieme....

3. Nella finestra di dialogo [Finitura sottoinsieme], selezionare un'opzione di pinzatura
dall'elenco [Pinzatura] e fare clic su [OK].

5 Modifica dei lavori
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Le icone dei sottoinsiemi e segnano l'inizio e la fine del sottoinsieme pinzatura.

• Vengono visualizzate solo le opzioni di pinzatura che sono disponibili sulla stampante.

• Su alcune stampanti non è possibile configurare la pinzatura come impostazione eccezione.
Inoltre, anche se è possibile impostare eccezioni di pinzatura, quando vengono stampate più
copie, l'ordine di uscita dei documenti potrebbe risultare diverso dal previsto. Questo accade
perché ogni sottoinsieme di pinzatura viene elaborato come lavoro separato.

• È possibile inviare un lavoro che contiene più sottoinsiemi di pinzatura con diverse opzioni di
pinzatura alle stampanti con un controller EFI Fiery. Tuttavia, quando viene elaborato il
lavoro, viene applicato solo il primo sottoinsieme di pinzatura e ogni sottoinsieme aggiuntivo
con la medesima opzione di pinzatura.

• Se si incollano o spostano pagine all'interno di un sottoinsieme di pinzatura, le pagine
vengono aggiunte al sottoinsieme.

• Se si copiano o tagliano come gruppo solo le pagine di un sottoinsieme di pinzatura e si
incollano in una nuova posizione, viene mantenuta l'impostazione del sottoinsieme di
pinzatura.

• Se si muovono come gruppo solo le pagine di un sottoinsieme di pinzatura, viene mantenuta
l'impostazione del sottoinsieme di pinzatura.

Per rimuovere l'eccezione di pinzatura, selezionare le pagine o i fogli, fare clic con il tasto destro del
mouse sulla selezione, quindi fare clic su Finitura sottoinsieme...→ Ripristina impostazioni lavoro.

MMooddiiffiiccaa ddii llaavvoorrii nneellllaa vveerrssiioonnee bbrroowwsseerr ddii TToottaallFFllooww PPrreepp
È possibile avviare la versione browser di TotalFlow Prep da TotalFlow Production Manager o
TotalFlow Print Server. Al termine della modifica del lavoro, è possibile salvarlo e inviarlo nuovamente
a TotalFlow Production Manager o TotalFlow Print Server.

• Alcune funzioni di TotalFlow Prep non sono disponibili nella versione browser.

• TotalFlow Production Manager deve essere installato sullo stesso computer di TotalFlow Prep.

• Quando si modifica un lavoro da TotalFlow Production Manager, alcune impostazioni vengono
applicate al file PDF e non si riflettono nel ticket lavoro JDF. Ad esempio, se vengono imposte
quattro pagine su un foglio, viene creato un file PDF 4-Up e 1-Up viene specificato nel ticket JDF.
Quindi, quando si visualizza il lavoro in TotalFlow Production Manager o quando si modifica
nuovamente il lavoro nella versione browser di TotalFlow Prep, le impostazioni vengono
visualizzate nel file PDF ma non nelle proprietà del lavoro.

Modifica di lavori nella versione browser di TotalFlow Prep
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Per modificare e salvare un lavoro nella versione browser di TotalFlow Prep:

1. Accertarsi che TotalFlow Production Manager o TotalFlow Print Server siano configurati per l'uso
della versione browser di TotalFlow Prep per la modifica dei lavori.

Per ulteriori informazioni, consultare la documentazione per TotalFlow Production Manager o
TotalFlow Print Server.

2. In TotalFlow Production Manager o TotalFlow Print Server, trovare il lavoro da modificare e
aprirlo nella versione browser di TotalFlow Prep.

Per ulteriori informazioni, consultare la documentazione per TotalFlow Production Manager o
TotalFlow Print Server.

3. Modificare il lavoro.

Per ulteriori informazioni sulla modifica delle impostazioni lavoro, consultare Modifica dei lavori,
pagina 95.

4. Salvare le modifiche apportate al lavoro e inviare nuovamente il lavoro a TotalFlow Production
Manager o TotalFlow Print Server:

• Se si sta modificando un lavoro da TotalFlow Production Manager, fare clic su [File] e
selezionare una delle seguenti opzioni:

– [Salva e continua]: salva le modifiche apportate al lavoro e invia nuovamente il lavoro
a TotalFlow Production Manager per continuare l'elaborazione.

– [Salva e sospendi]: salva le modifiche apportate al lavoro e arresta il lavoro nell'attività
corrente del flusso di lavoro. È possibile modificare nuovamente il lavoro in seguito o
specificare in TotalFlow Production Manager quando continuare l'elaborazione.

– [Salva come PDF e continua]: salva le modifiche apportate al lavoro e invia
nuovamente il lavoro a TotalFlow Production Manager per continuare l'elaborazione. Per
garantire la corretta elaborazione, alcune impostazioni lavoro vengono rimosse dal ticket
lavoro e applicate al file PDF. Quando il lavoro viene visualizzato in TotalFlow
Production Manager, queste impostazioni vengono visualizzate nel file PDF ma non nelle
proprietà del lavoro.

– [Salva come PDF e sospendi]: salva le modifiche apportate al lavoro e arresta il lavoro
nell'attività corrente del flusso di lavoro. È possibile modificare nuovamente il lavoro in
seguito o specificare in TotalFlow Production Manager quando continuare
l'elaborazione. Per garantire la corretta elaborazione, alcune impostazioni lavoro
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vengono rimosse dal ticket lavoro e applicate al file PDF. Se il lavoro viene modificato
nuovamente in TotalFlow Prep, queste impostazioni vengono visualizzate nel file PDF ma
non nelle proprietà del lavoro.

• Se si modifica un lavoro dal TotalFlow Print Server, fare clic su File→ Salva e esci.

RRiissoolluuzziioonnee ddeeii ccoonnfflliittttii ddeellll’’iimmppoossttaazziioonnee ddeell llaavvoorroo
Quando si specifica un'impostazione lavoro che non è compatibile con le impostazioni correnti, viene
visualizzata una finestra di dialogo di avviso. La finestra di dialogo elenca le opzioni in conflitto e
fornisce informazioni su come risolvere il problema.

In alcuni casi viene segnalato di cambiare manualmente le impostazioni correnti prima di poter
applicare l'impostazione che ha provocato il conflitto. Ad esempio, se il lavoro è impostato per aprirsi
verso sinistra e si desidera specificare le impostazioni di pinzatura per il bordo superiore, la finestra di
dialogo di avviso informa che è necessario cambiare prima la direzione di apertura e quindi
riapplicare l'impostazione di pinzatura.

In altri casi, è possibile specificare se si desidera applicare l'impostazione in conflitto e regolare
automaticamente le impostazioni del lavoro corrente o non considerare l'ultima modifica e mantenere
così come sono le impostazioni correnti. Ad esempio, se si specifica un'opzione di perforazione per un
lavoro a cui è già stata applicata la pinzatura, la finestra di dialogo di avviso consente di specificare
quelle delle due impostazioni di finitura si desidera applicare.

Risoluzione dei conflitti dell’impostazione del lavoro
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66.. Stampa e salvataggio lavori

•Anteprima lavori
•Invio di lavori a una stampante
•Invio di lavori a TotalFlow Production Manager
•Stampa di pagine selezionate
•Stampa di intervalli di pagine
•Stampa di un lavoro con fogli a colori e in bianco e nero su stampanti separate
•Salvataggio di lavori
•Controllare l'andamento e i risultati del lavoro

Dopo aver modificato i lavori e specificato tutte le impostazioni richieste, è possibile inviare i lavori alla
stampante, quindi verificarne l’avanzamento e i risultati. È anche possibile salvare i lavori per utilizzarli
in seguito.

• Verificare che il computer e la stampante da utilizzare siano collegati correttamente alla rete. Per
maggiori informazioni, consultare la documentazione della propria stampante.

• Per stampare lavori tramite TotalFlow Production Manager, è necessario prima impostare TotalFlow
Production Manager e verificare che sia collegato alla rete. Per ulteriori informazioni, consultare la
documentazione di TotalFlow Production Manager.

• È anche possibile elaborare i lavori e inviarli automaticamente a una stampante usando hot folder.
Per ulteriori informazioni, vedere Utilizzo di hot folder con impostazioni predefinite, pagina 250.

AAnntteepprriimmaa llaavvoorrii
Prima di stampare un lavoro, è possibile visualizzare l'anteprima di output in [Vista reader]. [Vista
reader] consente di sfogliare le pagine del lavoro e visualizzare l'anteprima delle impostazioni del
lavoro per verificarne la correttezza.

Per visualizzare l'anteprima di un lavoro:

1. Fare clic sul , il pulsante [Vista reader], nell'angolo destro dello spazio di lavoro.
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2. Usare le funzioni disponibili in [Vista reader] per navigare nel lavoro e verificare l'output:

• Fare clic sul bordo esterno delle pagine.

• Utilizzare , il pulsante [Pagina precedente], e , il pulsante [Pagina successiva].

• Passare il mouse sul numero di pagina corrente e digitare il numero di pagina che si desidera
visualizzare.

• Selezionare una pagina nell'elenco delle pagine.

• Fare clic su , l'icona [Segnalibri], e selezionare [Inizio], un nome capitolo o [Fine] per
passare alla prima pagina, a un capitolo specifico o all'ultima pagina.

Il prodotto finale effettivo potrebbe differire dai risultati visualizzati nell'anteprima a seconda
della stampante, delle impostazioni carta e delle impostazioni di finitura.

IInnvviioo ddii llaavvoorrii aa uunnaa ssttaammppaannttee
Per inviare un lavoro a una stampante:

1. Assicurarsi che la stampante che si desidera utilizzare sia selezionata nel menu delle stampanti.

Per ulteriori informazioni, vedere Specificazione di una stampante per il lavoro, pagina 95.

2. Fare clic su , il pulsante [Stampa].

È anche possibile fare clic su File→ Stampa sulla barra dei menu per stampare i lavori.

Se è presente un problema con la stampante o con le impostazioni del lavoro, il pulsante

[Stampa] diventa rosso ( ). Quando si fa clic sul pulsante, si riceve un messaggio di
errore contenente maggiori dettagli sul problema.

Nella versione browser di TotalFlow Prep, non è disponibile la funzione di stampa. Al termine della
modifica di un lavoro, è possibile salvarlo e inviarlo nuovamente a TotalFlow Production Manager o
TotalFlow Print Server. Per ulteriori informazioni, vedere Modifica di lavori nella versione browser di
TotalFlow Prep, pagina 225.

IInnvviioo ddii llaavvoorrii aa TToottaallFFllooww PPrroodduuccttiioonn MMaannaaggeerr
Per inviare un lavoro a un flusso di lavoro definito in TotalFlow Production Manager:

1. Assicurarsi che il flusso di lavoro da utilizzare sia selezionato nel menu delle stampanti.

6 Stampa e salvataggio lavori
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Per ulteriori informazioni, vedere Specificazione di una stampante per il lavoro, pagina 95.

2. OOppzziioonnaallee:: Nell'area delle impostazioni a destra, fare clic su [Impostazione lavoro] e
selezionare un'opzione per la modalità di stampa dall'elenco [Modalità di stampa].
Ad esempio, è possibile selezionare [Stampa sospesa] per ritardare la stampa di un lavoro
dopo averlo inviato a TotalFlow Production Manager.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

3. Fare clic su , il pulsante [Stampa].

È anche possibile fare clic su File→ Stampa sulla barra dei menu per stampare i lavori.

Se è presente un problema con la stampante o con le impostazioni del lavoro, il pulsante

[Stampa] diventa rosso ( ). Quando si fa clic sul pulsante, si riceve un messaggio di
errore contenente maggiori dettagli sul problema.

Nella versione browser di TotalFlow Prep, non è disponibile la funzione di stampa. Al termine della
modifica di un lavoro, è possibile salvarlo e inviarlo nuovamente a TotalFlow Production Manager o
TotalFlow Print Server. Per ulteriori informazioni, vedere Modifica di lavori nella versione browser di
TotalFlow Prep, pagina 225.

SSttaammppaa ddii ppaaggiinnee sseelleezziioonnaattee
È possibile scegliere di stampare solo le pagine selezionate da un lavoro.

• Questa opzione è disponibile quando l'imposizione è impostata su [Normale] o [Combina] -
[Singolo].

• Se la stampante di destinazione non supporta la stampa di pagine selezionate o di intervalli di
pagine, questa funzione non è disponibile. Per informazioni sulle funzioni supportate, consultare la
documentazione della stampante.

Per stampare le pagine selezionate:

1. Assicurarsi che la stampante che si desidera utilizzare sia selezionata nel menu delle stampanti.

Per ulteriori informazioni, vedere Specificazione di una stampante per il lavoro, pagina 95.

2. Selezionare le pagine di destinazione nell'elenco delle pagine o i fogli di destinazione in [Vista
foglio].
Per ulteriori informazioni, vedere Selezione di pagine e fogli, pagina 97.

Stampa di pagine selezionate
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Se la selezione include fogli prestampati, ad esempio copertine prestampate, fogli di
designazione prestampati o schede inserite, potrebbero essere stampate anche le pagine prima
e dopo le pagine selezionate.

3. Nella barra dei menu, fare clic su File→ Stampa selezionato.

Nella versione browser di TotalFlow Prep, non è disponibile la funzione di stampa. Al termine della
modifica di un lavoro, è possibile salvarlo e inviarlo nuovamente a TotalFlow Production Manager o
TotalFlow Print Server. Per ulteriori informazioni, vedere Modifica di lavori nella versione browser di
TotalFlow Prep, pagina 225.

SSttaammppaa ddii iinntteerrvvaallllii ddii ppaaggiinnee
È possibile scegliere di stampare solo un intervallo di pagine da un lavoro.

• Questa opzione è disponibile quando l'imposizione è impostata su [Normale] o [Combina] -
[Singolo].

• Se la stampante di destinazione non supporta la stampa di pagine selezionate o di intervalli di
pagine, questa funzione non è disponibile. Per informazioni sulle funzioni supportate, consultare la
documentazione della stampante.

Per stampare un intervallo di pagine:

1. Assicurarsi che la stampante che si desidera utilizzare sia selezionata nel menu delle stampanti.

Per ulteriori informazioni, vedere Specificazione di una stampante per il lavoro, pagina 95.

2. Nella barra dei menu, fare clic su File→ Stampa intervallo.

3. Nella finestra di dialogo [Stampa intervallo], immettere le pagine o gli intervalli di pagine da
stampare.
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È possibile inserire più pagine o intervalli di pagine separati da virgole, ad esempio 1-7, 9, 11-
n, dove n è l'ultima pagina nel lavoro. Assicurarsi di inserire le pagine e gli intervalli di pagine in
ordine crescente.

Nella versione browser di TotalFlow Prep, non è disponibile la funzione di stampa. Al termine della
modifica di un lavoro, è possibile salvarlo e inviarlo nuovamente a TotalFlow Production Manager o
TotalFlow Print Server. Per ulteriori informazioni, vedere Modifica di lavori nella versione browser di
TotalFlow Prep, pagina 225.

SSttaammppaa ddii uunn llaavvoorroo ccoonn ffooggllii aa ccoolloorrii ee iinn bbiiaannccoo ee nneerroo ssuu
ssttaammppaannttii sseeppaarraattee
Per ridurre i costi, invece di stampare tutti i fogli su una stampante a colori, è possibile stampare i fogli a
colori su una stampante a colori e utilizzarli come inserti su una stampante in bianco e nero.

Per stampare un lavoro con fogli a colori e in bianco e nero su stampanti separate:

1. Registrare una stampante a colori e una stampante in bianco e nero.

La stampante in bianco e nero deve avere un vassoio introduttore.
Per ulteriori informazioni sull’aggiunta di stampanti, vedere Registrazione delle stampanti, pagina
63.

2. Nella barra dei menu, fare clic sul menu delle stampanti e selezionare la stampante a colori
dall’elenco.

3. Verificare che l’imposizione sia impostata su [Normale] o [Combina] - [Singolo] nel pannello
[Imposizione].

4. Per selezionare tutti i fogli a colori dal lavoro, fare clic con il pulsante destro del mouse su un
foglio qualsiasi e fare clic su Seleziona→ Fogli a colori.

• Un foglio con qualsiasi oggetto colore è considerato un foglio a colori.

• Un foglio con almeno una pagina a colori è considerato un foglio a colori.

5. Nella barra dei menu, fare clic su File→ Stampa selezionato.

6. Caricare il foglio a colori stampato in un vassoio introduttore sulla stampante in bianco e nero.

7. In TotalFlow Prep, fare clic sul menu delle stampanti e selezionare la stampante in bianco e nero
dall’elenco.

8. Fare clic con il pulsante destro del mouse su un foglio e fare clic su Seleziona→ Fogli a colori.

9. Fare clic con il pulsante destro del mouse sulla selezione, quindi fare clic su Carta→ Seleziona
vassoio....

Stampa di un lavoro con fogli a colori e in bianco e nero su stampanti separate
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10. Nella finestra di dialogo [Vassoio carta], selezionare il vassoio introduttore in cui sono caricati i
fogli a colori e fare clic su [OK].

11. Fare clic su , il pulsante [Stampa].

SSaallvvaattaaggggiioo ddii llaavvoorrii
È possibile salvare i lavori come file RJF, JDF o PDF per utilizzarli in seguito.

Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

Per salvare un lavoro:

1. Nel menu [File], selezionare [Salva con nome].
Se è la prima volta in cui si salva un lavoro, è possibile usare l'opzione [Salva].

2. Nella finestra di dialogo [Salva un file], seguire questi passaggi:

1. Cercare la cartella in cui si desidera salvare il lavoro e aprirla.

2. Digitare un nome per il lavoro nel campo [Nome file].

3. Selezionare un formato dall'elenco [Salva come tipo]:

[Ricoh Job Format (*.rjf)]
Il formato RJF è un formato file lavoro specifico di TotalFlow Prep. I file RJF sono file PDF
contenti informazioni integrate sulle impostazioni, per esempio impostazioni di finitura e
di stampa.

È possibile inserire una password per il lavoro nel campo [Password]. Immettere
caratteri alfanumerici, fino a 32 byte. La password distingue tra maiuscole e minuscole.

[Portable Document Format (*.pdf)]
Questa opzione salva il lavoro come un unico file PDF con le modifiche incluse. Non
vengono salvate informazioni relative a impostazioni di finitura, inserimento di fogli
divisori, numero di copie e vassoio di uscita.
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È possibile inserire una password per il lavoro nel campo [Password]. Immettere
caratteri alfanumerici, fino a 32 byte. La password distingue tra maiuscole e minuscole.

Le pagine con formato originale Image PDF possono essere compresse e salvate in
formato JPEG. Specificare il livello di compressione selezionando una delle opzioni
disponibili nell'elenco [Tasso di compressione]:

[Basso (priorità qualità)]
Questo livello assegna la priorità alla qualità rispetto alla riduzione delle dimensioni
del file.

[Medio]
Questo livello è intermedio. I file sono compressi ma la qualità immagine resta
accettabile.

[Alto (priorità dimensione)]
Questo livello assegna la priorità alla riduzione della dimensione del file rispetto alla
qualità.

Perché la compressione dati funzioni correttamente, verificare che i file immagine non
superino dimensione massima, risoluzione o conteggio pixel specificato in Formati e
dimensioni immagine supportati, pagina 266.

[Job Description Format (*.jdf)]
Quando si salva un lavoro in formato JDF, viene creata una cartella e i file PDF collegati
al file JDF saranno salvati nella cartella. Il nome della cartella creata è Nome file JDF_
mrjob. Ad esempio, se il nome file JDF è ABCD.jdf, i file PDF vengono salvati nella
cartella ABCD_mrjob.

• Non è possibile eliminare o modificare testo, immagine e oggetti maschera inseriti
per i lavori salvati in formato JDF.

• I file JDF creati possono essere utilizzati solo con le applicazioni TotalFlow.

4. Fare clic sul pulsante [Salva].

Dopo aver salvato un lavoro come file RJF o JDF, è possibile salvare le eventuali modifiche aggiuntive
facendo clic su [Salva] nel menu [File].

CCoonnttrroollllaarree ll''aannddaammeennttoo ee ii rriissuullttaattii ddeell llaavvoorroo
È possibile utilizzare il pannello [Avvisi] per gestire lavori e controllare i loro progressi e risultati.

Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

Controllare l'andamento e i risultati del lavoro
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Visualizzazione e gestione dei lavori attivi

È possibile gestire lavori correnti e verificare i loro progressi dalla scheda [Attivo] del pannello
[Avvisi].

Per visualizzare e gestire i lavori attivi:

1. Nella barra dei menu, fare clic su , il pulsante [Avvisi].

Se sono presenti nuove notifiche dall'ultima volta che è stato aperto il pannello [Avvisi], viene

visualizzata un'icona blu accanto al pulsante [Avvisi] ( ). Se sono presenti eventuali nuovi

errori, l’icona è rossa ( ). Se l’elaborazione del lavoro viene sospesa per tutti i lavori correnti

e futuri, l'icona è arancione ( ). Se non sono presenti nuove notifiche, il pulsante [Avvisi] è di
colore grigio.

2. Nel pannello [Avvisi], fare clic sulla scheda [Attivo].

Nella scheda [Attivo], è possibile controllare e gestire lavori che sono ancora in elaborazione.

I lavori la cui elaborazione è terminata o che sono stati annullati vengono visualizzati nella
scheda [Registrato]. Per ulteriori informazioni, vedere Visualizzazione e gestione dei lavori
registrati, pagina 238. I lavori che sono in stato di errore vengono visualizzati sia nella scheda
[Attivo] sia nella scheda [Registrato].

3. Consultare le informazioni visualizzate nell’elenco dei lavori per controllare lo stato dei lavori
attivi e visualizzare più dettagli relativi all’elaborazione del lavoro.

• L’icona di stato mostra lo stato corrente di ogni lavoro:
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Il lavoro è in attesa di elaborazione.

Il lavoro è in attesa di stampa.

Il lavoro è in elaborazione o in stampa.

Il lavoro è stato sospeso.

Si è verificato un errore nel lavoro.

• L’icona visualizzata prima del nome del lavoro mostra se il lavoro è stato inviato
dall’interfaccia utente TotalFlow Prep o attraverso una hot folder:

Il lavoro è stato inviato dall’interfaccia utente.

Il lavoro è stato inviato attraverso una hot folder.

Sotto al nome del lavoro, è possibile vedere un messaggio di stato. Passare il mouse sul
nome del lavoro per maggiori dettagli sul lavoro.

• Sulla destra del nome del lavoro, è possibile vedere quando il lavoro è stato inviato.

4. Utilizzare le opzioni disponibili per eseguire azioni su tutti i lavori o su uno specifico lavoro
nell’elenco.

Le azioni disponibili dipendono dalla fase di elaborazione del lavoro.

• Per arrestare temporaneamente tutti i lavori, fare clic su [Altre azioni] e abilitare l'opzione
[Sospendi tutti].

L’elaborazione del lavoro viene sospesa per tutti i lavori correnti e futuri.

• Per riprendere tutti i lavori sospesi, fare clic su [Altre azioni] e disabilitare l'opzione
[Sospendi tutti].

L’elaborazione del lavoro riprende per tutti i lavori correnti e futuri.

• Per annullare tutti i lavori e rimuoverli dall'elenco [Attivo], fare clic sul pulsante [Altre
azioni] e selezionare [Annulla tutti].

• Per aprire e modificare un lavoro che si trova nello stato [In attesa di modifica manuale],
fare clic sul nome del lavoro.

Dopo aver finito la modifica del lavoro, fare clic sul pulsante [Stampa] per inviare il lavoro
alla stampante.

• Per arrestare temporaneamente un lavoro specifico, passare il mouse sul lavoro e fare clic su
, il pulsante [Sospendi].

• Per riprendere un lavoro sospeso o un lavoro che è stato arrestato a causa di un errore,
passare il mouse sul lavoro e fare clic su , il pulsante [Riprendi].

Utilizzando questa funzione non è possibile riprendere lavori in cui si è verificato un errore
irreversibile. Per riprendere un lavoro di questo tipo, annullarlo e quindi riaprirlo. Accertarsi
che il contenuto del lavoro sia corretto, quindi riprovare.

Controllare l'andamento e i risultati del lavoro
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• Per annullare un lavoro specifico e rimuoverlo dall'elenco [Attivo], passare il mouse sul
lavoro e fare clic su , il pulsante [Annulla].

• È possibile solo sospendere lavori che non sono ancora stati inviati alla stampante.

• Quando si annulla un lavoro nello stato [Preparazione della stampa in corso], [In attesa
alla stampante] o [Stampa], TotalFlow Prep tenta di arrestare ogni ulteriore elaborazione
del lavoro. A volte, a seconda della stampante e della fase di elaborazione del lavoro,
l’elaborazione continua al di fuori di TotalFlow Prep e il lavoro non può essere annullato.

Visualizzazione e gestione dei lavori registrati

È possibile verificare i risultati dei lavori dalla scheda [Registrato] del pannello [Avvisi].

Per visualizzare e gestire i lavori registrati:

1. Nella barra dei menu, fare clic su , il pulsante [Avvisi].

2. Nel pannello [Avvisi], fare clic sulla scheda [Registrato].

6 Stampa e salvataggio lavori
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Nella scheda [Registrato], è possibile gestire lavori la cui elaborazione è terminata o che sono
stati annullati. I lavori che sono ancora in fase di elaborazione vengono visualizzati nella scheda
[Attivo]. Vedere Visualizzazione e gestione dei lavori attivi, pagina 236 per maggiori
informazioni. I lavori che sono in stato di errore vengono visualizzati sia nella scheda [Attivo]
sia nella scheda [Registrato].

3. Consultare le informazioni visualizzate nell’elenco dei lavori per controllare lo stato dei lavori
registrati.

• Le icone di stato mostrano lo stato di ogni lavoro:

Il lavoro è stato completato.

Il lavoro è stato annullato.

Si è verificato un errore nel lavoro.

Sotto l’icona di stato, è possibile vedere il nome della stampante specificata per il lavoro.

• L’icona visualizzata prima del nome del lavoro mostra se il lavoro è stato inviato
dall’interfaccia utente TotalFlow Prep o attraverso una hot folder:

Il lavoro è stato inviato dall’interfaccia utente.

Il lavoro è stato inviato attraverso una hot folder.

Sotto al nome del lavoro, è possibile vedere un messaggio di stato. Passare il mouse sul
nome del lavoro per maggiori dettagli sul lavoro.

• Sulla destra del nome del lavoro, è possibile vedere quando il lavoro è stato inviato.

4. OOppzziioonnaallee:: Per rimuovere tutti i lavori dal registro, fare clic su [Cancella].

I registri vengono conservati per 90 giorni.

Controllare l'andamento e i risultati del lavoro
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77.. Lavorare con le impostazioni predefinite

•Creare delle impostazioni predefinite
•Modifica della configurazione delle impostazioni predefinite
•Eliminazione delle impostazioni predefinite
•Esportazione di impostazioni predefinite
•Importazione di impostazioni predefinite
•Applicazione di un'impostazione predefinita a un lavoro
•Costruzione di un lavoro con Impostazioni registrate in un'impostazione predefinita
•Utilizzo di hot folder con impostazioni predefinite

Per una maggiore efficienza, è possibile registrare le funzioni e le impostazioni usate più
frequentemente come impostazioni predefinite del lavoro. Le impostazioni predefinite possono essere
applicate direttamente a un lavoro o possono essere associate a una hot folder per l'elaborazione
automatica.

TotalFlow Prep fornisce anche alcune impostazioni predefinite campione utilizzabili per creare biglietti
da visita e libretti, per eliminare i puntini e raddrizzare i documenti scansiti e per reimpostare le
impostazioni predefinite del lavoro. Le impostazioni predefinite campione disponibili variano in base
alla lingua selezionata durante l'installazione di TotalFlow Prep.

CCrreeaarree ddeellllee iimmppoossttaazziioonnii pprreeddeeffiinniittee
È possibile registrare le impostazioni di un lavoro aperto come predefinite.

Queste impostazioni lavoro possono essere incluse in una impostazione predefinita:

• Stampante e impostazioni stampante

• Impostazione codice utente

• Impostazioni carta

• Impostazioni di orientamento, lato di stampa e colore

• Imposizione

• Impostazioni di finitura e output

• Impostazioni capitolo

• Schede

• Schede su margini al vivo

• Intestazioni e piè di pagina

• Numerazione pagine

• Timbratura pagina

• Impostazioni delle eccezioni

• Fogli copertina

• Fogli designati

• Fogli divisori

Il numero di copie e le informazioni dal pannello [Impostazione lavoro], fatta eccezione per le
impostazioni [Codice utente], [Modalità di stampa], [Data di scadenza] e [Applica impostazioni
a PDF e rimuovi da job ticket], non vengono salvati e applicati come parte dell'impostazione
predefinita.
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Il codice utente salvato nelle impostazioni predefinite viene applicato solo se il lavoro non presenta già
un codice utente specificato.

Quando si salva un'impostazione predefinita, è anche possibile aggiungere impostazioni di
elaborazione dell'immagine, associare l'impostazione predefinita a una hot folder di input e specificare
le impostazioni di output per i lavori elaborati attraverso la hot folder.

Per registrare un'impostazione predefinita:

1. Creare o aprire un lavoro.

Per ulteriori informazioni, vedere Preparazione dei lavori, pagina 85.

2. Verificare di aver specificato tutte le impostazioni lavoro che si desidera includere
nell'impostazione predefinita.

Per ulteriori informazioni, vedere Modifica dei lavori, pagina 95.

3. Nella barra dei menu, fare clic sul menu delle impostazioni predefinite e selezionare [Salva
lavoro come impostazione predefinita].

È anche possibile creare un'impostazione predefinita utilizzando uno di questi metodi:

• Fare clic sul menu delle impostazioni predefinite, selezionare [Gestisci impostazioni
predefinite], quindi fare clic sul pulsante [Crea impostazione predefinita].

• Andare in Impostazioni→ Impostazioni predefinite e fare clic sul pulsante [Crea
impostazione predefinita] nella schermata [Gestisci impostazioni predefinite].

4. Nella schermata [Salva impostazione predefinita], specificare un nome e una descrizione per
l'impostazione predefinita.

7 Lavorare con le impostazioni predefinite
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È anche possibile configurare una hot folder di input per l'elaborazione automatica del lavori,
specificare le impostazioni di output per i lavori elaborati attraverso la hot folder e includere
impostazioni di elaborazione dell'immagine.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

• È possibile registrare fino a 25 impostazioni predefinite.

• Se viene configurata una hot folder di input per l'impostazione predefinita, è possibile creare
ed effettuare l'output di lavori semplicemente inserendo i file nella hot folder. Per ulteriori
informazioni, vedere Utilizzo di hot folder con impostazioni predefinite, pagina 250.

• Quando si associa una hot folder a una impostazione predefinita, viene visualizzata un'icona
di collegamento rapido per la hot folder sul desktop.

• È possibile associare una hot folder a una singola impostazione predefinita. Le hot folder non
possono essere condivise da più computer o impostazioni predefinite. In caso contrario
potrebbero verificarsi errori.

• Le funzioni hot folder ed di elaborazione dell’immagine non sono disponibili nella versione
browser di TotalFlow Prep.

5. Fare clic su [Salva].
L'impostazione predefinita configurata viene aggiunta all'elenco delle impostazioni predefinite
disponibili nel menu delle impostazioni predefinite e viene selezionata per il lavoro corrente
finché non viene modificata una delle impostazioni lavoro registrate.

MMooddiiffiiccaa ddeellllaa ccoonnffiigguurraazziioonnee ddeellllee iimmppoossttaazziioonnii pprreeddeeffiinniittee
È possibile modificare nome, descrizione, hot folder, impostazioni di output del lavoro e impostazioni di
elaborazione dell'immagine specificate per un'impostazione predefinita registrata.

Per modificare le impostazioni di un'impostazione predefinita:

Modifica della configurazione delle impostazioni predefinite
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1. Nella barra dei menu, fare clic sul menu delle impostazioni predefinite e selezionare [Gestisci
impostazioni predefinite].

È anche possibile aprire la schermata [Gestisci impostazioni predefinite] da
Impostazioni→ Impostazioni predefinite.

2. Nella schermata [Gestisci impostazioni predefinite], passare il mouse sull'impostazione
predefinita che si desidera modificare e fare clic su , il pulsante [Modifica impostazione
predefinita].

3. Modificare le impostazioni necessarie nella schermata [Salva impostazione predefinita].

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

La sezione [Hot folder] non è disponibile quando si modificano le impostazioni predefinite
create nella versione browser di TotalFlow Prep.

4. Fare clic su [Salva].

EElliimmiinnaazziioonnee ddeellllee iimmppoossttaazziioonnii pprreeddeeffiinniittee
È possibile eliminare le impostazioni predefinite registrate che non si utilizzano più.

Per eliminare un'impostazione predefinita:

1. Nella barra dei menu, fare clic sul menu delle impostazioni predefinite e selezionare [Gestisci
impostazioni predefinite].

7 Lavorare con le impostazioni predefinite
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È anche possibile aprire la schermata [Gestisci impostazioni predefinite] da
Impostazioni→ Impostazioni predefinite.

2. Nella schermata [Gestisci impostazioni predefinite], passare il mouse sull'impostazione
predefinita che si desidera rimuovere e fare clic su , il pulsante [Elimina impostazione
predefinita].

EEssppoorrttaazziioonnee ddii iimmppoossttaazziioonnii pprreeddeeffiinniittee
È possibile esportare le Impostazioni predefinite registrate come file RJP in modo che possano essere
usate su un altro computer.

• Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

• I profili segnatura non vengono esportati come parte dell'impostazione predefinita.

• I profili codice a barre e i crocini personalizzati salvati all'interno di un profilo crocino non vengono
esportati come parte dell'impostazione predefinita.

Per esportare un'impostazione predefinita:

1. Nella barra dei menu, fare clic sul menu delle impostazioni predefinite e selezionare [Gestisci
impostazioni predefinite].

Esportazione di impostazioni predefinite
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• È anche possibile aprire la schermata [Gestisci impostazioni predefinite] da
Impostazioni→ Impostazioni predefinite.

2. Nella schermata [Gestisci impostazioni predefinite], selezionare le impostazioni predefinite
da esportare e fare clic sul pulsante [Esporta impostazioni predefinite].

3. Nella finestra di dialogo [Salva con nome], specificare un nome e la posizione di salvataggio
per il file RJP esportato e fare clic su [Salva].

IImmppoorrttaazziioonnee ddii iimmppoossttaazziioonnii pprreeddeeffiinniittee
È possibile importare impostazioni predefinite esportate come file RJP.

• Questa funzione non è disponibile nella versione browser di TotalFlow Prep.

Per importare un'impostazione predefinita:

1. Nella barra dei menu, fare clic sul menu delle impostazioni predefinite e selezionare [Gestisci
impostazioni predefinite].

7 Lavorare con le impostazioni predefinite
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• È anche possibile aprire la schermata [Gestisci impostazioni predefinite] da
Impostazioni→ Impostazioni predefinite.

2. Nella schermata [Gestisci impostazioni predefinite], fare clic sul pulsante [Importa
impostazioni predefinite].

3. Nella finestra di dialogo [Apri], cercare un file RJP esportato, selezionarlo e fare clic su [Apri].
Se un'impostazione predefinita importata ha il medesimo nome di una delle impostazioni
predefinite esistenti, al nome viene aggiunto un valore numerico tra parentesi.

AApppplliiccaazziioonnee ddii uunn''iimmppoossttaazziioonnee pprreeddeeffiinniittaa aa uunn llaavvoorroo
È anche possibile applicare le impostazioni registrate in un'impostazione predefinita a un lavoro aperto.
Le impostazioni lavoro correnti vengono aggiornate per adattarsi alle impostazioni lavoro registrate
nell'impostazione predefinita.

Per applicare una impostazione predefinita:

1. Creare o aprire un lavoro.

Per ulteriori informazioni, vedere Preparazione dei lavori, pagina 85.

2. Nella barra dei menu, fare clic sul menu delle impostazioni predefinite e selezionarne una
dall'elenco.

Applicazione di un'impostazione predefinita a un lavoro



7

248

• Quando viene applicata un'impostazione predefinita, i valori dell'impostazione predefinita
sovrascrivono tutte le impostazioni lavoro correnti, escluse quelle per la stampante.

Se la stampante corrente non supporta alcune impostazioni della preimpostazione, tali
impostazioni non vengono applicate. Viene visualizzata una finestra di dialogo di avvertenza
con maggiori informazioni sulle impostazioni non supportate.

Il codice utente salvato nelle impostazioni predefinite viene applicato solo se il lavoro non
presenta già un codice utente specificato.

• Se le impostazioni dall'impostazione predefinita specificano pagine, intervalli pagine,
capitoli o intervalli di capitoli che non sono validi per il lavoro corrente, tali impostazioni
vengono applicate parzialmente in base alle pagine e ai capitoli disponibili.

• Le preimpostazioni che contengono impostazioni di elaborazione dell'immagine non sono
disponibili nella versione browser di TotalFlow Prep.

È possibile usare l'impostazione predefinita campione [Carta auto] per riportare il lavoro alle
impostazioni predefinite.

CCoossttrruuzziioonnee ddii uunn llaavvoorroo ccoonn IImmppoossttaazziioonnii rreeggiissttrraattee iinn
uunn''iimmppoossttaazziioonnee pprreeddeeffiinniittaa
È possibile applicare le impostazioni registrate in un'impostazione predefinita quando si costruisce un
lavoro con la funzione [Componi lavoro].

Per costruire un lavoro con le impostazioni registrate in un'impostazione predefinita:

1. Aprire TotalFlow Prep e fare clic su [Componi lavoro] nella schermata [Azioni rapide].

Se un lavoro è già aperto in TotalFlow Prep, andare su File→ Componi lavoro per costruire un
nuovo lavoro.

2. Nella finestra di dialogo [Componi lavoro], aggiungere i file dal computer o importare i file da
uno scanner.

7 Lavorare con le impostazioni predefinite
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• Per aggiungere file dal computer, fare clic su [Aggiungi file], cercare i file da aggiungere
nella finestra di dialogo [Apri], selezionarli e fare clic su [Apri].
Se un file è protetto da password, viene segnalato di immettere la password prima di poter
aggiungere il file al lavoro.

• Per importare i file da uno scanner, selezionare uno scanner compatibile con TWAIN o
l'utilità Fiery Remote Scan dall'elenco di scanner e fare clic su [Scansione].
In base allo scanner selezionato, viene avviata la schermata di configurazione del driver
TWAIN o l'utilità Fiery Remote Scan. Attenersi ai passaggi richiesti dal driver dello scanner e
scegliere le impostazioni necessarie.

3. Ripetere il passaggio precedente per aggiungere tutti i file richiesti per il lavoro.

4. OOppzziioonnaallee:: Apportare le regolazioni necessarie all'elenco dei file.

Ad esempio, è possibile riordinare i file e specificare quali pagine includere per i file con più
pagine.

5. Abilitare l'opzione [Applica impostazioni predefinite] e selezionare un'impostazione
predefinita dall'elenco per applicare le impostazioni registrate nell'impostazione predefinita
quando viene creato il lavoro.

Costruzione di un lavoro con Impostazioni registrate in un'impostazione predefinita
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Se le impostazioni dall'impostazione predefinita specificano pagine, intervalli pagine, capitoli o
intervalli di capitoli che non sono validi per il lavoro corrente, tali impostazioni vengono
applicate parzialmente in base alle pagine e ai capitoli disponibili.

6. Fare clic sul pulsante [Crea].

Per ulteriori informazioni sulla costruzione di lavori dai file esistenti sul computer o dai file scansiti,
consultare Costruzione di un nuovo lavoro, pagina 86.

UUttiilliizzzzoo ddii hhoott ffoollddeerr ccoonn iimmppoossttaazziioonnii pprreeddeeffiinniittee
È possibile usare hot folder e impostazioni predefinite per l'elaborazione automatica del lavoro.
Quando in una hot folder viene inserito un file di un documento supportato, viene creato un lavoro,
viene applicata l'impostazione predefinita associata e viene eseguito l'output del documento senza
bisogno di avviare l'applicazione.

La funzione hot folder non è disponibile nella versione browser di TotalFlow Prep.

Per usare una hot folder per l'elaborazione automatica del lavoro:

1. Creare un'impostazione predefinita e associarla a una hot folder di input.

Per dettagli, vedere Creare delle impostazioni predefinite, pagina 241.

Verificare di aver selezionato il metodo di output richiesto per i lavori elaborati attraverso la hot
folder nella schermata [Salva impostazione predefinita]:

• Per inviare i lavori alla stampante specificata nell’impostazione predefinita, abilitare
l’opzione [Stampa lavoro sulla stampante dopo l’elaborazione].

Per attendere la modifica manuale del lavoro, selezionare la casella [Attendi modifica
manuale].

• Per salvare e inviare i lavori a una cartella di output, abilitare [Salva come lavoro di
stampa] o l'opzione [Salva come PDF].

Se si desidera applicare le impostazioni specificate nel ticket lavoro al posto di quelle salvate
nell'impostazione predefinita alla creazione del lavoro, selezionare anche la casella [Usa valori
ticket in ingresso (JDF, RJF) invece delle impostazioni predefinite.].

• Il numero di copie e le informazioni personalizzate sono sempre recuperate dal ticket lavoro.

• Se nel ticket in ingresso non sono presenti codici utente, viene applicato il codice utente
dell'impostazione predefinita.

2. Posizionare il file o i file che si desidera elaborare nella hot folder configurata.

• Prima di inserire dei file in una hot folder, assicurarsi che possano essere elaborati tramite
questa applicazione. Per dettagli, vedere Formati file supportati, pagina 263.

7 Lavorare con le impostazioni predefinite
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• Se in una hot folder viene inserito un file protetto da password, si verificherà un errore. Prima
di inserire dei file in una hot folder, rimuovere la protezione password.

• Se vengono inseriti più file in una hot folder, viene creato un lavoro distinto per ogni file. Per
combinare più file in un unico lavoro, avviare l'applicazione e usare [Crea nuovo lavoro] o
la funzione [Componi lavoro]. Non è possibile combinare i file nelle hot folder.

• Per inserire contemporaneamente un file JDF e i file PDF ad esso collegati in una hot folder,
inserire per primo il file JDF. Se i file PDF vengono inseriti nella hot folder prima del file JDF,
l'applicazione potrebbe avviare l'elaborazione solo con i file PDF.

• Se si inserisce un file JDF in una hot folder, verificare che i file PDF collegati al file JDF siano
archiviati in una cartella che sia accessibile dal computer client.

• Se la casella di controllo [Richiedi codice utente per stampare lavoro] è selezionata
nella schermata [Preferenze] e si invia un lavoro senza codice utente a una hot folder, il
lavoro passa allo stato di errore.

• I file inseriti nella hot folder vengono rimossi dopo che l'applicazione li ha elaborati. Si
consiglia di creare una copia dei file che si desidera salvare prima di metterli nella hot folder.

• Se si desidera eliminare dal disco una cartella definita come hot folder, è necessario prima
rimuovere l'impostazione della hot folder dall'impostazione predefinita associata. In caso
contrario, l'applicazione ricreerà la cartella al successivo polling per i lavori.

• Se le impostazioni registrate nell’impostazione predefinita associata alla hot folder
specificano pagine, intervalli di pagine, capitoli o intervalli di capitoli che non sono validi per
un lavoro, queste impostazioni vengono applicate parzialmente in base alle pagine e ai
capitoli disponibili all’interno del lavoro.

3. OOppzziioonnaallee:: Verificare l'avanzamento del lavoro e, se necessario, modificare lo stato del lavoro.

Per ulteriori informazioni, vedere Controllare l'andamento e i risultati del lavoro, pagina 235.

Utilizzo di hot folder con impostazioni predefinite
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88.. Risoluzione dei problemi

•Se non è possibile avviare l'applicazione
•Se appare un messaggio
•Se si verifica un problema

Se si riscontrano problemi mentre si lavora con TotalFlow Prep, è possibile risolverli utilizzando le
informazioni contenute in questa sezione.

SSee nnoonn èè ppoossssiibbiillee aavvvviiaarree ll''aapppplliiccaazziioonnee
Questa sezione spiega come comportarsi se non è possibile avviare l'applicazione.

Azione e riferimenti

1. Se sul disco rigido lo spazio è insufficiente, aumentare lo spazio libero. Per informazioni sullo
spazio necessario sul disco rigido, consultare la Guida all'installazione.

2. Se il problema persiste, riavviare il computer.

3. Se il problema non è ancora stato risolto, disinstallare l'applicazione e installarla nuovamente.
Consultare la Guida all'installazione per dettagli sulla disinstallazione e la reinstallazione
dell'applicazione.

SSee aappppaarree uunn mmeessssaaggggiioo
Questa sezione illustra i messaggi principali. Se si riceve un messaggio non illustrato nella presente
sezione, seguire le istruzioni contenute nel messaggio. Se il problema persiste, controllare messaggio e
codice del messaggio, quindi contattare l'assistenza tecnica.

Nelle seguenti tabelle, il codice visualizzato dopo il testo del messaggio è un identificatore unico per il
messaggio. I codici visualizzati nella colonna Codice messaggio identificano il contesto specifico
dell'errore e le possibili soluzioni.

CCrreeaazziioonnee ee aappeerrttuurraa ddeeii llaavvoorrii

Messaggio
Codice
messaggio Azione e riferimenti

“Impossibile creare un nuovo
lavoro.“ (101019)

“Impossibile incorporare il file
originale/i dati acquisiti nel
lavoro {0}.“ (101026)

2020900015 Verificare di avere privilegi sufficienti per
leggere il file MJD specificato.

2020302111 Consultare Formati file supportati, pagina 263
e accertarsi che l'applicazione supporti il
formato del file.

2020302112 Verificare che il formato del file immagine e la
risoluzione siano supportati o che le risoluzioni
X e Y dell'immagine siano le stesse.
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Messaggio
Codice
messaggio Azione e riferimenti

Per dettagli sui formati immagine supportati,
consultare Formati e dimensioni immagine
supportati, pagina 266.

2020700003 Se sul disco rigido lo spazio è insufficiente,
aumentare lo spazio libero. Per informazioni
sullo spazio necessario sul disco rigido,
consultare la Guida all'installazione.

“Impossibile aggiornare le
informazioni sull'impostazione
predefinita.“ (106010)

2000200102 Non è stato possibile creare una nuova
cartella.

Controllare i seguenti punti, quindi specificare
una cartella valida:
• Possedete privilegi sufficienti per accedere

alla cartella specificata?
• È stata specificata una cartella di sola

lettura? (Ad esempio, una cartella
contenuta in un CD)

“Conversione PDF tramite il
driver TotalFlow PDF fallita.“

1. Consultare Formati file supportati, pagina
263 e accertarsi che l'applicazione
supporti il formato del file.

2. Se le impostazioni del driver PDF TotalFlow
sono state modificate, installare
nuovamente il driver PDF TotalFlow. Per
informazioni, consultare la Guida
all'installazione.

3. Se non è stato possibile risolvere il
problema con i procedimenti del
passaggio 1 o del passaggio 2, il file
potrebbe essere rovinato. Controllare se è
possibile aprire il file nell'applicazione
utilizzata per la sua creazione.

“La scansione è stata
annullata.“ (107003)

Se la scansione non è stata annullata e appare
questo messaggio, ripetere la scansione.

“Impossibile acquisire.
Verificare la connessione dello
scanner e le impostazioni del
driver.“

• Verificare che TotalFlow Prep supporti il
driver dello scanner.

Per informazioni sui driver supportati,
vedere il file Leggimi di Printer Connector.

• Verificare che il driver dello scanner sia
configurato correttamente.

8 Risoluzione dei problemi
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Messaggio
Codice
messaggio Azione e riferimenti

Per informazioni sull’installazione del driver
e sulla procedura di configurazione,
vedere la documentazione per i propri
driver.

• Verificare che lo scanner sia connesso alla
rete e pronto all'uso.

“Informazioni lavoro non
disponibili.“ (101007)

“Miniature non disponibili.“
(104001)

La memoria potrebbe essere stata insufficiente
all'elaborazione del documento. Se la
memoria era insufficiente, uscire da altre
applicazioni.

“La password è errata.
Riprovare.“ (101006)

Verificare di aver specificato la password
corretta per il file.

“Impossibile avviare TotalFlow
Prep perché un'altra istanza di
TotalFlow Prep è già in
esecuzione.“

Riavviare TotalFlow Prep per risolvere il
problema.

Se appare un messaggio
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SSttaammppaa ee ssttaammppaannttii

Messaggio
Codice
messaggio Azione e riferimenti

“Impossibile stampare il
lavoro.“ (101041)

“Impossibile creare un nuovo
lavoro. Impossibile assegnare il
dispositivo al lavoro.“
(101022)

“Impossibile creare un nuovo
lavoro. Informazioni capacità
dispositivo non disponibili.“
(101023)

“Informazioni capacità
dispositivo non disponibili.“
(101011)

“Impossibile connettersi al
dispositivo.“ (202038)

“Impossibile creare il lavoro.
Errore sconosciuto.“ (101018)

2000400110

2000400114

2000600105

2000400144

2000400133

2000400117

2000400156

Controllare i punti seguenti:
• La stampante è accesa?
• La stampante è collegata alla rete?
• Si è verificato un errore nella stampante?

“Informazioni capacità
dispositivo non disponibili.“
(101061)

“Informazioni capacità
dispositivo non disponibili.“
(101011)

“Si è verificato un errore HTTP.“
(101012)

“Si è verificato un errore HTTP.“
(101055)

“Impossibile aggiungere la
stampante. Il dispositivo non è
supportato.“ (102021)

“Impossibile aggiungere la
stampante. Impossibile
accedere alla stampante.“
(102023)

“Impossibile aggiornare le
impostazioni di connessione
stampante.“ (102009)

2000400109

2000400134

• Verificare la correttezza delle impostazioni
di connessione specificate quando è stata
aggiunta la stampante.

• Fare clic su [Gestione stampante] nel
menu [Impostazioni] per visualizzare i
dettagli di connessione e le informazioni di
stato per le stampanti registrate. Fare clic

sul , il pulsante [Modifica], accanto a
una stampante per visualizzarne o
modificarne le impostazioni.

Per dettagli su un'impostazione specifica,
fare clic sul pulsante per visualizzare la
guida contestuale su schermo.

• Verificare che il modello di stampante sia
supportato. Per ulteriori informazioni,
consultare il file Leggimi di Printer Connector.

2000400114

2000400115

Potrebbe non essere riuscita la connessione al
server sul quale è installato TotalFlow
Production Manager.

Controllare i punti seguenti:
• Il server è acceso?
• Il server è collegato alla rete?

8 Risoluzione dei problemi
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Messaggio
Codice
messaggio Azione e riferimenti

“Impossibile aggiornare le
informazioni stampante o le
impostazioni di connessione.“
(102011)

“Impossibile aggiungere la
stampante. Assicurarsi che le
informazioni sulla stampante e
le impostazioni di connessione
siano corrette.“ (102025)

“Lo stato della stampante è
sconosciuto.“ (101058)

“Impossibile aprire il lavoro. Lo
stato della stampante è
sconosciuto.“ (101010)

• TotalFlow Production Manager è stato
avviato correttamente? In caso negativo,
riavviare il server.

• Si riesce a stampare da TotalFlow
Production Manager?

Potrebbe verificarsi un errore HTTP poiché il
carico del sistema aumenta temporaneamente
quando TotalFlow Prep invia i lavori a
TotalFlow Production Manager. Attendere che
il carico del sistema diminuisca e provare a
inviare di nuovo i lavori.

2000400102

2000400132

2000400144

Controllare i seguenti punti su TotalFlow
Production Manager:
• Esiste un flusso di lavoro adeguato in

TotalFlow Production Manager?
• Il flusso di lavoro è associato a una

stampante fisica?
• Si riesce a stampare dalla stampante fisica

che è associata a TotalFlow Production
Manager?

Per ulteriori informazioni, consultare la
documentazione di TotalFlow Production
Manager.

2000400128

2000400130

Verificare che nella stampante non si sia
verificato un errore.

Se viene visualizzato “Impossibile aggiornare
le impostazioni di connessione stampante.“,
controllare tutte le stampanti registrate.

2000400103 Quando è terminata la stampa con la
stampante specificata, ripetere l'operazione.

Se appare un messaggio
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MMooddiiffiiccaa ddii llaavvoorrii nneellllaa vveerrssiioonnee bbrroowwsseerr ddii TToottaallFFllooww PPrreepp

Messaggio
Codice
messaggio Azione e riferimenti

“Impossibile aprire il lavoro.
Errore sconosciuto.“ (101000)

“Impossibile aprire il lavoro
perché il file non è valido.
Errore sconosciuto.“ (101001)

“Impossibile aprire il lavoro. Il
file potrebbe essere
danneggiato o il tipo di file non
supportato.“ (101002)

“Impossibile stabilire una
sessione con il servizio.“
(100002)

2000024103

2021217104

2021217106

2000900101

2000900102

Impossibile ottenere il file JDF da TotalFlow
Production Manager o da TotalFlow Print
Server. Il file JDF potrebbe essere corrotto o il
tipo di file potrebbe non essere supportato.
• Accertarsi che TotalFlow Production

Manager o TotalFlow Print Server sia
configurato correttamente.

• Verificare di disporre dei privilegi sufficienti
per accedere al file.

• Accertarsi che la versione di TotalFlow Prep
sia compatibile con la versione di
TotalFlow Production Manager o di
TotalFlow Print Server.

“Impossibile recuperare le
informazioni sulla stampante da
TotalFlow Production Manager
o TotalFlow Print Server.“
(102015)

2000024102

2000000107

Impossibile ottenere le funzionalità del
dispositivo da TotalFlow Production Manager o
da TotalFlow Print Server oppure il file
potrebbe essere danneggiato.
• Verificare che il nome completo del

computer di TotalFlow Production Manager
possa essere risolto a un indirizzo IP.

• Accertarsi che TotalFlow Production
Manager o TotalFlow Print Server sia
configurato correttamente.

“Impossibile inviare il lavoro
all'applicazione. Errore
sconosciuto.“ (101037)

2000024104 Prima di inviare un lavoro, TotalFlow
Production Manager o TotalFlow Print Server si
blocca.

Riavviare TotalFlow Production Manager o
TotalFlow Print Server, quindi modificare e
salvare di nuovo il lavoro.

“Impossibile connettersi al
server.“

2000000001 Quando si modifica un lavoro, il servizio
TotalFlow Prep viene arrestato.

Riavviare il servizio TotalFlow Prep e riprovare.

8 Risoluzione dei problemi
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Messaggio
Codice
messaggio Azione e riferimenti

“Impossibile terminare la
sessione con il servizio.“
(100003)

(Questo messaggio non è
visualizzato sull'interfaccia
utente di TotalFlow Prep ma
viene restituito a TotalFlow
Production Manager o a
TotalFlow Print Server.)

2000900103 L'interfaccia utente del browser è stata chiusa
in modo anomalo.

Riaprire l'interfaccia utente del browser e
accertarsi che funzioni correttamente.

“Si è verificato un errore
sconosciuto.“ (300000)

La connessione a TotalFlow Production
Manager o a TotalFlow Print Server potrebbe
non essere riuscita.
• Accertarsi che TotalFlow Production

Manager o TotalFlow Print Server sia
configurato correttamente.

• Controllare la connessione Internet.
• Verificare che tutti i servizi richiesti siano in

esecuzione.

SSaallvvaattaaggggiioo ddeeii llaavvoorrii

Messaggio
Codice
messaggio Azione e riferimenti

“Impossibile salvare il file PDF.“
(101040)

“Impossibile salvare il lavoro
come RJF. Errore sconosciuto.“
(101036)

2000600001
• Accertarsi che la lunghezza del percorso

assoluto non superi i 260 caratteri.
• Verificare che la cartella in cui si desidera

salvare il file non sia di sola lettura.

Se appare un messaggio
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AAllttrrii pprroobblleemmii

Messaggio
Codice
messaggio Azione e riferimenti

“Informazioni preferenze non
disponibili.“ (105003)

“Impossibile aggiornare le
informazioni sulle preferenze.“
(105004)

2090400105 1. Riavviare il computer.

2. Se non è stato possibile risolvere il
problema nel passaggio 1, il file delle
impostazioni potrebbe essere rovinato.

“Impossibile effettuare il
collegamento al servizio RICOH
TotalFlow Prep. Verificare che il
servizio sia avviato e
riprovare.“

Il servizio TotalFlow Prep o il servizio Printer
Connector potrebbero non essere ancora
avviati dopo il riavvio del sistema. Verificare
che i servizi siano avviati e provare ad aprire
nuovamente l'applicazione.

SSee ssii vveerriiffiiccaa uunn pprroobblleemmaa
In questa sezione vengono fornite le spiegazioni e le possibili soluzioni ai problemi che si possono
incontrare.

Impossibile comunicare con la stampante

• Verificare che la stampante sia accesa e collegata alla rete.

• Verificare la correttezza delle impostazioni di connessione specificate quando è stata aggiunta la
stampante.

Per visualizzare i dettagli della connessione e le informazioni di stato per le stampanti registrate,

selezionare [Gestione stampante] nel menu [Impostazioni]. Fare clic su , il pulsante
[Modifica], accanto a una stampante per visualizzarne o modificarne le impostazioni.

Per dettagli su un'impostazione specifica, fare clic sul pulsante per visualizzare la guida
contestuale su schermo.

Immagini che sono vicine al bordo del foglio non vengono stampate

L'area di stampa valida dipende dal dispositivo, dalle impostazioni del dispositivo, dal formato carta e
dal tipo di flusso di dati. Le immagini che si trovano vicino al bordo del foglio potrebbero non essere
stampate perché al di fuori dell'area di stampa valida, anche se compaiono nell'anteprima di TotalFlow
Prep.

Ad esempio, potrebbe accadere quando si stampa sulle schede del divisore a rubrica inserito.

Provare ad aumentare l'area stampabile nelle impostazioni della stampante.

Le miniature non mostrano il contenuto del lavoro

Le miniature segnaposto vengono visualizzate al posto del contenuto effettivo del lavoro quando viene
applicata l'opzione [Nascondi contenuto foglio]. Verificare che l'opzione [Nascondi contenuto
foglio] nel menu [Visualizza] non sia selezionata.

8 Risoluzione dei problemi
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L'orientamento di un'immagine scansita non è corretto

Se l'orientamento dei dati acquisiti non è come previsto, è possibile ruotare le pagine utilizzando la
funzione di rotazione fornita da TotalFlow Prep. Per ulteriori informazioni, vedere Rotazione di pagine,
pagina 125.

Le impostazioni del lavoro sono in conflitto

Quando si specifica un'impostazione lavoro che non è compatibile con le impostazioni correnti, viene
visualizzata una finestra di dialogo di avviso. La finestra di dialogo elenca le opzioni in conflitto e
fornisce informazioni su come risolvere il problema. Attenersi alle istruzioni fornite nella finestra di
dialogo e regolare le impostazioni del lavoro come necessario. Per ulteriori informazioni, vedere
Risoluzione dei conflitti dell’impostazione del lavoro, pagina 227.

Spazio sul disco insufficiente

Se non è possibile salvare un file a causa di spazio su disco insufficiente, aumentare la quantità di
spazio libero sul disco rigido. Per informazioni sullo spazio necessario sul disco rigido, consultare la
Guida all'installazione.

Memoria insufficiente

Se si verifica la condizione OutOFMemoryError, chiudere tutte le applicazioni non necessarie e
riavviare l'interfaccia utente TotalFlow Prep. Se il problema non si risolve, contattare il servizio di
assistenza.

Problemi con i file di lavoro di versioni precedenti di TotalFlow Prep

Alcune impostazioni lavoro delle versioni precedenti di TotalFlow Prep non sono supportate o vengono
applicate diversamente in TotalFlow Prep 4.0 o versioni successive. È necessario applicare nuovamente
queste impostazioni dopo aver aperto il file di lavoro in TotalFlow Prep 4.0 o versioni successive.
Consultare la Guida all'installazione per ulteriori informazioni sulla migrazione dei file legacy.

Impossibile avviare License Manager

Verificare di utilizzare un account con permessi di amministratore. Se è stato eseguito l'accesso come
utente con privilegi di amministratore diversi da Administrator, fare clic con il pulsante destro del mouse
su [License Manager] e selezionare [Esegui come amministratore].

Il pannello [Avvisi] non visualizza in modo accurato lo stato del lavoro

Quando vengono inviati alla stampa centinaia di lavori, il pannello [Avvisi] potrebbe non visualizzare
in modo accurato lo stato dei lavori. Per risolvere il problema, chiudere e riaprire il pannello [Avvisi].

La stampante non utilizza il vassoio di alimentazione specificato in TotalFlow Prep

Per stampanti con controller RICOH, accertarsi che le opzioni [Commutazione vassoio] e
[Commutazione vassoio automatica estesa] siano disabilitate. Per ulteriori informazioni, consultare
la documentazione della stampante.

Per le stampanti con controller EFI Fiery, accertarsi che la carta selezionata in TotalFlow Prep
corrisponda alla carta caricata nel vassoio:

Se si verifica un problema
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• Se il controller abbina la carta in base agli attributi, gli attributi di formato, grammatura e tipo
specificati per la carta in TotalFlow Prep devono corrispondere a formato, grammatura e tipo della
carta caricata nel vassoio. L’ID catalogo specificato per la carta nel ticket lavoro viene ignorato.

• Se il controller utilizza un ID catalogo per l’abbinamento della carta, la carta di catalogo
specificata in TotalFlow Prep deve corrispondere alla carta di catalogo caricata nel vassoio.

Per ulteriori informazioni, consultare la documentazione della stampante.

8 Risoluzione dei problemi
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99.. Riferimenti

•Formati file supportati
•Impostazioni porta ed eccezioni firewall

In questa sezione è possibile trovare ulteriori informazioni sui formati di file supportati, sulle
impostazioni delle porte e sulle eccezioni del firewall.

FFoorrmmaattii ffiillee ssuuppppoorrttaattii
In questa sezione vengono fornite le informazioni sui formati file supportati da TotalFlow Prep per la
creazione dei lavori e l'inserimento dei file in un lavoro esistente. Sono elencate anche le applicazioni
richieste per l'invio dei file e il tipo di documenti che i file hanno come parte del lavoro.

Prima di inviare i lavori, verificare di aver installato tutte le applicazioni richieste.

AApppplliiccaazziioonnii nneecceessssaarriiee ppeerr ii ttiippii ddii ffoorrmmaattoo

Tipo file Applicazione necessaria

Tipo di
documento
per il
lavoro Note

TIFF Nessuno PDF di
immagine

JPEG Nessuno PDF di
immagine

PNG Nessuno PDF di
immagine

PDF Nessuno Oggetto
PDF

PS/EPS Acrobat Distiller, incluso con
Adobe Acrobat 8/9/X/XI/DC/
2017/2020

Oggetto
PDF

Acrobat Distiller viene
utilizzato per creare un file
PDF che viene poi usato per
creare il lavoro.

DOC/DOCX/
RTF

• Microsoft Word 2007 SP3/
2010 SP1/2013/2016/
2019/Office 365

• Adobe PDF, incluso con
Adobe Acrobat 8/9/X/XI/
DC/2017/2020

• Driver TotalFlow PDF, incluso
con questa applicazione

Oggetto
PDF

Il driver PDF TotalFlow viene
utilizzato per creare un file
PDF che poi viene usato per
creare il lavoro.

Per informazioni
sull'installazione del driver PDF
TotalFlow, consultare la Guida
al'installazione.
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Tipo file Applicazione necessaria

Tipo di
documento
per il
lavoro Note

XLS/XLSX/CSV
• Microsoft Excel 2007 SP3/

2010 SP1/2013/2016/
2019/Office 365

• Adobe PDF, incluso con
Adobe Acrobat 8/9/X/XI/
DC/2017/2020

• Driver TotalFlow PDF, incluso
con questa applicazione

Oggetto
PDF

PPT/PPTX
• Microsoft PowerPoint 2007

SP3/2010 SP1/2013/
2016/2019/Office 365

• Adobe PDF, incluso con
Adobe Acrobat 8/9/X/XI/
DC/2017/2020

• Driver TotalFlow PDF, incluso
con questa applicazione

Oggetto
PDF

9 Riferimenti
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Tipo file Applicazione necessaria

Tipo di
documento
per il
lavoro Note

JDF Nessuno Oggetto
PDF

I file JDF vengono usati insieme
ai file PDF per specificare le
istruzioni di elaborazione per il
lavoro. Contengono le
informazioni del ticket lavoro,
come ad esempio istruzioni
speciali, informazioni sul
cliente e impostazioni di
modifica, di finitura e di
stampa.

I file JDF vengono solo
supportati quando si inviano i
lavori mediante una hot folder
o si inseriscono i file in un
lavoro esistente.

RJF Nessuno Oggetto
PDF

Il formato RJF è un formato file
lavoro specifico di TotalFlow
Prep. I file RJF sono file PDF
contenti informazioni integrate
sulle impostazioni, per
esempio impostazioni di
finitura e di stampa.

I file RJF vengono solo
supportati quando si inviano i
lavori mediante una hot folder
o si inseriscono i file in un
lavoro esistente.

Ulteriori informazioni sull'invio di file PDF

• Questa applicazione supporta i seguenti tipi di file PDF:

– File PDF creati utilizzando applicazioni originali di Adobe Systems (versioni PDF da 1.3 a 1.7).

– File PDF creati usando la funzione di scanner dei dispositivi elencati nel file Leggimi di Printer
Connector.

Nel caso in cui si stia utilizzando un file PDF che non è stato creato con le applicazioni o i
dispositivi sopraindicati, il file potrebbe non essere importato nell'applicazione oppure alcune
funzioni dell'applicazione potrebbero non essere disponibili.

Formati file supportati
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• La presente applicazione non supporta file PDF con moduli XFA creati utilizzando applicazioni
come Adobe LiveCycle Designer. Prima di importare un file PDF nella presente applicazione,
convertire il file in modo tale che non contenga moduli XFA. Ad esempio, è possibile utilizzare
Adobe Distiller per convertire il file.

• Quando un lavoro viene creato da un documento di Microsoft Office, l'applicazione importa
l'output generato da Adobe Distiller. Se Adobe Distiller non converte il documento correttamente,
l'input ricevuto da questa applicazione non è corretto.

Si può tentare di convertire il documento originale a PDF in Microsoft Office utilizzando una
funzionalità come PDFMaker prima di inviarlo.

• Se si apre un file PDF o un documento di Microsoft Office con un formato pagina superiore a
330,2 × 487,6 mm (13 × 19,2 pollici), l'applicazione riduce il formato al maggiore formato carta
disponibile per la stampante di destinazione.

Per impostazione predefinita, quando la dimensione è ridotta viene mantenuto il rapporto di aspetto
originale. È possibile modificare questa impostazione nella schermata [Preferenze].

Per ulteriori informazioni sul supporto della carta lunga, consultare Impostazione supporto carta
lunga, pagina 156.

• Se il file PDF viene creato con Adobe Illustrator, l'anteprima del file potrebbe essere spostata in
modo non corretto. Per risolvere il problema, si può tentare di salvare i dati in un nuovo PDF con la
funzione Salva con nome di questa applicazione. Quindi, è possibile creare il lavoro dal file PDF
salvato.

Formati e dimensioni immagine supportati

In questa sezione vengono fornite le informazioni riguardanti i formati e le dimensioni delle immagini
supportati.

TotalFlow Prep supporta solo le immagini che utilizzano la modalità colore RGB.

FFoorrmmaattii iimmmmaaggiinnee ssuuppppoorrttaattii

Formato immagine Colori

TIFF (multipagina supportato) Non compresso Bianco e nero (1 bit)

Scala di grigi (8 bit)

Colori indicizzati (8 bit)

Quadricromia (24 bit)

CCITT G3 FaxMH Bianco e nero (1 bit)

CCITT G3 FaxMR Bianco e nero (1 bit)

CCITT G4 FaxMMR Bianco e nero (1 bit)

9 Riferimenti
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Formato immagine Colori

TIFF-MH (Huffman RLE) Bianco e nero (1 bit)

LZW Bianco e nero (1 bit)

Scala di grigi (8 bit)

Colori indicizzati (8 bit)

Quadricromia (24 bit)

JPEG (JFIF) - YCbCr Scala di grigi (8 bit)

Colori indicizzati (8 bit)

Quadricromia (24 bit)

PackBits Bianco e nero (1 bit)

Scala di grigi (8 bit)

Colori indicizzati (8 bit)

Quadricromia (24 bit)

ZIP (Deflate) Bianco e nero (1 bit)

Scala di grigi (8 bit)

Colori indicizzati (8 bit)

Quadricromia (24 bit)

JPEG Normale Scala di grigi (8 bit)

Colori indicizzati (8 bit)

Quadricromia (24 bit)

Progressivo Scala di grigi (8 bit)

Colori indicizzati (8 bit)

Quadricromia (24 bit)

PNG Normale Bianco e nero (1 bit)

Scala di grigi (8 bit)

Colori indicizzati (8 bit)

Quadricromia (24 bit)

Formati file supportati
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Formato immagine Colori

Interlace Bianco e nero (1 bit)

Scala di grigi (8 bit)

Colori indicizzati (8 bit)

Quadricromia (24 bit)

DDiimmeennssiioonnii iimmmmaaggiinnee ssuuppppoorrttaattee

Colori
Dimensioni
massime

Risoluzione
massima Pixel massimi Esempi

Bianco e nero (1
bit)

330,2 ×
487,6mm (13 ×
19,2 pollici)

1.200 dpi 20.000 × 30.000
pixel

Tabloid (11 × 17)
1.200 dpi
(13.200 ×
20.400 pixel)

Tabloid Extra (12
× 18) 600 dpi
(7.200 × 10.800
pixel)

Tabloid Extra (12
× 18) 1.200 dpi
(14.400 ×
21.600 pixel)

Scala di grigi (8
bit)

330,2 ×
487,6mm (13 ×
19,2 pollici)

600 dpi 7.800 × 11.520
pixel

Tabloid Extra (12
× 18) 600 dpi
(7.200 × 10.800
pixel)

Quadricromia (24
bit)

330,2 ×
487,6mm (13 ×
19,2 pollici)

600 dpi 7.800 × 11.520
pixel

Tabloid Extra (12
× 18) 600 dpi
(7.200 × 10.800
pixel)

9 Riferimenti
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• Le dimensioni massime dell'immagine supportate dipendono dalla stampante selezionata per il
lavoro. Se si utilizza una stampante che supporta carta lunga, è possibile aggiungere immagini più
grandi.

• La trasparenza canale alfa non è supportata.

• Se la risoluzione di un file immagine non è specificata, TotalFlow Prep imposta automaticamente la
risoluzione di immagine a 200 dpi.

• Se si aggiunge al lavoro un file immagine che eccede le dimensioni massime ma non il numero
massimo di pixel, la risoluzione dell'immagine viene aumentata al massimo, fino ad adattare
l'immagine alle dimensioni massime.
Se l'immagine eccede il numero massimo di pixel o se nonostante l'aumento della risoluzione non
rientra nelle dimensioni massime, l'elaborazione dipende dalla modalità del colore dell'immagine:

– Le immagini in bianco e nero (1 bit) vengono ridotte alle dimensioni massime supportate dalla
stampante, mantenendo il rapporto di aspetto originale. Tuttavia, se l'opzione [Mantieni
proporzioni originali quando vengono ridimensionati originali di grandi dimensioni]
sulla schermata [Preferenze] non è abilitata, vengono ridotte al formato A3 a 600 dpi.

– Le immagini in scala di grigi vengono convertite in bianco e nero e seguono lo stesso processo
delle immagini in bianco e nero.

– Le immagini in quadricromia vengono ridotte alle dimensioni massime supportate dalla
stampante. Il rapporto di aspetto originale viene sempre mantenuto, a prescindere dalle
impostazioni specificate nella schermata [Preferenze].

• Se si utilizzano le funzioni di modifica originali per le immagini trasparenti, i colori dell'immagine
potrebbero essere diversi da quelli originali.

Limitazioni delle funzioni Modifica per le pagine di documenti

Questa sezione fornisce informazioni sulle funzioni di modifica originale disponibili per ogni formato di
documento.

FFuunnzziioonnii ddiissppoonniibbiillii ppeerr ffoorrmmaattoo ddooccuummeennttoo

Funzione

Formato documento

Image PDF *1 Object PDF *2

Raddrizza (automatico) Disponibile Non disponibile

Raddrizza (manuale) Disponibile Non disponibile

Smacchiamento Disponibile Non disponibile

Sposta area Disponibile Non disponibile

Formati file supportati
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Funzione

Formato documento

Image PDF *1 Object PDF *2

Ridimensiona pagina Disponibile Disponibile

Taglia Disponibile Disponibile

Ruota Disponibile Disponibile

Inserisci maschera Disponibile Disponibile

Inserisci testo Disponibile Disponibile

Inserisci immagine Disponibile Disponibile

Applica sovrapposizione
immagine

Disponibile Disponibile

*1 Questo formato è adatto a lavori e documenti inseriti creati da file immagine con formato TIFF, JPEG
o PNG.

*2 Questo formato è adatto a lavori e documenti inseriti creati da file immagine con formato diverso da
TIFF, JPEG e PNG.

FFuunnzziioonnii ddiissppoonniibbiillii ppeerr ffoorrmmaattoo ddooccuummeennttoo nneellllaa vveerrssiioonnee bbrroowwsseerr ddii TToottaallFFllooww PPrreepp

Funzione

Formato documento

Image PDF *1 Object PDF *2

Raddrizza (automatico) Non disponibile Non disponibile

Raddrizza (manuale) Non disponibile Non disponibile

Smacchiamento Non disponibile Non disponibile

Sposta area Non disponibile Non disponibile

Ridimensiona pagina Disponibile Disponibile

Taglia Non disponibile Disponibile

Ruota Disponibile Disponibile

Inserisci maschera Disponibile Disponibile

9 Riferimenti
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Funzione

Formato documento

Image PDF *1 Object PDF *2

Inserisci testo Disponibile Disponibile

Inserisci immagine Non disponibile Non disponibile

Applica sovrapposizione
immagine

Non disponibile Non disponibile

*1 Questo formato è adatto a lavori e documenti inseriti creati da file immagine con formato TIFF, JPEG
o PNG.

*2 Questo formato è adatto a lavori e documenti inseriti creati da file immagine con formato diverso da
TIFF, JPEG e PNG.

IImmppoossttaazziioonnii ppoorrttaa eedd eecccceezziioonnii ffiirreewwaallll
Questa sezione fornisce informazioni sulle impostazioni porta ed eccezioni firewall richieste per il
funzionamento corretto di TotalFlow Prep.

Gli amministratori devono specificare un numero di porta quando creano una stampante. Tale numero
di porta deve corrispondere al numero di porta configurato per la stampante.

IImmppoossttaazziioonnii ppoorrttaa

Numero porta Descrizione

20080 (HTTP) L’impostazione porta predefinita per far comunicare il server TotalFlow Prep
Tomcat con l’interfaccia utente.

Se questa porta è già in uso, è possibile impostare un numero di porta diverso
per il server Tomcat. Per ulteriori informazioni, vedere la Guida
all’installazione.

17005 (HTTP) Utilizzata per lo spegnimento di Tomcat.

161 (UDP), 514
(TCP), 1022 (TCP)

Utilizzata per la scansione.

161 (SNMP) Utilizzata per la registrazione della stampante.

17080 (HTTP) Utilizzata per la versione browser di TotalFlow Prep.

17888 Utilizzata per la versione HTML della Guida per l'utente.

Impostazioni porta ed eccezioni firewall
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Numero porta Descrizione

80, 8010 (HTTP) e
9100, 9101,
9102, 9103 (TCP)

Printer Connector e il controller della stampante utilizzano queste impostazioni
di porta per comunicare con le stampanti.

9100 Utilizzata se il linguaggio della stampante è impostato su PostScript.

8010 / 80 Utilizzata se il linguaggio della stampante è impostato su PDF/JDF.

20091 - 20099 Utilizzata per le operazioni Java Remote Method Invocation (RMI).

IImmppoossttaazziioonnii ppoorrttaa ppeerr ssttaammppaannttii JJoobb TTiicckkeett

Se viene assegnato un lavoro alla stampante, non è possibile modificare l'impostazione della porta per
le stampanti Job Ticket.

Numero
porta

Descrizione

9100 L’impostazione porta predefinita per la maggior parte dei dispositivi di stampa. Se il
dispositivo stampante utilizza l’opzione controller EFI Fiery, è possibile specificare
anche uno dei seguenti numeri di porta:

9101 I lavori vengono inviati alla coda diretta e vengono stampati nello stesso
ordine in cui sono stati inviati. Per la maggior parte delle stampanti non è
possibile determinare lo stato del lavoro. La funzione di fascicolazione per
più copie non è disponibile.

9102 L’impostazione porta raccomandata. I lavori vengono inviati alla coda di
stampa; tuttavia, potrebbero non essere stampati nello stesso ordine in cui
vengono inviati. È possibile determinare lo stato del lavoro. La funzione di
fascicolazione per più copie è disponibile.

9103 I lavori vengono inviati alla coda di attesa e un operatore deve rilasciarli
alla console della stampante per la stampa.

Se il Firewall di Windows è abilitato, alcuni programmi potrebbero essere bloccati e questa
applicazione potrebbe non funzionare correttamente. I programmi bloccati devono essere registrati
come eccezioni firewall.

• java.exe

Percorso di installazione: Percorso di installazione di questa applicazione\svc\jre\bin
\java.exe

• TwainAccessor.exe

9 Riferimenti
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Percorso di installazione: Percorso di installazione di questa applicazione\svc\bin
\TwainAccessor.exe

• mongod.exe

Percorso di installazione: Percorso di installazione dell'applicazione\svc\bin
\impostrip\externals\ite\bin\win64\mongod.exe

• node.exe

Percorso di installazione: Percorso di installazione dell'applicazione\svc\bin
\impostrip\externals\ite\bin\win64\node.exe

Se in fase di installazione di TotalFlow Prep è stato selezionato il percorso di installazione predefinito,
Percorso di installazione dell'applicazione fa riferimento alla seguente cartella:

C:\Program Files\RICOH\TotalFlow Prep\

Per maggiori informazioni su come registrare le eccezioni del firewall, consultare la Guida di Windows.

Impostazioni porta ed eccezioni firewall
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